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Outbound Contact 8.1 Deployment Guide

Outbound Contact 8.1 Deployment Guide

Welcome to the Outbound Contact 8.1 Deployment Guide. These topics provide step-by-step
instructions for the configuration and installation of the applications and components that are
required to run Outbound Contact 8.1.

About Outbound Contact Outbound Contact Deployment

Introduction Deployment Planning

Terms and Concepts Manually Configure and Install Outbound
Applications

Architecture
Outbound Solution Wizard

Silent Setup

Starting and Stopping Procedures

Outbound VolP Deployment Configuration Options Reference
Outbound VoIP Deployment Manually Define Outbound Configuration
Objects

Outbound Contact Configuration Options

Dialing Regulations and Related Call Handling and Treatments
Functionality

SCXML-Based Treatments

Log Files Call Handling and Treatments
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Deploving Do Not Call Functionality
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OCS Feature Compliance with Regulatory
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Outbound Deployment with CPD
Server

Configuring Dialogic Boards

CPD Server Options

Database-related Functionality

Manually Defining Outbound Configuration
Objects/Table Access Object

Field Object
Format Object
Calling List Object
Filter Object

Predictive Algorithm

Dialing Modes

Predictive Dialing Modes
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Introduction

Introduction

Outbound Contact is an automated system that is used to create, modify, and run outbound dialing
campaigns/dialing sessions in which agents interact with customers. Running a dialing session,
involves launching a dialing session that is associated with the campaign, monitoring it, and making
any necessary adjustments. To perform these tasks, Outbound Contact users can:

¢ Create calling lists from customer contact information.

e Group calling lists into campaigns for outbound dialing.

e Share campaigns among multiple agent groups.

e Create campaign sequences with the Campaign Sequence object, which provides predefined thresholds
and automatic agent assignments.

e Automatically load, start, unload, and perform other management functions for Campaign Groups using
Outbound Schedules.

¢ Optimize usage of agent resources by using assignments. Agents can shift as needed between different
dialing sessions and activities, including switching between inbound and outbound call handling.

e Chain records for a customer (multiple call records).

¢ Choose different dialing modes.

* Define treatments and scheduled calls for unsuccessful calls on each calling list.
¢ Monitor campaigns using Reporting tools.

¢ Apply Do Not Call restrictions by phone number or customer ID.

Outbound Contact can use traditional telephony or VolP architecture. In both cases, it has a client/
server architecture consisting of the one of the following:

¢ Qutbound Contact consists of Outbound Contact Server (OCS) and optionally can include Call Progress
Detection Server (CPD Server) and/or CPD Proxy Server.

In release 8.x, Genesys Administrator replaces Outbound Contact Manager (OCM). Genesys
Administrator is a web-based user interface (Ul) that provides provisioning, monitoring, deployment,
and operations of Genesys solutions.

If you already use Outbound Contact Manager, you
Note: can continue to use OCM 7.6 with Outbound
Contact 8.x.

Migration

Refer to the Genesys Migration Guide for detailed information about migrating Outbound Contact 7.x
or 8.0 to Outbound Contact 8.1.

Outbound Contact Deployment Guide 8



Introduction

License Control

Outbound Contact 8.1 requires an 8.0 license. See the Genesys Licensing Guide for the supported
versions of FlexLM, which is the application Genesys uses to authenticate licenses. If you want to run
Outbound Contact in a mixed environment (in which some Outbound Contact components are release
8.1, and some others are release 7.5, 7.6, or 8.0), 8.0 Outbound Contact licenses must be present on
License Server, along with licenses for earlier versions of Outbound Contact. Outbound Contact
licenses are required for all dialing modes except Push Preview and Power GVP with OBN Manager.

If you are using Dialogic HMP software, additional
licenses are necessary. See HMP Software and
contact your Dialogic representative for more
information.

Note:

Refer to the Genesys Licensing Guide for detailed information about how to license Outbound Contact
8.1.
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Outbound Contact Terms and Concepts

Outbound Contact Terms and Concepts

These topics introduce the terminology and concepts that pertain to Outbound Contact:

Formats

Fields

Records

Calling Lists

Filters

Treatments

Campaign Group

Campaigns

Display Name on a Per-campaign Basis

Outbound Schedules
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Formats

The layout of each calling list is determined by a format. The term format has two meanings in
Outbound Contact:

The field layout in a table in a relational database.

A configuration object in Genesys Administrator.

) You can also configure this in Configuration
Note:
Manager.

A format consists of a number of Field objects.

You can create multiple calling lists of the same format, but each calling list can have only one
corresponding format. The configuration database provides default formats; these consist of all of the
mandatory fields that are required by Outbound Contact 7.x and 6.5. You can create new formats that
consist of user-defined fields and the mandatory fields.

Each format within a tenant has a unique name, which you specify if you create a new format.

Outbound Contact Deployment Guide 11
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Fields

The term field has two definitions for Outbound Contact:

¢ The name of a column in a table in a relational database.
¢ A configuration object in Genesys Administrator.

You can also configure this in Configuration

pete Manager.

Each Calling List field object contains both database-related information (such as data type) and
business-related information (such as field type).

Outbound Contact Deployment Guide 12
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Records

A record is a row in a Calling List table. Among its mandatory fields, each record contains:

e A phone number.
e The fields that determine how the records should be processed (Record Type and Record Status).

¢ The fields that store time boundaries and time zone information; these enable runtime determination of
whether the record can be dialed.

A record can contain as many custom fields as needed as defined in a Calling List Format object.

Chained Records

Chained records are multiple records for the same customer in a calling list. These records typically
contain alternative phone numbers such as home, business, and cellular phone. In addition, each
record in the same chain can have different time boundaries and time zone information, and it can
also have different values stored in its business data fields.

Flexible Prioritization of Record Types

Flexible prioritization means that a user can assign his or her own order of priority to specific record
types for dialing purposes.

A record type with a higher priority is dialed before a record with a lower priority. Genesys
Administrator (Outbound) automatically passes the priority for the record type and its parameters to
Outbound Contact Server with events.

The user can prioritize the following record types in the Predictive/Progressive dialing mode and in
the Preview dialing mode.

¢ General records--All records are initially marked General in an Outbound Contact calling list. The status
may change after the record has been dialed. Either an agent or a treatment in response to a call result
can change the status of a record.

¢ Campaign Callback records--An agent reschedules a campaign callback record at the customer's chosen
time. The callback may be dialed automatically or delivered to an agent's desktop softphone as a
preview record depending on the value of the predictive_callback option. See Outbound Contact
Configuration Options for more information about this option.

See the "Communication Protocols" chapter of the
Note: Outbound Contact Reference Manual for
information on the events distributed when

Outbound Contact Deployment Guide 13
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rescheduling records.

¢ Campaign Rescheduled records--Treatments reschedule these records based on the detected call
results. A campaign rescheduled call is dialed automatically and handled by any agent who is working
on that particular campaign.

Record types can be prioritized in Genesys Administrator (Outbound Contact section) or in a third-
party application that manages the campaigns.

The following options define the default record priorities for Outbound Contact:

e default campaigncallback priority
e default campaignrescheduled priority

e default _general priority

These options must be configured in the Outbound section of the Application, Campaign or
Campaign Group objects. Wherever these options are configured, they apply to Campaign Group
objects.

Priorities set at the Campaign Group level have the most precedence while those set at the
Application level have the least. In addition:

¢ Values set at the Application level are applicable for all Campaign Groups.

* Values set at the Campaign level should be applicable for all Campaign Groups created for the given
Campaign.

The priorities set by the options are displayed as a grid in Genesys Administrator at Operations >
Outbound Contact > Dialing Sessions > Priorities. The same grid also appears for the
associated Sequence on the Sequences tab, and for the associated Schedule at Provisioning >
Outbound Contact > Schedules, if the associated Campaign Group is part of the Sequence or has
an assigned Schedule. In all cases, the grid is read-only.

You can also configure SCXML treatments to select
which record in a chain is dialed first and which is
dialed next. For more information, see SCXML-
Based Treatments.

Note:

If you are using a third-party application (instead of Genesys Administrator) to communicate with
OCS, you must use the KeyValue List from the Genesys Common Library with the events to transfer
the priority information to OCS.

You must define the priorities in the following user requests, that are sent through the
Communication DN:

e CM_RegLoadCampaign

* CM ReqgStartDialing

* CM ReqgSetDialingMode

For more information about these user requests, see "Communication DN API" in the Outbound
Contact Reference Manual.

Outbound Contact Deployment Guide 14
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Note that flexible prioritization does not apply to Personal Callback records or Personal Rescheduled
records. An agent schedules or reschedules a personal call back record at the customer's chosen
time. OCS automatically delivers a Personal record to the agent's desktop at the specified time, and
the same agent who initially handled the record processes the Personal Call Back or Personal

Rescheduled record.

Outbound Contact Deployment Guide 15
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Calling Lists

The term calling list has two meanings in Outbound Contact:

¢ A subset of records from a table in a relational database that satisfies the conditions of a filter that
might be associated with it.

e A configuration object in Genesys Administrator.

The two meanings converge in the following way: the Table Access Point configuration object in
Genesys Administrator contains the name of the table in the database. Each table in the database
requires a separate Table Access Point object. The Table Access Point object is a property of the
Calling List object in Genesys Administrator. One or more Calling List objects can share the same
Table Access Point object.

Each Calling List table contains a number of mandatory fields that, for example, identify customers
and the status of each record.

The user can add a number of user-defined fields; these typically store business-related data.

Do Not Call

The Do Not Call (DNC) function prevents a particular telephone number or customer ID from being
dialed. Record-blocking can occur in Outbound Contact either by customer request or by a decision
on the part of a contact center manager.

A Do Not Call request can be handled during either an outbound call or an inbound call--for example:

e During a conversation initiated by an outbound call, a customer tells an agent that he or she does not
want to be called anymore. In outbound mode, the agent uses a unique record identifier generated by
OCS (GSW_RECORD_HANDLE) to refer to the record.

* A customer calls the contact center (inbound call) and explicitly asks not to be called. In inbound mode,
the phone number or customer ID serves as a reference to the record.

In both cases, having received a Do Not Call request, OCS makes an entry in a special table
(referenced in the gsw_donotcall_list Table Access) in the database. OCS reads all of the records from
this table and populates two separate tables (buffers) in memory with unique values from the phone
field and from the customer id field. These tables can also be populated by Do Not Call requests to
OCS from the following sources:

¢ An agent desktop--If an agent belongs to a Campaign Group, and a dialing session for that Campaign
Group is loaded, Outbound Contact Server uses the OCS-Agent Desktop protocol to handle DNC
requests.

e A third-party application, through the Communication DN API -- If an agent is not associated with a
Campaign Group, OCS uses the Communication DN API.

¢ A routing strategy can insert records into the DoNotCall list.

Outbound Contact Deployment Guide 16
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e GVP can insert records into the DoNotCall list when OCS is running in Power GVP dialing mode.

A Do Not Call request (by phone number or customer ID) from the agent's desktop updates not only
the records that are in the database, but also retrieves records that are currently in the memory
buffers of the Outbound Contact Server.

Outbound Contact makes a provision for several customers with the same phone number in a calling
list. The value of the customer _id option can specify a user-defined field in the Calling List table to
identify DNC customers by customer ID instead of phone number. You define the field name in the
Field object with the send attribute assigned to it. (For more information, see Field Object.) You then
specify the field name as the value of the customer_ID option in the OCS Application object. The new
field is part of the Format object. Through these configurations, you can apply the DNC restriction to
a particular customer instead of placing the restriction on a particular telephone number.

To enable this enhanced Do Not Call functionality in Outbound Contact, see User-Defined Field for Do
Not Call.

OCS stores records marked as NoCall in the gsw_donotcall_list (one per tenant) and monitors them in
the following way:

When a dialing session associated with an outbound campaign is running, OCS retrieves records that
are ready to dial and checks them against the gsw_donotcall_list.

If a record that is retrieved from the calling list matches any record from the gsw_donotcall_list, OCS
does not dial this record. Instead, it returns the record to the calling list and changes its record_type
to NocCall.

Rereading of the Do-Not-Call List

The DoNotCall list might be updated from outside Outbound Contact, for example by a third-party
application that accesses the DoNotCall list database table directly. To avoid missing updates from
external sources, you can have OCS periodically reread the already-loaded DoNotCall list.

The Do Not Call list table for the given Tenant is
read when the first dialing session from this Tenant
is activated (loaded).
Rereading of the Do Not Call list for the specific
Note: Tenant halts dialing in all Dialing Sessions that
belong to this Tenant until the list is fully read.
Therefore, Genesys recommends that you
configure Do Not Call rereads for periods of low
activity in the contact center (such as night time).

You can choose to have OCS reread already-loaded Do Not Call lists periodically by setting the dnc-
reread option. For details, see Outbound Contact Configuration Options.

If a manual update to the Do Not Call list is required, restart OCS in order to acknowledge the
changes. If you choose to restart OCS, do so during off-hour periods, so that restarting the server
does not disrupt calling activities. Alternatively, OCS will pick-up these updates upon next reread of
the Do Not Call list, if such a reread is configured.

Outbound Contact Deployment Guide 17
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Primary and Backup Impact

When OCS switches from the backup to the primary, OCS rereads the Do Not Call records that were
added after the Do Not Call list was initially read by OCS for all Tenants that have active/ running
dialing sessions associated with campaigns whose Do Not Call list(s) were imported. This action
synchronizes the Do Not Call list between the backup OCS and the primary OCS if the primary OCS
updates the list after the backup OCS reads it, because of the addition of new records to the Do Not
Call list. No call requests will be created by OCS until the Do Not Call list table is completely read.

Dealing with a Large Do Not Call List

Outbound Contact uses a database table to store Do Not Call contact numbers and other information
related to DNC customers' requests. This table serves as a persistent storage of Do Not Call--related
information. While loading a dialing session for a campaign, OCS retrieves the data that is stored in
this table, puts it into memory, and checks each phone number from the calling list against this table
to determine whether a phone number should be dialed.

Generally this Do Not Call database table is intended to hold information regarding only internal Do
Not Call requests rather than external Do Not Call requests.

An internal DNC request is one that is specific to a particular contact center. For example, a Do Not
Call request is internal if either of the following is true:

* A called party requests to be marked as Do Not Call when an agent contacts him or her through an
outbound call.

¢ A called party contacts (through an inbound phone call, e-mail, or personal visit) the organization that
makes outbound calls and requests to be marked as Do Not Call.

An external DNC request is one that is submitted to an authority that collects such requests and
distributes them to contact centers.

The number of internal Do Not Call requests is relatively small compared to the number of external
ones. A contact center may receive several thousand DNC requests from customers. The number of
DNC requests nation-wide could number in the tens of millions. Because OCS stores all phone
numbers from the Do Not Call table in memory (RAM), the following OCS performance factors are
affected as the size of the table increases:

¢ The amount of time that OCS takes to load a dialing session for a campaign--or, more specifically, the
amount of time that it spends reading the table data for a campaign and storing it in memory.

¢ The amount of memory that is allocated by OCS after it reads the whole table.
To improve the performance of OCS, minimize the amount of data stored in the Do Not Call database
table (accessible to OCS through gsw_donotcall_list Table Access). Ideally, this table would contain

only internal DNC records. Information about external Do Not Call requests would be keptin a
separate, custom DNC database table.

See the "Recommended DBMS Optimizations" chapter in the Outbound Contact Reference Manual for
more information about tuning your database(s).

To address potential performance issues, Genesys recommends two methods for handling large Do
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Not Call tables (over 1 million records):

¢ Use a dialing filter to improve OCS handling of large database tables.

¢ Run an SQL query to completely avoid any performance problems.

Method 1: Use a Dialing Filter

Dialing filters are used to bypass records from the Calling List table that should not be dialed. Each
calling list can have its own dialing filter. Suppose that a custom DNC database table contains the
field dnc_phone for storing all phone numbers that should not be dialed. In this case, the dialing filter
will be as follows:

e phone NOT IN (SELECT dnc_phone FROM <custom_do_not_call_table>)

e NOT EXISTS (SELECT dnc_phone FROM <custom_do_not_call_table> WHERE dnc_phone = phone)
Note that you must complete the following steps:

* Replace the <custom_do_not_call_table> placeholder with the actual name of the custom Do Not Call
table.

* Replace the column name phone (in the Outbound 6.X format) with contact_info if you are using the
Outbound 7.X format for the calling list.

The second dialing filter might be faster, but your Database Management System (DBMS) might not
support an EXISTS SQL clause. Check your DBMS documentation or consult your Database
Administrator if necessary.

Method 2: Run an SQL Query

You can run an SQL query directly on calling lists in your database, before loading a dialing session
for a campaign. This query marks as NoCall any records in a calling list with phone numbers matching
those in a custom Do Not Call table. Run the following SQL query on all Calling Lists that you plan to
use for dialing:

UPDATE <calling_list table> SET record_type = 7 WHERE phone IN (SELECT dnc_phone FROM
<custom_do_not_call_table>)

You must complete the following steps:
* Replace the placeholder <custom_do_not_call_table> with the actual name of the custom Do Not Call
table.
* Replace the placeholder <calling_list_table> with the actual name of the Calling List table.

¢ Change permissions, as needed, for modifying tables through the execution of the UPDATE SET
statement.

If you choose to maintain Do Not Call support manually, you must run this SQL query every time after
you modify the calling list (by changing record_type to General and record_status to Ready) while
preparing a calling list for the next campaign.

Note: For more information about working with Do Not
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Call lists, see Deploying Do Not Call Functionality.
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Filters

Outbound Contact uses two kinds of filters: dialing filters and viewing filters.

Dialing Filter

A dialing filter customizes a calling list so that only certain phone numbers are dialed during a
campaign. One use of dialing filters is to divide records that share the same calling list (database
table) between two or more campaigns. As a configuration object in Genesys Administrator, each
Calling List object requires its own filter in order to select records according to specific criteria. For
example, if you intend to divide records in the same table between two campaigns, you must create
two Calling List objects, each with its own filter.

You create dialing filters and apply them to calling lists in either Genesys Administrator or
Configuration Manager.

OCS supports WHERE and ORDER BY clauses in dialing filters that are longer than 255 characters. For
more information, see Filter Object Options Tab Fields.

Viewing Filter

A viewing filter selects records in a calling list for display in Genesys Administrator. One use of
viewing filters is to display records in a certain order — for example, alphabetically by the name of
the city. Another use of viewing filters is to select customers by specific criteria that you define—for
example, all records that have a call_result value of NoAnswer.

It is possible to combine a dialing filter and viewing filter for browsing records in on the Operations
tab of Genesys Administrator (Outbound Contact) when both filters are enabled. For more
information, see Framework Genesys Administrator Help (Operating Your Call Center > Outbound
Contact Operations).

When OCS receives notification from Configuration Server that a dialing filter has changed, OCS
removes the retrieved records from the buffer (memory), returns them to the Calling List database,
and then retrieves the records that meet the criteria of the newly applied filter. Records on which the
agent is already working remain in OCS memory until they have been processed.
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Treatments

Treatments define options for handling calls by describing sets of actions to be performed on each
call result. For example, if the call result for an outbound call is NoAnswer, a treatment might be to
redial the number at a later time or to dial a different phone number for the customer.

In addition to the standard treatments for busy signals, no answers, and so on, Outbound Contact
gives the user the option to route, to an alternate DN, calls answered by fax machines or answering
machines. For example, it can run a fax-on-demand campaign along with a campaign that plays
messages to answering machines. This scenario requires a separate application that is responsible
for playing prerecorded messages (for example, IVR or voice mail). You can create treatments and
assign them to a calling list by using Genesys Administrator or Configuration Manager.

You can design customer-focused treatments by using SCXML scripts that allow you to customize
contacting customers according to time of day, contact type/first contact, dial attempts, call results
and so on.

For more information on treatments, see Call Handling and Treatments and SCXML-Based Treatments.
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Campaign Group

A Campaign Group is the main configuration object in Outbound Contact. It can be found within the
Campaign object in Genesys Administrator. A Campaign Group is defined as a Campaign (a set of
calling lists) that is assigned to work resources such as an Agent Group or a Place Group.

A Campaign Group can be associated with Agent Groups or Place Groups. Agents are individuals who
are set up as Person objects in Genesys Administrator in order to handle customer contacts. Places
can be telephone sets. There are two ways to group these individual objects:

* An Agent Group is a logical grouping of agents. Agents can be grouped by skill (for example, language
or marketing knowledge) or time (for example, shifts). If the Agent Group is configured as "virtual",
Outbound Contact uses the information that is provided by the Stat Server to monitor the Agent or
Place Group and the Agent Status. Outbound Contact monitors the virtual agent group through the Stat
Server that is configured in the Campaign Group object in Genesys Administrator. If it is not specified,
the group will not be processed, and Outbound Contact Server prints an error message in the log and
stops processing the group. If Outbound Contact Server disconnects from the specified Stat Server, it
will stop dialing for that group because of the unavailability of agent-state information. Dialing will
resume when reconnection to the Stat Server is reestablished. For more information on creating virtual
agent groups, see the Framework Stat Server User's Guide.

¢ A Place Group is a logical grouping of telephone sets. An example of a place group is a group of
telephone sets (sets shared by agents) in a contact center. When a place group is configured for a
Campaign Group, Outbound Contact Server does not validate who logs in to the group. For its purpose,
all that matters is that someone has logged in to the place group to handle outbound calls. A place
group is commonly configured when a contact center requires a generic group (in other words, a
physical group of phone sets) for a performance report on a campaign and does not need to know who
participated in the campaign. In Contact Center Pulse Plus (CCPulse+), the Genesys real-time reporting
software where outbound statistics are reported, the place group report shows activities and statistics
of the DNs that belong to places that are related to the Campaign Group.

The Agent Group or Place Group must be assigned to a campaign as a Campaign Group object. Stat
Server provides status information about these configuration objects (real or virtual) to Outbound
Contact Server. When loading a dialing session for a particular campaign group, OCS registers and
monitors the following DNs:

¢ All DNs of type Extension, ACD Position, and Voice Treatment Port that are associated with Places and
belong to a Switch object associated with a T-Server application to which OCS is connected.

e The DN specified as the Voice Transfer Destination (VTD) on the Advanced tab of the Campaign Group
configuration object.

e For VoIP environments, a Trunk Group DN configured on the Advanced tab of the Campaign Group
configuration object. For more information, see VoIP Environment Configuration.

If any other DNs of the ACD Queue, Routing Point, External Routing Point, Service Number, Virtual
Queue types or any others are involved in an outbound call flow, they must be monitored by OCS.
These DNs should be specified as an Origination DN in the Advanced tab of the Agent Group or Place
Group object that is linked to the Campaign Group in order for OCS to register those DNs with T-
Server and to receive call-related events on those DNs.
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e |f a Voice Transfer Destination DN and a T-Server
used as a Dialer belong to one switch in a multi-
site environment, but the call is distributed by
external routing to an agent who is on a
different site, at least one queue from this site
should be listed in the Origination DN list of the

Notes: corresponding Agent or Place Group. This forces
OCS to register regular DNs on the remote site
and receive related events.

e After OCS has registered a DN specified as VTD,
Trunk Group DN, or Origination DN, OCS keeps
monitoring it until OCS is restarted.

VoIP Environment Configuration

When running Outbound Contact in a VolP environment, you must configure the Campaign Group so
that it is VolP-ready by doing the following:

e A Trunk Group DN is configured.

e The SIP Server, that controls the Trunk Group DN, is listed in the Configuration tab/Connections section
of the OCS application object in Genesys Administrator.

If these conditions are not met, the dialing modes
function in the traditional, non-IP mode for that

Note: dialing session/Campaign Group.

For more information about the Outbound-VoIP environment,
see Outbound VoIP Deployment.
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Campaigns

A campaign is a flexible master plan that organizes calling lists for dialing calls and handling call
results. An outbound campaign specifies what kind of work the agents perform (for example,
collections, telemarketing, or fund-raising). A campaign is structured as follows:

¢ Generally, Outbound Contact Server (OCS) does not allow you to run more than one campaign for the
same Agent or Place Group at the same time. For example, if you are currently running Campaign
Group A (Campaign 1, Group 1), you cannot run Campaign Group B (Campaign 2, Group 1). However,
there are certain exceptions to this rule based on the types of dialing modes being used by each
Campaign Group, as shown in the following table:

Dialing Modes
ProgressivePredictive/

ProgressivePredictive Previey Push Power ProgressivePredictive
with with Preview GVP GVP GVP
Seizing Seizing
Progressive/
Pr_'og ressive N N Y Y Y Y N
with
Seizing
Predictive/
Pr_'edlctlve N N Y Y Y Y N
with
Seizing
Preview Y Y Y Y Y Y Y
I Y Y Y Y Y Y Y
Preview
Power
GVP Y Y Y Y Y Y Y
Progressive
GVP Y Y Y Y Y Y Y
Predictive
GVP N N Y Y Y Y N

(Y = can be run simultaneously; N = cannot be run simultaneously)
See Campaign Group for more information.

¢ One campaign can use several calling lists, and one calling list can be shared among several
campaigns. A special record-level locking mechanism prevents simultaneous dialing of the same
dialing record for different campaigns.

These configuration elements can be modified at runtime without stopping the dialing session
that is associated with a campaign.
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Warning

Genesys recommends that you do not change the dialer for an outbound
campaign while a campaign is active. Doing so can result in unexpected behavior,
such as the campaign stopping or problems with historical reporting.

Interaction with Agents

Outbound Contact maintains a documented protocol of interactions between itself and an agent's
desktop application. To simplify desktop application architecture and development, this protocol
is based on the user events that T-Server distributes at the client application's requests. The
supported types of interactions between Outbound Contact and the desktop application are
described in the following subsections. For more information about these interactions, see
Communication Protocols in the Outbound Contact Reference Manual.

Call Delivery Prioritization

In modern call centers, delivery of outbound calls to agents is handled by a routing strategy/
Designer application. Depending on the business needs in your environment, you can prioritize
delivery of outbound calls over inbound calls. Outbound calls have distinct differentiators (call

type, presence of the GSW_RECORD_HANDLE pair in UserData), which can be utilized by the
strategy logic.

Agent Assignment in Multiple Campaigns

Outbound Contact supports agent assignment in multiple campaigns for both the Transfer Mode
and ASM Modes. When using Universal Routing Server (URS) 8.0.1 and higher, you can enforce
the routing of any call to an agent assigned to a specific Campaign Group by invoking the
UseActivityType routing strategy function. For details, see the description of the UseActivityType
function in the Universal Routing Reference Manual. Keep in mind, however, that use of the
UseActivityType function may affect performance of predictive algorithm and cause

abandonment of outbound calls if outbound-dedicated Agents are occupied by non-outbound
calls.

Transfer Mode

Universal Routing Server (URS) must be used in order to support agent groups in multiple
campaigns. OCS will attach CampGrouplD data to every outbound call to represent the
CampaignGroup DBID. For every agent assigned to more then one active CampaignGroup,
Outbound Contact designates only one Campaign Group for this agent. OCS will change the
Campaign Group designation when the configuration of campaign priorities and the staffing

limits have been changed, when agents have been logged in/out, or when dialing sessions for
some Campaign Groups have been started/stopped.

Stat Server uses the same information in the CurrentCampaignGroupDBID statistic. URS can then
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target agents by using the CampaignGroup target.

A Campaign Group routing target should be used
only when routing calls to groups with an agent
assignment.

. When URS receives agent-assignment statistics from Stat
Note: Server, it might not apply them immediately to the strategy.
This can cause the outbound call to be abandoned during
processing by the strategy. Set URS pulse_time option to a
very low value (for example, 1 second) to prevent such calls
from being abandoned. For more information on this URS
option, see the Universal Routing Reference Manual.

ASM Modes

OCS also supports agent assignments in multiple campaigns in ASM modes. When you set the
agent-assignment option to true, OCS includes the Campaign Group name and DBID in its
request for an engaging call. This ensures that a customer call will be merged only with an
engaging call that originated for the same Campaign Group.

When OCS is making assignment decisions in ASM modes, OCS considers an engaged agent
eligible for reassignment to other Campaign Groups and can make a reassignment decision and
release the engaging call.

ASM Modes & CPD Server

CPD Server attaches the Campaign Group identifiers to the user data of the engaging call as
follows:

e For ISDN conventional configurations, CPD Server monitors the Voice Transfer Destination DN and
requests an update of user data that has these identifiers when EventRouteRequest is signaled for
the engaging call.

* When using CPD Server with HMP, the identifiers are attached during the call-setup phase, as SIP
Server can attach data to new a call whenever this data is provided in the SIP header of the initial
call-setup message. SIP Server must be properly configured to attach these identifiers to an
engaging call. In the configuration section of the SIP Server Application object, INVITE section must
contain the following options (example):

« userdata-1 = GSW_CAMPAIGN_GROUP_NAME
« userdata-2 = GSW_CAMPAIGN_GROUP_DBID

Because user data is passed via SIP headers, the
name of the Campaign Group used for agent
assignment can contain only English letters,
numbers and underscores.

Note:

When CPD Server bridges an outbound call to an engaging call, CPD Server gives first priority to
the Campaign Group DBID (GSW_CAMPAIGN_GROUP_DBID) in order to match calls associated
with the same Campaign Group.
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VolP ASM Modes Without CPD Server

Because all VolP ASM modes do not use CPD Server, OCS can attach Campaign Group identifiers
to both engaging and outbound calls when they are created. As a result, these calls can be
routed and bridged to the correct Campaign Group. To enable this, the routing strategy must be
designed to route engaging calls to Campaign Group targets.

Routing Strategy Design and CampaignGrouplID

For agent assignment, you should design the routing strategy to distribute only outbound calls
and engaging calls (if running a dialing session/campaign in an ASM mode) that contain the
correct CampGrouplD attached data to agents who meet the following criteria:

* The agent belongs to the specified group that is configured for that CampaignGroup.

e The agent's current statistic in Stat Server contains the CurrentCampaignGroupDBID, which is
equivalent to the CampGrouplID.

Both requirements can be achieved by using routing targets of Campaign Group type. In addition,
for engaging calls placed in conventional ISDN scenarios in which an engaging call arrives to the
Route Point DN without attached data, you must include the SuspendForEvent function
(EventAttachedDataChanged) in the routing strategy before the routing decision is made.

This SuspendForEvent function should be applied
only to engaging calls, (that is, those calls that
originated from a certain DN list.)

Note:

Campaign Prioritization
Campaigns are prioritized according to the following definitions:

¢ An understaffed campaign is one in which the number of assigned agents is less than what is
required to maintain a minimum service-level agreement (SLA).

« A staffed campaign is one in which the number of assigned agents is sufficient to maintain a
minimum SLA, but is less than the maximum SLA.

e An overstaffed campaign is one in which that the number of assigned agents is sufficient to
maintain the maximum SLA.

Agents are assigned based on the following priorities:

* All active campaigns that are configured with an equal priority will have an equal number of agents
assigned to each campaign if all of the campaigns are equally understaffed or equally staffed.

If agents are not configured equally for all
Campaign Groups—for example, if they have
different skills—the above behavior does not
apply. In this situation, the distribution for
campaigns could be uneven, and some agents
could be moved to an Inbound session instead of
being reassigned to an understaffed campaign.

Note:

¢ When some campaigns with equal priority are understaffed, all non-assigned agents are assigned
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to the understaffed campaigns only. If there are several understaffed campaigns, an equal number
of agents are assigned to each campaign that has equal priority.

* When there are no understaffed campaigns, all non-assigned agents are assigned to staffed
campaigns only. If there are several staffed campaigns, an equal number of agents are assigned to
each campaign that has equal priority.

* Agents are not assigned to overstaffed campaigns.

Refer to the descriptions of the following configuration options for more information about how
the following options help to configure agent assignment:

¢ agent-assignment

e agent-assignment-priority

* agent-assignment-min-num

¢ agent-assignment-max-num

* inbound-agent-assignment-priority

¢ inbound-agent-assignment-min-num

Refining How Agent Assignment Functions

The following options address specific situations, providing you with more flexibility to refine the
effectiveness of agent reassignment. OCS can now reassign agents to other activities if the
dialing session to which they are currently assigned cannot use them because there are no
available calling records or there are no free dialing ports.

¢ Agent reassignment if there are no available dialing ports or if there are no dialing records:
* agent-reassignment-if-waiting-ports
* agent-reassignment-if-waiting-ports-timeout
* agent-reassignment-if-waiting-records
* agent-reassignment-if-waiting-records-timeout
* Preventing agent assignment to inbound or low-priority outbound activities:

* inbound-agent-assignment-min-num

Claiming of Agents by a Routing Strategy

The ClaimAgentsFromOCS routing function in Universal Routing 8.1, enables a routing strategy to
make an immediate reassignment of one or more agents from outbound call handling to handling
of inbound interactions.

This functionality is enabled using the ocs-urs-interact configuration option.

This function is used when a strategy that is processing inbound calls cannot process a call within
the service objective criteria, and the call is important enough to require the use of agents
currently busy with outbound activity.

For example, outbound agents can be claimed if a call has been waiting longer than some
specified value.
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For additional information on this functionality, see the chapter on Universal Routing Functions in
the Universal Routing Reference Manual.

Agent Selection Logic

To select an agent for reassignment to an inbound activity, OCS goes through a list of agents
specified in the claim_agent.GSW PERSON DBIDS key of the CM_ReqClaimAgent message and
checks their states and assigned sessions. While checking agent states, OCS takes in
consideration only Ready or Not Ready states, without differentiating them on their type or cause
(such as ACW, on call, reason code, and so on). OCS gives preference to an agent in the Ready
state, who is currently assigned to the Campaign Group with the lowest priority and the largest
number of assigned agents.

OCS selects the most appropriate agent from all outbound-assigned agents satisfying request
conditions, and reassigns that agent to the inbound activity for the time period specified in the
request. If there is only one active dialing session and all agents in that session are not in the
Ready state, OCS selects the first agent in the claim_agent.GSW _PERSON DBIDS list. If OCS
determines that agent is already claimed, it selects the next agent in the list.

An agent may not be reassigned to the inbound activity immediately if there are some present
conditions in the Campaign Group. For example, if there are no Ready agents suitable for
reassignment, OCS waits until a selected agent finishes the outbound call before reassigning the
agent.

After the time expires, OCS reassigns the agent back to the outbound activity from where that
agent was claimed, or to the other running outbound activity this agent could be assigned to,

giving preference to the Campaign Group with the highest priority and the smallest number of
assigned agents.

OCS attempts to accommodate each Claim Agent request from URS by reassigning one agent per
request to inbound activities. It is expected that URS does not claim more agents than necessary
by sending Claim Agent requests repeatedly.

Personal and Campaign Callbacks

The OCS-Desktop protocol enables the agent to schedule Personal or Campaign callbacks for
specific records. A Personal callback is delivered to the agent who scheduled it. A Campaign
callback is sent to any agent working in the specified dialing session. The records scheduled as
either Personal or Campaign callbacks are marked accordingly in the calling list, so that reports
can be generated.

For Personal callbacks, OCS follows up on them if a dialing session is stopped but not unloaded.

For Campaign callbacks, processing depends on the settings specified in the predictive_callback
option.

See Communication Protocols in the Outbound
Contact Reference Manual for information on the
events that are distributed when an agent
reschedules records.

Note:
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Campaign Sequencing

Outbound Contact supports dynamic manual sequencing of running campaigns (campaign
sequencing). Only one campaign per dialing session can be running at a time, but multiple
campaigns can be loaded into memory. This enables the user to stop a previous dialing session
for a campaign and automatically start the next one without disrupting the agents' work. When
the new dialing session starts, the agents who are working in the group are notified. If new
agents log in to the group after a dialing session for an outbound campaign has started, they are
informed of the name and status of the currently running dialing session. OCS sends the name

and status of a dialing session for a campaign as user events by means of a communication
protocol.

Campaign sequencing can be configured according to the following parameters:
e Stop at Contacts—This counter is increased when a dialed record is updated in the database with

the Answer call result. As soon as the counter exceeds the campaign threshold, the dialing session
for the campaign is stopped and unloaded.

Stop at Dials—This counter is increased when a dialing request or a PreviewRecord user event is

issued. When the counter exceeds the campaign threshold, the dialing session for a campaign is
stopped and unloaded.

Stop at time—This occurs when a dialing session for a campaign is stopped and unloaded after it
had been running up to the specified time.
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Display Name on a Per-campaign Basis

This functionality enables you to specify a Display Name (in addition to CPN Digits) when dialing calls
in an outbound campaign. The Display Name can be set at the level of the OCS application,
Campaign Group, or individual record or chain of records.

Starting in release 8.1.1, OCS can use the CPNDisplayName configuration option to specify the name
to be displayed. When dialing with SIP Server, this value is passed to SIP Server as the DisplayName
parameter in the AttributeExtensions. When dialing with CPD Server in HMP transfer mode, this
option is supported only if the CPD Server option tscall is set to true/yes.

For an individual record, or for a chain of records, this option can be set using the set flex_attr
custom action of the SCXML treatment. See Setting Options for Individual Records or Chain of
Records for more information about custom actions.

Display Name is only supported when CPNDigits is
Note: also defined. Therefore, you must specify both the
CPNDigits and CPNDisplayName options.
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Outbound Schedules

Outbound Schedules enable you to automate control of dialing sessions that run in the contact center
more than once; that is, their execution recurs. For example, if specific dialing sessions run every
weekday, by using Outbound Schedules you can configure OCS to automatically run these dialing
sessions without the need for manual everyday operations to manage them.

In Outbound Schedule terminology a dialing session is a Campaign Group.

An Outbound Schedule is an object that:

¢ Contains the instructions for when its execution recurs;
¢ Unites one or more dialing sessions that are to be executed at each recurrence.
Each dialing session that is a part of the Schedule contains additional configuration parameters that

specify which commands are automatically executed by OCS for this dialing session and when they
should occur.

The following actions are available for automation:

e Load

e Start (with dialing parameters)

* Stop

¢ Set Dialing Mode and/or Set Dialing Parameters
e Unload

* Force Unload

e Complete (Stop if required, followed by Unload)

The Outbound Schedule determines when and at what intervals the included dialing sessions are
executed. A Schedule typically unites a set of dialing sessions that should be activated and
deactivated based on the same rules.

OCS supports an unlimited number of Schedules, each Schedule containing an unlimited number of
dialing sessions. Additionally, the same dialing session can be included in more than one Schedule.

Dialing sessions that are included in the same Schedule do not need to be associated with the same
Campaign, Group, or have anything else in common.

Genesys Administrator is used for configuration of
Outbound Schedules. For instructions on creating
and configuring Outbound Schedules, see the
Provisioning > Outbound Contact > Schedules
section in the Framework Genesys Administrator
Help.

Note:

The following table shows the types of recurrence that are supported for Outbound Schedules:
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Type of recurrence

Daily

Weekly

Monthly

Once

Recurrence Types for Outbound Schedules

Available Settings

Repeat every N day(s)
at specific time

Repeat every N week(s)
on specified days of
week at specific time

Repeat every N
month(s) on the
specified days at
specific time.

Execute once at specific
time.

Duration of Execution

From specified start
date until specified end
date or indefinitely

From specified start
date until specified end
date or indefinitely

From specified start
date until specified end
date or indefinitely.

Execute on specified
date.

Example

* Run every day from 8
am to 5 pm, all summer,
from 1st of June, 2011
until 31st of August,
2011.

e Run every three days
from 8 am to 12 pm,
from 1st of
September, 2011.

* Run every Saturday
and Sunday, 8 amto 1
pm, from 1st of June,
2011 until 31st of
August, 2011.

* Run every second
Monday, beginning
at 8 am, from
September 1st,
2011.

* Run every month, on
15th, 16th,19th and last
day of the month, 8 am
to 5 pm, from 1st of
June, 2011 until 31st of
August, 2011.

* Run every other
month, on all days
except for 10th and
11th, beginning at 8
am, from September
1st, 2011.

* Run once, 3 pm to 4
pm, on the 1st of July,
2011.

A Schedule with any type of recurrence may also specify stop conditions, such as "stop at the
specified time of day" and/or "stop after a specified time interval". When an Outbound Schedule is
stopped, it sends the Complete command (that is Stop, if necessary, followed by Unload) to all dialing

sessions that are configured for this Schedule and are still active or running.

Schedule Items

Each dialing session that is associated with an Outbound Schedule is an item in that Schedule.
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Execution of each Schedule item is controlled by execution points. Each execution point comprises
the following:

¢ An action to be done to the dialing session.

¢ A condition that specifies when the action should be performed.

Execution points are of two types: instant and sequential. Any action that occurs at an execution
point can be either sequential or instant. However, OCS executes instant execution points differently
from sequential execution points, as explained in the following sections.

Sequential Execution Points

This category or set contains execution points that should logically be executed one after another. For
example a dialing session can be started only after it has been loaded, and therefore Load should
generally be the first execution point and Start should be the second in the set of sequential
execution points. OCS activates the first execution point of this set when the Schedule is activated
and only switches to the next (N + 1) execution point when current (Nth) execution point has been
executed. There must be at least one sequential execution point for each Schedule item. Sequential
execution points cannot be configured as repeatable.

When defining sequential execution points for a
Schedule, the At time condition specified for a Stop
action must not be earlier than the At time
condition specified for the corresponding Start
action. OCS does not assume that the earlier Stop
time is on the next calendar day; instead, it starts
the action at the specified time and then
immediately stops it.

Note:

This is not an issue when defining Stop actions with the After
condition; OCS supports execution on the following day in this
case.

Instant Execution Points

This set of execution points is activated immediately upon Schedule activation. Instant execution
points are not dependent on each other. For example, if a Schedule item should be completed when a
specific condition is met, the Complete action should be added to the set of instant execution points.
This set can be empty or contain one or more execution points. Instant execution points can be
configured as repeatable, which means they are executed each time the specified condition for the
given execution point is met.

Execution Points

Execution Points that are created for each Schedule item define what actions are executed for the
Schedule item and when they are executed. An execution point consists of an action (for example,
Load, Start, or Unload) and conditions. The following table summarizes the conditions that can be
applied to each action.
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Conditions Applicable to Schedule Actions

Type of Condition

No condition

At time

After

Time in state

Value of statistics

Note:

Parameters

Not applicable

Time of day

Time period

Name of dialing sessionName of
stateTime spent in state

Name of statisticsName of
objectName of Stat ServerTarget
value of the statistics

Description

Executes action immediately

Executes action at specified time
of day, for example at 3 o'clock.

Executes action after specified
time period has elapsed, for
example after 30 minutes.

Executes action when specified
dialing session assumes the
specified state and spends
specified time interval in that
state, for example when dialing
session 1 has unloaded, or when
dialing session 2 has been
running for 1 hour.

Executes when specified
statistics on specified object
received from specified Stat
Server assumes specified value,
for example when there are no
more dialing records in the
calling lists.

Conditions cannot be logically combined and each
action can have one, and only one, associated

condition.

OCS attempts to execute the action specified for each execution
point and continues Schedule execution regardless of the
success or failure of the action. For example, if you attempt to
Stop and Unload a Schedule item that is already stopped, OCS
will fail to execute the Stop action. Nevertheless, OCS continues
to the next action configured for the Schedule item and will next
try to execute the Unload action.

How Schedules are Executed

All Outbound Schedules are executed independently. When it starts up, OCS reads all Outbound
Schedules from the configuration and calculates the nearest date and time for each Outbound
Schedule to be activated. When that activation date and time comes, for each Schedule item, OCS
activates the first execution point of the sequential set and (if an instant set is present in the
Schedule) all execution points of the instant set.

Activation of an execution point means that it is ready to be executed whenever the associated

condition is met. For example, if the condition is the value of a statistic, OCS begins monitoring the
specified statistic for the target value. If the condition specified as time interval after which the action
occurs, OCS starts the countdown for the given time interval at which the execution point is to be

activated.
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An Outbound Schedule is deactivated after all Schedule items that it contains are unloaded or when
the stop conditions for the Schedule are met. When the Schedule is completed, OCS calculates the
time for the next activation (unless the Schedule was configured to run only once). The Schedule
then waits in a dormant state until the next activation. In addition to control by the configured sets of
sequential and instant execution points, OCS enables you to manually control the Schedule items at
any time during Schedule execution in the same way as for independent dialing sessions. You can
manually stop, start, and unload any Scheduled item using any administrative OCS client (that is,
Genesys Administrator or Outbound Contact Manager). You can also check the status of any Schedule
item in Genesys Administrator or Outbound Contact Manager.

Manual Operations in Schedules

Although you can perform manual operations on schedule items, manually unloading a schedule item
breaks its link to a schedule and the schedule item loses its connection to the schedule. Then, when
the standalone session is activated again, the schedule does not resume control over it. Only
unloading disassociates the item from the schedule. The stop, start, and set dialing modes do not
affect this association.

Dynamic Disabling of Schedules

Whenever an active Schedule is marked in Genesys Administrator as disabled, OCS continues
executing it until it is deactivated (after all Schedule items that it contains are unloaded), or when the
stop conditions for the Schedule are met. If a deactivated Schedule (in a dormant state) is disabled,
OCS does not activate it at the next activation time.

Starting with release 8.1.507.08, the on-schedule-disable option determines how OCS responds to the
dynamic disabling of an Outbound Schedule. This option is configured at the Application or Outbound
Schedule level (at the Outbound Schedule level, the option can be configured only in the default
section of the Annex tab of an Outbound Schedule configuration object).

Regardless of the option value, OCS does not activate a disabled Schedule at the next activation
time.

OCS applies any other dynamic changes to schedule parameters at the next
activation.

Primary / Backup Notifications

For each active Schedule, the primary OCS notifies its backup about the Schedule's current state,
including all of the parameters for activating and deactivating each Schedule item, and provides
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updated information any time a change to the Schedule status occurs. Because it is fully informed of
all Schedule configuration and status information, in case of a switchover, the backup OCS can
resume execution of the Schedule from exactly the same position where primary OCS has left off.
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Architecture

These topics explain the required architecture for outbound campaigns:

* Outbound Architecture Overview
» Dialing Overview
¢ Multiple Sites, Users, and Tenants
* Outbound Contact and HTTP Server
* Other Supporting Solutions
For architectural and related information about

Note: using Outbound Contact in an Outbound-VolP
environment, see Outbound VolP Deployment.
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Outbound Architecture Overview

Qutbound Architecture Overview

Outbound Contact provides an integrated environment for creating, running, and reporting on
outbound campaigns. The following figure illustrates how the Outbound Contact components
integrate with other Genesys components in a standard T-Server environment.

The following subsections describes (respectively) the Outbound Contact components, Genesys
Administrator, and how they fit into the architecture that is illustrated in the following figure.

BE
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Outbound Contact Architecture - T-Server Configuration
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Outbound Contact Server

Outbound Contact Server (OCS), as the dialing engine, is the core of Outbound Contact. It retrieves
information from Calling List(s) with the help of the DB Server and requests that T-Server, or a
Dialogic board (through CPD Server), or another dialer (when using GVP 7.6 Outbound Notification
(OBN) or Interaction Server) dials outbound calls or initiates outbound interactions. OCS monitors the
call flow and reacts to call results and delivers responses to requests from agent desktops.

Desktop protocol for Outbound Contact enables OCS to communicate through T-Server with agent
desktops. Third-party protocol for Outbound Contact enables OCS to communicate through a
Communication DN with third-party applications. Outbound Contact is also capable of communicating
with another OCS, Stat Server, and ICON.

Outbound Contact Server can also use the
following:

e Genesys Voice Platform (GVP) to dial outbound
calls. For more information, see Genesys Voice
Platform.

e Interaction Server to deliver interactions to
Note: agent's desktops. See Genesys eServices
(formerly, Multimedia) for more information.

e Stat Server to provide Agent/Place status
information solely. In any dialing mode, when
monitoring an Agent/Place group is required,
Stat Server should be properly configured;
otherwise, Outbound Contact will not operate.

OCS also performs the following functions:
¢ Reads configuration data—including the options for configuration objects such as Agent Groups, Place
Groups, and Campaign Groups — from the Configuration Database.

* Receives commands from Outbound Contact Manager, Genesys Administrator, or third-party
applications for starting and stopping dialing sessions for Campaign Groups.

¢ Provides pacing algorithms for the dialing of outbound calls.
e Updates call results.

e Applies treatments to records based on call results.

¢ Processes Do Not Call (DNC) requests

e Checks the Do Not Call list for telephone numbers and customer IDs that should not be contacted.
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Genesys Administrator

In release 8.x, Genesys Administrator replaces Outbound Contact Manager (OCM) as the Ul for
Outbound Contact. Genesys Administrator is a web-based Ul that provides provisioning, monitoring,
and deployment abilities for Genesys solutions. It supports the same functionality that was previously
provided by OCM 7.6.

The Outbound-specific features of Genesys Administrator enable contact center managers to perform
the following tasks:

e Manage calling lists:

e Add, modify, and delete records in a list.
Note: Genesys does not recommend changing record status from Retrieved to Ready in a

calling list while a campaign is loaded or running.

e Create chained records in a list.

* Move records among calling lists that have the same table format and that exist in the same type of
DBMS.

* Import/export calling lists.

Browse Calling Lists, Campaign Groups, and their components:

* Use dialing and viewing filters to select records by particular criteria.

Outbound Contact Manager or Genesys Administrator can automatically save a viewing filter when
the user leaves the current calling list. When the user reopens the list, Genesys Administrator

retrieves and displays the filter.

View the relationships among campaigns, agent groups, and calling lists.

Start and stop dialing sessions.

If you start a dialing session with Genesys Administrator, and then Genesys
Administrator stops, the dialing session continues to run. When Genesys
Administrator restarts, OCS updates Genesys Administrator with the current
status of the dialing session.

Create and manage Schedules for Campaign Groups that enable the automatic control of the included
Campaign Groups based on user-configurable criteria.

Manage campaign sequences.

Monitor the current status of dialing sessions for outbound campaigns.

Specify or modify the optimization parameters for any campaigns and campaign sequences that are
running.

Update Do Not Call lists with data from external sources.

Prioritize records for dialing by record type.
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OCM 7.6 still can be used with Outbound Contact
8.x. If you are using OCM, Dialing Sessions are
called Campaign Groups for starting and stopping
operations.

Note:
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Call Progress Detection Server

Call Progress Detection Server is an optional component for switches that do not have Call Progress
Detection (CPD) capability. This server uses a Dialogic board to perform CPD for outbound calls and, if
configured, to record voice files. As the dialer, CPD Server interfaces with OCS and the Dialogic

board.

Dialing Methods

The way in which outbound dialing is performed depends on the dialing method and equipment that
you use. There are several ways to perform outbound dialing:
* No Call Progress Detection (CPD) Server required if
* A switch already has call progress detection capability, or
e SIP Server is used with GVP applications.

¢ Transfer modes—The dialing mode in which calls successfully placed and identified with a positive CPD
are transferred from the dialing resource to the VDN (Vector DN) for distribution to agents.

e ASM (Active Switching Matrix mode) modes:

* For the Dialogic boards, the board connects to the switch through an ISDN carrier. In this mode,
outbound calls are a combination of the following:

e An internal call from the board to the agent desktop (an engaging call).

¢ An outbound call from the board to the public switched telephone network (PSTN).

CPD Server connects these two calls on the Dialogic board when it is time to establish a call between
an agent and a dialed number. Therefore, this method requires twice as many Dialogic ports as
Transfer mode requires.

ASM mode is the only supported dialing mode
when using T-Server for Cisco Call Manager or
Note: Unified Communications Manager and CPD Server
with Dialogic boards. This limited support is due to
T-Server's inability to monitor CPD or IVR ports.

For more information on these dialing modes, see Dialing Modes.

Engaging Calls

An engaging call usually is an internal call dialed from the call-processing port (dialing modes that
used in conjunction when using CPD server) or from the Trunk Group DN (dialing modes that used in
conjunction when using VoIP environment) to the Voice Transfer Destination DN and is delivered to an
agent from this DN. An agent answers this call, which makes the agent engaged—that is ready to be
connected (bridged) to an outbound call with a customer.

The ASM mode provides the following functionality to enhance performance:
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¢ Eliminates unacceptable delays between the time when a customer picks up the phone and when the
call is connected to an agent.

* Avoids lack of support for call transfers.

e Eliminates force-tone problems in which a customer can hear a signal intended only for an agent — for
example, when a signal alerts the agent that a call is transferred.

In the Predictive with seizing dialing mode, a call is dialed automatically, based on a prediction of
agent availability; the agent is then seized (engaged) before the called party answers. There is no
delay after the customer is connected. OCS includes a campaign-pacing engine with a Predictive
dialing algorithm that initiates the record dialing. In the Progressive with seizing dialing mode, a call
is dialed automatically when an agent is already on the line and ready to take the call. Progressive
with seizing means Progressive dialing in ASM mode.

In both modes, the agent should be on the line (engaged) before the customer answers. The
differences between these two dialing modes are as follows:

e In Progressive with seizing mode, the agent is already reserved for the call when it is dialed.

* In Predictive with seizing mode, the agent is predicted to be available when the dialer places the call.

In release 7.6.101 and higher, the predictive
algorithm accounts for the average engaging call
dialing duration (defined as the time between an

Note: agent going ready and becoming ASM Engaged
when the engaging call is delivered to the agent)
for a given campaign and uses this value when
calculating dialing pacing.

Centralized CPD Server
Outbound Contact supports a centralized CPD Server.

A contact center that has a multi-site environment can use a single CPD Server at its central location.
With a centralized CPD Server, a routing strategy at the central site can send calls and events to
Routing Points that are distributed across the network.

For example, in a multi-site environment where a group of agents are logged into a switch, you can
use a single CPD Server that is connected to any T-Server at that same site. The agents do not have
to be logged in to the same switch to which the CPD Server is connected. With a centralized CPD
Server, a routing strategy at the central site can send calls and events to Routing Points that are
distributed across the network. For more information, see also Multi-Sites.

Sample Call Flow with Centralized CPD Server

The following is a sample call flow using a centralized CPD Server. In this example, Steps 1 through 7
occur at the central location in a wide-area network (WAN).

The OCS sends a dial request to the CPD Server. (Both the OCS and CPD Server are at the central
location.)

CPD Server sends a dial request to its Dialogic board.
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The Dialogic board dials the customer's number. A switch conveys the call to the customer, while the
Dialogic board performs call-progress detection.

After receiving an Answer call result, the CPD Server transfers the call to a Routing Point.

A T-Server, that is monitoring the switch to which it is linked (by a CTI link), informs the Router about
the call at the Routing Point.

The routing strategy at the central location determines how to route the call. In this example, the
routing strategy determines that the call should be routed to an agent at an outlying site.

The Router sends the call to Inter Server Call Control (ISCC), an external routing feature of T-Server.

ISCC sends the call to a second switch that is being monitored by a second T-Server. The second
switch relays the call to an ACD Queue for a group of agents.

In this step, the second switch, the T-Server that monitors it, and the group of agents associated with
the ACD Queue, are all at an outlying location in the network.

Voice File Recordings

CPD Server is able to record files in a plain VOX format (PCM/8000Hz/8bps). It creates two voice files
for each outbound call:

e File 1 contains the line recording for the call-progress detection stage.

* File 2 records the conversation between an agent and the called party if the call result is answer (ASM
mode only).

Recording on Dialogic Ports

CPD Server records these voice files on the Dialogic ports used for outbound dialing. Specific ports
are not dedicated for recording, but the number of ports to use for recording is configurable.

The option max-number-ports-to-record specifies the maximum number of agent ports on which CPD
Server records at the same time. You configure this option in the CPD Server Application object in
Genesys Administrator or Configuration Manager.

The cpd-recording option enables or disables the recording of File 1 only (call progress detection
stage).

CPD Server counts the ports being recorded, and stops recording when the specified number of ports
is engaged for this purpose. CPD Server will not record on another port until one is disengaged.

The number of times that the same call transfers from Agent DN to Agent DN does not increase the
number of ports being used for the recording of that call. The call remains on the same port when it
passes from agent to agent. This extended port usage for recording might necessitate the allocation
of more Dialogic resources—that is, an increased number of ports to be used for outbound dialing in
general.

For information about the max-number-ports-to-record and cpd-recording options, See CPD Server
Options.
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Voice File Names and Content

Voice file names have the format

<Prefix>_<RecRef>_ <PhoneNumber>_ <Date> <Time>_ <AgentCustPortNames> where each of the
variables in angle brackets is replaced by an alpha/numeric string. The following table lists and
describes each of these variables.

Information in File Names

Variable in File Name Structure Description

<Prefix> Prefix for file type

<RecRef> Recording reference number

<PhoneNumber> Phone number

<Date> Date of the recording

<Time> Starting time of the recording

<Agent/CustPortNames> Agent Dialogic port name
<Prefix>

The prefix in the file name is set by the following CPD Server configuration options:

e cpd-file-name-prefix for call result (the default is cpd ).

* conversation-file-name-prefix for conversation (the default is conv_).
For more information about these options, See CPD Server Options.
<RecRef>

CPD Server assigns a recording reference number to each voice file as part of its name.

<Date>

The date is presented in the following format:
<Month (two digits)> <day (two digits)> <year (two digits)>

For example, 060703 represents June 7, 2003.

<Time>

Time is presented in this format:

<Hour (two digits)> <Minutes (two digits)> <seconds (two digits)>
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For example, 111545 represents 11 hours, 15 minutes, 45 seconds.

The hour is presented in 24-hour format as shown in these examples:

* 6:00 AM is 060000.
* 6:00 PM is 180000.

Examples of File Names

The following are sample file names:
¢ Sample file name for a call result voice file:
Call_Result_5551212_060703_060000_dtiB1T1.vox
e Sample file name for a conversation voice file:

Conv_5551212_060703_060005_dtiB1T1_dtiB1T2.vox

The call result file is created for call-progress
detection only, and the file name contains only one
CPD port. A conversation file, which records an
actual conversation between an agent and a
customer, is recorded in ASM mode only and the
file name contains two CPD ports.

Note:

Answering Machine Final Beep Detection

Starting in release 8.1.1, CPD Server can be configured to detect the final beep after an answering
machine greeting before processing the call any further. This functionality is especially useful when a
message should be recorded on the customer's Answering Machine device as a result of the
outbound campaign contact. Beep detection ensures that the message begins playing (and being
recorded by the Answering Machine) only after AM greeting is fully over. This ensures that a message
is recorded on the AM in full, and no starting part of the message is lost.

This functionality is available only when CPD Server is used with Dialogic DM3 boards or HMP
software.

The following configuration options are used to provision this feature:
¢ am-beep-detect--Enables or disables this feature.

* am-beep-detect-timeout--Defines the time that CPD Server waits for the final beep.

* am-beep-tone-<n>--Defines AM final beep tones. See AM-beep-tones Section.
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CPD Proxy Server

CPD Proxy Server distributes calls among various CPD Servers for optimal load-balancing and
utilization of system resources. CPD Proxy Server distributes calls for load-balancing when the volume
of calls is particularly heavy. It also notifies clients about changes in hardware resources due to
configuration and license modifications, or "out of service" events caused by hardware problems. In
general, CPD Proxy Server can be used in any situation to improve overall system stability and load
distribution. The following figure illustrates how CPD Proxy Server relates to other components.

CPD Cluster
Configuration Server
CPD Server 1
Clients
. CPD Proxy [ CPD Server 2
CPD Server N

Configuration with CPD Proxy Server
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Dialing Overview

A typical Genesys system consists of agent desktops, a T-Server or a SIP Server, one or more OCS
applications, and a calling list database.

For an enterprise that uses T-Server, this central component, a computer-telephony integration (CTI)
server provides a transport layer for all the system's telephony information. All information to and
from the desktop and other servers passes through T-Server. The agent desktop and OCS are clients
of T-Server. For an Outbound-IP environment, SIP Server functions as the transport layer.

e The value of the T-Server and SIP Server
consult-user-data option should NOT be set
to separate. This value prevents OCS from
correctly processing a call flow when an

Notes: outbound call is transferred by a consultation
call.

e For information about a VoIP environment that
uses SIP Server instead of T-Server, see
Outbound VoIP Deployment.

Smart Logout

The Smart Logout feature ensures that an agent is not logged out of a campaign until all calls that
were assigned to the agent are returned to the calling list or are completed by the agent (refer to the
"Agent Logout" section in the "Communication Protocols" chapter of the Outbound Contact Reference
Manual). After the completion of Smart Logout (after OCS sends the LogOutAcknowledge
message—refer to the "LogOutAcknowledge" section in the "Communication Protocols" chapter of the
Outbound Contact Reference Manual), agents are assigned to the Inbound activity.
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General Agent Desktop Interaction with
OCS

The following figure illustrates the data flow for a typical customer record.

This figure is not specific to any particular

Note:
sequence of events.
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Data Flow for Typical Customer Record
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Check Against Do Not Call List

OCS reads all records from the table that is referenced in the gsw_donotcall_list Table Access and
populates separate tables in memory with the unique values from the phone and customer _id fields.
The tables in memory mirror the DNC List in the database. OCS checks these tables in memory
during a Do Not Call predial check.

If OCS finds a phone number in the Do Not Call table in memory during a predial check, it applies the
DNC restriction to the phone number and does not check the customer ID. The phone number has a
higher priority than the customer ID if they are both in a dialing record. The following figure illustrates
the predial check process.

Racord
retrieved for
dialimg

Mark in DB
type=NoCall

End

Is customer i

Mey—— Dialing

Yes

Mark in DB
type=NoCall

End

Dialing

Predial Check by Phone and Customer ID
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Dialing Modes

Outbound Contact supports the following dialing modes:
e Predictive (a Transfer mode). For a standard environment, see Predictive Dialing Modes; for a VoIP
environment, see Predictive GVP Dialing Mode.

e Predictive with seizing (an Active Switch Matrix [ASM]) mode). For a standard environment, see
Predictive with Seizing Dialing Mode; for a VolP environment, see Outbound-VolP in ASM Dialing Modes.

* Progressive (a Transfer mode). For a standard environment, see Progressive Dialing Mode; for a VolP
environment, see Progressive GVP Dialing Mode.

* Progressive with seizing (an ASM mode). For a standard environment, see Progressive with Seizing
Dialing Mode; for a VoIP environment, see Outbound-VolP in ASM Dialing Modes.

¢ Preview. See Preview Dialing Mode.

e Push Preview. See Push Preview Dialing Mode.

¢ Direct Push Preview. See Direct Push Preview Dialing Mode.

* Power GVP. See Power GVP Dialing Mode.

e Last In First Out (LIFO). See Last In First Out Campaign Groups for Record Processing.

For more information about a VoIP deployment, see

e Outbound VoIP Deployment.

After a dialing session for a campaign has started, the user can change the dialing mode in the
following ways:

* From Predictive to Progressive, and vice versa

If you change the mode from Progressive to
Predictive while the Campaign is running, the
Campaign switches to the new mode when it
reaches the value set by the history length option.
If that value has already been reached at the time
of the change, the mode changes immediately.

Note:

e From Predictive with seizing to Progressive with seizing, or vice versa

To change from any Predictive or Progressive dialing mode to Preview dialing mode, you must stop
and restart the dialing session for the campaign group.

Outbound Contact supports call blending in any dialing mode. Among other considerations, OCS
takes into account queued inbound calls. By using the progressive_blending_reserved_agents option,
you can specify the number of reserved agents in Progressive dialing mode that should be available

for inbound traffic. For more information about the progressive_blending_reserved_agents option, see

Outbound Contact Configuration Options.
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Dialing Modes and Third-Party Clients

Outbound Contact supports communication with Interaction Server, as a third party client, over a
dedicated ESP port. For Campaign Groups in Push Preview and autodial modes the following third
party client operations are supported if they meet the Request Attribute Requirements:

» Cancel records

e Mark records as Do Not Call
¢ Update records

* Process records

* Reschedule records

e Add records

Request Attribute Requirements

To support all operations of third-party clients:

e For requests to cancel records or mark records as Do Not Call, the request must include one of the
following to identify the target record(s):

* A valid record handle.
If the record handle is specified in the request and OCS finds a record that has that record handle,
the record or the entire chain is marked as canceled in the Calling List(s).

* Contact Info.
If Contact Info is specified in the request without the record handle, all records that have that
Contact Info (and all chains, if any, that include these records) are marked as canceled in the
Calling List(s).

e Customer ID.
If Customer ID is specified in the request without the record handle, all records that have that
Customer ID (and all chains, if any, that include those records) are marked as cancelled in the
Calling List(s).

Optionally, the Campaign name can also be
specified to limit record cancellation to a Campaign

e that has the specified name.

Interaction ID should be specified if URS is processing an
interaction that was created by Interaction Server.

* For all other records, the request must include a valid record handle.

Routing Strategy Design

You can enhance your strategies which are used to route outbound call to the group of agents or
group of places. You do so by using strategy blocks from the Outbound folder in Interaction Routing
Designer (IRD). As with all the other blocks that you use in the strategy, you select the block you
want to use (for example, Update record) and set the properties within this block, such as the name
of Outbound Contact Server, the record handle (which you can extract from the user data of the
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outbound call), and user data values that you want to pass to OCS for update.

Predictive Dialing Modes

There are three predictive dialing modes:

¢ Predictive Dialing Mode
* Predictive with Seizing Dialing Mode
* Predictive GVP Dialing Mode

In the predictive dialing modes, Outbound Contact can dial more calls than the number of available
agents in a group--making use of the predictive algorithm to determine the pacing.

Predictive Dialing Mode

The Predictive dialing mode predicts agent availability when it dials calls from a calling list. Predictive
mode is recommended for high-volume, low-value campaigns.

Predictive with Seizing Dialing Mode

In the Predictive with seizing dialing mode (an ASM mode), a call is dialed automatically, based on a
prediction of agent availability, and the agent is "seized" (engaged) before the called party answers.
There is no delay time after the customer is connected. Predictive with seizing is an Active Switching
Matrix (ASM) mode.

Predictive GVP Dialing Mode

In the Predictive GVP dialing mode, the non-zero waiting time is taken into account, implementing a
call flow that uses a system queue for impatient customers. In this model, a waiting customer might
give up (or abandon) the call after a period of time. Based on the assumption that these time periods
are exponentially distributed random values with an average value that characterizes the customer's
patience, the Predictive GVP algorithm calculates an outbound dialing rate to achieve the Target
Value of the optimization method, by using the average customer patience time. The algorithm
dynamically estimates the average patience time, based on the last call's statistics.

The following optimization methods can be used with Predictive GVP dialing mode:

* Agent Busy Factor

e Overdial Rate

e Average Waiting Time

¢ Average Distribution Time

OCS always uses Hot Start in the Predictive GVP
dialing mode. If the options for the predefined

statistical data (predictive_patience_time,
predictive_hit_ratio,

Note:
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predictive_outbound_call_duration,
predictive_inbound_rate, and
predictive_inbound_call _duration) are not
configured, OCS applies their default values, which
may not be efficient.

Agent Feedback for the Predictive Dialing Modes

To improve dialing efficiency in the predictive modes (for example, to increase the Busy Factor for a
given value of the Abandon Rate), OCS supports better optimization by accepting estimated call-
completion time notifications from agents through the ReadyTime event. In this event, the agent
desktop provides OCS with preliminary information on the time remaining for an agent to complete
call processing.

As a result of these notifications, OCS evaluates whether an agent is trusted or distrusted. A trusted
agent is one with a calculated trust factor that is less than the Overdial Rate optimization parameter
for that campaign. In other words, the agent is available to handle another call when OCS expected
the agent to be available.

A distrusted agent is one with a trust factor that is greater than the Overdial Rate for that same
campaign.

The trust factor is the percentage of false notifications in comparison to all ReadyTime events
received. A notification is considered false when an agent is not ready within the tolerance set in the
time-to-ready-tolerance option after OCS receives the ReadyTime event. This tolerance is the allowed
accuracy in the agent's estimation of when that agent will complete call processing and become
Ready.

OCS and the predictive algorithm rely on the accuracy of this information to determine when the
agent is Ready.

All agents are distrusted when a dialing session for
a campaign first starts.

The predictive_algorithm option must be set to

advanced_small_group for the time estimate (when the agent
Note: will become Ready) that is delivered to OCS from the agent

desktop to be considered by the predictive algorithm.

Time to going Ready estimates are taken into account only if the
Overdial Rate is used as the optimization parameter.

OCS does not support the Agent Feedback feature

NEIEE in the Predictive GVP dialing mode.

Predictive Algorithm

The predictive dialing algorithm performs real-time pacing calculations based on continuously
sampled values for the following parameters:

e Statistics:
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* Average talk time (for both outbound and inbound calls)
* Average not ready time
* Average wrap-up time
* Average contact rate per campaign (percentage of answered calls over total dialed calls)
* Number of currently queued calls (both inbound and outbound)
* Average inbound traffic volume based on the value of the history_length option
* Resources:
* Number of available agents logged in the group

* Number of available dialing ports

e Controllable parameters:

* Optimized parameters, such as Agent Busy Factor, Overdial Rate, Average Waiting Time, Average
Distribution Time (for Predictive GVP dialing mode only)

e Goal value of the chosen optimized parameter

Outbound Contact can support an unlimited number of agent groups, each of which has its own
independent dialing engine. In other words, each group can run its own outbound campaign with its
own pacing based on real-time, campaign-specific statistics. By default, Outbound Contact treats all
agent groups with which it works as blended groups by immediately adjusting pacing if both inbound
and outbound calls are routed to the same group.

Optimization Parameters

In predictive dialing modes, Outbound Contact offers optimization parameters. These parameters
directly affect the performance of dialing algorithms in the predictive dialing modes. These
parameters include the following:

e Agent Busy Factor

e Overdial Rate

¢ Average Waiting Time

e Average Distribution Time
e Maximum Gain

You specify these parameters as part of the campaign group configuration process within Genesys
Administrator > Provisioning tab > Outbound Contact > Campaign > Campaign Group.

Predictive Algorithm for Customer Abandoned Calls

This algorithm, used in the Predictive GVP dialing mode, implements the Average Distribution Time
optimization method (in addition to the other four optimization methods). See Optimization
Parameters. The Target Value for this optimization method is the average waiting time in queue for all
calls, including abandoned calls. The waiting-time-in-queue begins the moment a call is queued to be
transferred to an agent and ends when the call is connected to the agent or abandoned. The
Predictive GVP algorithm calculates and logs the actual value of the average waiting-time-in-queue,
which is the actual average distribution time.
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The Target Value for the Average Distribution Time optimization method should be less than the
average patience time. In accordance with the Erlang-A model for exponentially-distributed customer
waiting times, the expected Abandon Rate is calculated as follows:

Abandon Rate = Average Distribution Time / Average Patience Time

The Predictive algorithm for the Predictive GVP dialing mode handles inbound traffic in the same way

as all other Predictive algorithms, but also applies the following restrictions, and performs the
following calculations:

Restrictions

¢ Restricts the outbound dialing pace so that the expected Abandon Rate does not exceed 30 percent.

¢ Restricts the outbound dialing rate so that the number of busy ports does not exceed the total number
of ports available for Campaign Group. The number of busy ports equals the current number of calls in
the dialing and queued states. The total number of available ports is the lesser of the total ports for the
Trunk Group as reported by SIP Server in the EventResourcelnfo parameter and the non-zero value of
the number of CPD ports that are specified for the Campaign Group.

¢ Restricts the outbound dialing rate so that the number of requested outbound calls-per-second does not

exceed the maximum number of dialing-requests-per-second, as specified for Campaign Group by using
the dialing_rate_limit configuration option.

Calculations

¢ Calculates the Hit Ratio as the percentage of queued calls, relative to all dialed calls. Calls answered by
a live persons and released without this queuing are considered a special type of No Contact call.

e Calculates the Overdial Rate as the percentage of abandoned queued calls, relative to all calls that are
queued to be transferred to an agent. When the actual Abandon Rate (calculated from the time when
the Campaign Group is started) exceeds the value that is specified by the predictive_max_overdial_rate
configuration option, OCS switches the predictive algorithm to the Advanced Small Group algorithm,
where the Target Value equals the predictive_max_overdial_rate configuration option or the pa-
abandon-rate-limit configuration option, if the latter is smaller.

The Predictive algorithm for the Predictive GVP dialing mode supports the features that are currently

implemented for the other Predictive algorithms, including Agent Assignment, the dynamic allocation
of dialing rate and ports, and the self-diagnostic.

Configuration Options
The following options can be configured to optimize the Predictive GVP algorithm:

e predictive_patience_time--Use this option to specify the starting value of the average patience time.

* pa-selfcheck-adt-threshold--Use this option to specify the percentage of the target Average Distribution
Time that the Predictive algorithm uses as the threshold to report the dialing performance degradation.

When you are using the Predictive GVP dialing
mode, there are some important things to note.

Note: The pa-dial-expire and pa-queue-expire configuration options
specify the timeouts for cleaning up stuck calls that are in dialed
and queued states. The timeouts are used to distinguish normal
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and abnormal call flows. These options should be set to values
that are higher than the maximum expected durations of each
state. When you are using Predictive GVP mode, these durations
might be significantly higher than for other dialing modes.

The pa-hitratio-min configuration option specifies (as a
percentage), the minimum value of the Hit Ratio, which is used
to predict the dialing pace. The Hit Ratio is the percentage of
queued calls, relative to all dialed calls. For Predictive GVP
mode, calls are queued only when conversations with live
agents are required. Therefore, the Hit Ratio can be significantly
less than that of a regular Predictive mode. This option should
be set to a value that is less than the minimum expected
percentage of conversations with agents to all dialed calls.

Predictive Algorithm for Pacing Based on Gain/Loss Criteria

This algorithm uses the Maximum Gain optimization method for the Predictive dialing mode. This
method dynamically predicts the optimal dialing pace to maximize the total gain of a campaign,
based on a given ratio of benefit-per-established-call to loss-per-abandoned-call. This method has no
target value in the strict sense, but Target Value is used to set the benefit-to-loss specific ratio (see
Configuring Maximum Gain). Contact center managers can set this ratio in accordance with the real
impact of established and abandoned calls on a campaign.

The Maximum Gain optimization method can be used in the Predictive, Predictive with Seizing, and
Predictive GVP dialing modes. This method supports existing features for the other optimization
methods, such as a preliminary Progressive-in-Predictive mode (using Hot Start with predefined
statistical data), Agent Assignment, the dynamic allocation of the dialing rate and ports, and the self-
diagnostic algorithm.

In addition, the Maximum Gain optimization method includes a special algorithm that maximizes the
total gain for small groups of agents. This algorithm considers the benefit-to-loss specific ratio, the
current readiness of agents to answer calls (including estimated call-completion time notifications
from agents), the current numbers of dialed and queued calls in progress, and the estimated value of
the Hit Ratio. It is configured in the same way as the Advanced Small Group algorithm for the
OverDial Rate optimization method.

Example

To find the optimal Target Value for this optimization method, compare the beneficial effect of an
increase in Agent Busy Factor to a negative effect of an increase in Overdial Rate. The Agent Busy
Factor is determined by the number of established calls (answered by agents) and the Overdial Rate
is determined by the number of abandoned calls.

Assuming that each established call provides a benefit (B) and each abandoned call incurs a loss (L),
the total gain (TG) (the total B minus the total L) per average service time is calculated as follows:

TG = ABF*N*B - ODR*DP*L
Where:

* ABF = Agent Busy Factor
¢ N = Number of agents

e B = Benefit value per each established call
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¢ ODR = Overdial Rate
e DP = Dialing pace (in Erlang units)

e L = Loss value per each abandoned call

Configuring Maximum Gain

Use Genesys Administrator to set the Maximum Gain optimization parameter for any type of
Predictive dialing mode that uses this parameter. When this optimization parameter is selected, you
will be prompted for the following two values:

e Established outbound call gain
e Abandoned outbound call loss
When Genesys Administrator communicates with OCS to store information in the Campaign Group

configuration object, it uses the following formula to convert the two values to the following single
value:

Target Value = (Established Gain/Abandoned Loss) * 100
Restricting the Abandon Rate

The predictive_max_overdial_rate configuration option is used to restrict the real Abandon Rate by
switching the dialing mode from Predictive to Progressive if the current actual Abandon Rate exceeds
the value of this option. However, switching to Progressive mode can significantly reduce the Busy
Factor. Therefore, this option is best used to guarantee compliance with the legal requirements of
Abandon Rates.

Genesys recommends that you use the pa-abandon-rate-limit configuration option (see pa-abandon-
rate-limit) with the Predictive algorithm to restrict the expected Abandon Rate in all types of
Predictive modes and for all the types of optimization methods.

Predictive Algorithm for Small Groups

Outbound Contact provides you with two predictive algorithms for dialing outbound calls during a
campaign that are specifically designed to handle small groups of agents.

* Small group algorithm--This algorithm waits until all dialed calls are completed before dialing new calls.

e Advanced small group algorithm--This algorithm accounts for all inbound calls and also allows calls to
be initiated, even if one or more calls remain in the dialing stage, instead of waiting until all dialed calls
are completed.

You specify the small group algorithm by configuring the predictive algorithm option with either the
small_group or advanced_small_group value. You can choose to exclude current outbound calls with

long dialing durations from pacing calculations made by the advanced small group algorithm. To do
so, set the value for the pa-exclude-long-dialing configuration option to true.

Predictive Algorithm Self-Diagnostic

In release 7.6.101 and higher, the predictive algorithm has been enhanced with self-diagnostic
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capabilities to limit performance degradation, which could result in a deviation from the optimization
parameters (Busy Factor, Overdial Rate, and Average Waiting Time) that are associated with the loss
of a dialing pace.

Four options are associated with this self-diagnostic capability:

¢ pa-selfcheck-awt-threshold

¢ pa-selfcheck-bf-threshold

pa-selfcheck-odr-threshold
* pa-selfcheck-interval
Diagnostic results are reported using log events that identify the expected cause of the degradation
and addresses four areas:
e 12-50131: call-related factors, which include the following scenarios:
* Unexpected call-related agents' activity, which can be caused by:

e Agent state PA_StatAgentBusyRingOrDial that is not caused by Outbound, OutboundOther, or
Inbound call types.

e Agent goes to the Not Ready state from the Ready state but is not checked out.

e Agents log out from the Ready state, but does not use Smart LogOut.

Low Hit Ratio.
» Transferring outbound calls to another campaign.
* Receiving outbound calls that are transferred from another campaign.

* Engaging call duration influence.
A sample log event of this type might be:

12:35:49.844 Std 50131 Campaign Group 'Alpha Campaign@AlphaAgentGroup’, Busy Factor defined
80, actual 50, call-related reason: Hit Ratio is low
e 12-50132: configuration factors, which include the following scenarios:

* Long calls, which last more than outbound agent outlier limit) on agents and thus agents become
Not Available.

* A dials-per-second limitation on the switch or Campaign Group level

* Violation of Overdial Rate limitation (predictive_max_overdial_rate) with a transition to the
Progressive-in-Predictive mode.

¢ 12-50133: malfunctions, which include the following scenarios:
* Abandoned calls in the presence of Ready agents.

e Cleaning or removing outbound calls (calls that are frozen in either a Dialed or Queued state and
removed by the Garbage Collector).

* Not Ready agents become Busy with new outbound calls (usually caused by an inadequate
telephony event sequence).

e The Outbound dialing rate is greater or less than predicted.
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e 12-50134: external conditions, which include the following scenarios:

* Lack of dialing ports.
e Campaign Group--related waits:

e Lack of dialing records.

¢ Lost connections to important supporting servers (for example, T-Server or Stat Server).
e Missing connection to the Do Not Call list.

Time-Optimized Predictive Algorithm

The time-optimized predictive algorithm provides contact centers with the flexibility to adjust the
dialing pace for a specific period. The main benefit of this algorithm is that it allows you to increase
the Busy Factor but still keep the overdial rate (ODR) within legislative limits. This improves the daily
performance for the Busy Factor and the wait time for each agent.

In releases prior to 8.0, the classical predictive algorithm calculated the required dialing pace only
based on the ODR that was set in the Campaign Group object. However, the actual overdial rate
might be less at any given time because of factors such as:

¢ A non-zero waiting time for accepted outbound calls in a queue that the classical predictive algorithm
does not take into account.

¢ A decrease in the hit ratio and in the average call duration and an associated increase in the number of
available agents.

* The loss of dialing and queued outbound calls due to errors or transfers to other campaigns.

This time-optimized algorithm optimizes predictive dialing by recalculating the dialing rate so that the
overdial rate criteria is met for a specific period of time (day, month, and so on). For example, if the
target value for the overdial rate is 3 percent for an eight-hour business day, a new target value can
be calculated and the dialing rate can be adjusted every hour so that the overdial rate for the eight-
hour period meets the target value for that 8-hour period (as configured in
predictive_max_overdial rate. This increases the predictive dialing efficiency.

Depending on the current overdial rate, this time-optimized algorithm functions as follows:

e If the current overdial rate is less than the target, the acceptable overdial rate can be greater than the
target for this time period. Therefore, the new dialing rate can be greater than the dialing rate that is
predicted by the classical predictive algorithm. With this new algorithm, OCS increases the dialing rate
by the difference between the target and the current overdial rates. This dialing rate increases the

agent-busy factor. As a result, outbound campaigns that run under legislative limitations on the
overdial rate can be more efficient.

¢ If the current overdial rate is greater than the target, the acceptable overdial rate must be less than the
target in order to average out ultimately to meet the target value.

Therefore, the new dialing rate must be less than the dialing rate predicted by the classical predictive
algorithm. In this case, the algorithm evaluates whether it can maintain the higher dialing rate, which
increases the agent-busy factor, but at the same time meets the overdial rate target. If it cannot
achieve the target, the algorithm chooses the dialing rate that produces the minimum predicted
overdial rate. Decreasing the dialing rate decreases the overdial rate; hence, outbound campaigns
that run under legislative limitations on overdial rate are more reliable as they take into account the
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busy factor, the overdial rate, and the changing call load over the course of a time period (such as an
eight-hour day).

If the predicted busy factor for the chosen dialing
rate is less than the predicted busy factor for the
Note: Progressive dialing mode, the time-optimized
’ algorithm switches to the Progressive dialing mode,
because it will result in a zero overdial rate for the
remainder of the time period.

Configure the following options for the time-optimized algorithm:

» predictive_algorithm--Set the option to time_optimized_odr (a new value that was added in 8.0) that
enables the use of this algorithm.

¢ pa-odr-interval--Specify the period of time, in minutes, over which OCS averages the overdial rate
that must match the target overdial rate.

« predictive_max_overdial_rate--Specify the maximum allowed overdial rate for dialing in Predictive
mode.

» predictive_min_overdial_rate--Specify the minimum allowed overdial rate for dialing in Progressive
mode.

Predictive Algorithm and Engaging Call Dialing Duration

In release 7.6.101 and higher, OCS calculates the average engaging dialing call duration (defined as
the time between an agent going ready and becoming ASM Engaged when the engaging call is
delivered to the agent) for a given Campaign Group. The predictive algorithm takes this value into
account when it calculates dialing pacing. With this enhancement, OCS changes the dialing rate
based on the optimization parameters:

* When using the Overdial Rate optimization parameter, OCS can restrict the dialing rate so that its
growth will be less than 10 percent.

* When using Average Waiting Time or Busy Factor, OCS can increase the dialing rate.

In addition, be aware of the following:

¢ As part of the self-diagnostic capability (Predictive Algorithm Self-Diagnostic), if OCS detects that the
target value of the optimization parameter cannot be reached or that the dialing rate is restricted, OCS
sends the STANDARD 12-50131 event, identifying the impact of the engaging call dialing duration.

e In a primary/backup configuration, OCS passes the value of the average engaging call dialing duration
to the backup Predictive Algorithm.

e For the advanced small group predictive algorithm, when using the ASM dialing modes, after OCS
receives the agent's ReadyTime notification specifying when the agent will become ready for engaging
calls, OCS increases the value by the average engaging call dialing duration to predict when the agent
will actually become ready for new outbound calls. OCS uses this corrected ReadyTime value when it
compares the value to the value when the agent actually becomes ready to determine the agent's trust
factor.
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Progressive Dialing Mode

The Progressive dialing mode dials calls from a calling list when an agent is actually available.
Progressive mode is recommended for low-volume, high-value campaigns. The number of calls that
are dialed depends on the number of Ready agents. The next dialing attempt is triggered by either of
the following factors:

e The AGENT_VOICE_MEDIA_STATUS - WaitForNextCall Stat Event message is received from Stat Server

¢ A non-positive call-progress result is received from the dialer
OCS places one (1) outbound call for one (1) Ready agent.

This dialing mode also supports Progressive Multiplier functionality ("lines-per-agent"), which enables
you to change the number of outbound calls dialed for each available agent. This feature is
configured using the pa-progressive-multiplier option.

Progressive with Seizing Dialing Mode

In the Progressive with seizing dialing mode (an ASM mode), a call is dialed automatically when an
agent is already on the line and ready to take the call. Progressive with seizing means Progressive
dialing in ASM mode.

In both Progressive with seizing and Predictive with seizing modes, the agent should be on the line
before the customer answers; however, there is a distinct difference between these two dialing
modes:

* In the Progressive with seizing mode, the agent is already reserved for the call when it is dialed.

¢ In the Predictive with seizing mode, the agent is predicted to be available when the dialer places the
call.

This dialing mode also supports Progressive Multiplier functionality ("lines-per-agent"), which enables
you to change the number of outbound calls dialed for a single engaged agent. This feature is
configured using the pa-progressive-multiplier option.

Preview Dialing Mode

In Preview dialing mode, an agent requests one or several records from OCS, previews each record,
and decides whether to dial a call. The agent interacts with the records by using the desktop
application that communicates (via T-Server) with OCS. The OCS-desktop communication protocol
enables the desktop application to perform the following tasks:

¢ Request and receive a record for preview.

¢ Update certain record fields.

e Schedule campaign or personal callbacks.
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¢ Receive a scheduled record as an unsolicited event from Outbound Contact.

¢ Reject, cancel, or mark a record as Do Not Call.

Preview mode is recommended for low-volume, high-value applications for which individual
ownership of accounts is the highest priority.

Preview dialing mode supports treatments based on call results.

Outbound Contact supports simultaneous participation by agents in multiple preview campaigns,
including one Predictive/Progressive-mode campaign based on the following behavior:

¢ Qutbound Contact Server distributes Campaign Status Notification messages for every campaign with
which an agent is associated.

¢ |If the agent participates in multiple preview campaigns, the record request for a specific campaign may
be specified explicitly in the GSW_CAMPAIGN_NAME attribute of the PreviewRecordRequest. If not
specified, Outbound Contact Server will select a record from any of the campaigns in a round-robin
fashion. In this scenario, the GSW_CAMPAIGN_NAME attribute should have empty string value, or a
NULL string value.

To take effect for the round-robin algorithm, an
Note: agent must be configured for the single group that
is assigned to multiple campaigns.

e If an agent wants to retrieve preview records from multiple campaigns, and the
agent_preview_mode_start option is set with a value of yes, the PreviewDialingModeStart and
PreviewDialingModeOver campaign requests should be submitted from the desktop for every
campaign.

The preview_release_nocontact_action option,
instructs OCS on what action to apply to an agent's
DN when the agent releases an outbound call that
was placed manually in the Preview dialing mode
but could not be established. For this option to take
effect, the attached data of this manually placed
call must contain the GSW_RECORD_HANDLE
attribute with the record handle, which OCS had
passed previously to the agent desktop.

Note:

In release 8.x, OCS can process records with an Instant
Messaging phone type for preview campaigns.

OCS monitors outbound calls that are manually dialed in the Preview mode if they contain UserData
attached by OCS. If OCS does not receive GSW_CALL RESULT in UpdateCallCompletionStats and
RecordProcessed requests, OCS updates the call result field with the call result received from the
dialer. If no dial attempts with the attached UserData have been made, OCS updates the

call result field with “Answer” if the record has been retrieved with the call result value of “OK”
or “Unknown”. Otherwise, OCS does not change the value of the call result field.
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Push Preview Dialing Mode

The Push Preview dialing mode uses Interaction Server to "push" records to agents. The number of
records that are "pushed" depends on the value of the Max Queue Size parameter. See Genesys
eServices (formerly, Multimedia) for more information about this dialing mode.

In release 8.x, OCS supports stopping the
processing of interactions and also updating
records that have not been processed (that is, an
agent did not receive the interaction) when the

Note: dialing session for an outbound campaign is

) unloaded. As a result, OCS updates the Calling List

with the appropriate status. When the dialing
session for a Campaign Group is started again, no
customer receives duplicate contacts for the
associated campaign.

When an agent requests a personal callback in push preview mode, the agent id field is populated
with the place id, instead of the agent id, in the following format: tenant-dbid@place. This means
that callback is treated as a "place callback" because it is delivered to the same place. Therefore, if
you have more than one agent using the same place, then the callback might not be delivered to the
agent who made the request.

If the campaign dialing mode is changed from push preview to some other mode, personal callbacks
do not work because the tenant-dbid@place format is used instead of an agent id.

Direct Push Preview Dialing Mode

Unlike regular Push Preview Dialing Mode, Direct Push Preview Dialing Mode does not require a
connection to Interaction Server in order to have records pushed to agent desktops. Instead, OCS
pushes preview records directly to agent desktops by sending unsolicited User Events
(GSW_USER_EVENT = PushPreviewRecord) to agents that are Push Preview Ready. Refer to the
Communication Protocols page in the Outbound Contact Reference Manual for a description of user
events.

OCS will try to keep n records (where n >= 1) on each Push Preview Ready agent desktop, provided
there are sufficient records in the OCS buffers.

e Similar to Push Preview Dialing Mode, OCS uses
a percentage for the Buffer Size Coefficients
settings. For Direct Push Preview Dialing Mode,
OCS uses a different calculation
(Number of agents * desktop-chains-limit,

Notes: instead of using the value of maxQueueSize).

Therefore, Genesys recommends that you set
the Campaign Group buffer size coefficients to
Minimum = 100 and Optimal = 150.

e Similar to regular Preview Dialing Mode, OCS
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considers Direct Push Preview Dialing Mode
non-autodialing. This means that when an
agent participates in a Direct Push Preview
campaign, the person gets assigned to an
inbound activity, unless there is an autodialing
campaign running for the same agent group. An
agent can participate in multiple Direct Push
Preview campaigns at the same time, as in
Preview Dialing Mode.

If you are using Direct Push Preview with Workspace Web Edition (Genesys Web Services), refer to
this article for additional configuration information.

Push Preview Ready Agents

When distributing Direct Push Preview records to agents, OCS considers the following agents Push
Preview Ready:

¢ An agent is configured in the Agent Group.

¢ An agent is logged in (an agent is not required to be in the Ready state).

* An agent has sent a PreviewDialingModeStart desktop request to OCS (if the agent_preview_mode_start
is set to true).

¢ An agent has less interactions on the desktop than the value of desktop-chains-limit option, where an
interaction is any chain delivered to the desktop through a User Event:

* PushPreviewRecord (actually a chain of such records).

* PreviewRecord (actually a chain of such records).

* Personal Callback (in any dialing mode).

* Personal Rescheduled (in any dialing mode).

e Campaign Callback if it is configured to be delivered as a User Event.

Each second, OCS calculates Push Preview Ready agents for a given Agent Group and places them in
the ordered list as follows:

* Agents who do not have any processed Push Preview Records (for example, agents who have just
logged in).

e Agents who have one interaction on the desktop. OCS sorts agents by the time when interactions are
processed and moves the longest waiting agent to the top of the list.

¢ Agents who have two interactions on the desktop. OCS sorts agents by the time when interactions are
processed and moves the longest waiting agent to the top of the list.

OCS starts from the top of the list and distributes one Push Preview Record to each agent, until
agents are no longer Push Preview Ready or until available records are depleted.
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Configuration Options
To enable this functionality, configure the following configuration options:
e direct-push-preview—Enables the dialing mode that OCS uses for a Campaign Group that is started in

Push Preview dialing mode.

¢ desktop-chains-limit—Controls how many preview interactions can reside simultaneously at an agent
desktop.

Last In First Out Campaign Groups for Record Processing

Starting with 8.1.525.04, OCS supports a special logic for record processing, called Last In First Out
(LIFO). With this Campaign Group logic, after a record is added via a Web AddRecord API request to
CX Contact, OCS places that record at the top of the dialing buffer (instead of placing it at the bottom
of priority buffers), so that the record is dialed immediately. Each newer record placed on the top of
the buffer effectively shifts existing records lower in the buffer position.

Campaign Groups with the LIFO logic can be used with any dialing mode. LIFO Campaign Groups do
not retrieve records from the contact lists. They only operate on records that are added to the OCS
buffer via the AddRecord API request over a Communication DN, originated from CX Contact.

When CX Contact issues an AddRecord notification to primary and backup OCS instances over the
Communication DN, they immediately process it, as follows:

¢ Primary and backup OCSs generate an internal chain of records consisting of one record.

e Primary and backup OCSs add this record at the top of the dialing buffer.

e The primary OCS dials this record when the OCS internal logic allows a call to be placed (for example,
an agent is in Ready state in Progressive dialing mode).

e The primary OCS applies a treatment to the record from a limited set of supported treatments as
described in the next section.

Treatments

LIFO Campaign Groups support all treatments of type Apply To Call, similar to regular Campaign
Groups. However, LIFO Campaign Groups support a limited set of Apply To Record treatments, as
follows:

* Delegate for Processing—allows the execution of a Copy Contact Treatment (in CX Contact terms) over a
LIFO record

e Execute SQL statement

¢ Mark as Agent Error

¢ Assign to Group

e Update all records in chain—updates records as record status = Updated

¢ No Treatment
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LIFO Campaign Groups ignore all other treatments of type Apply To Record.
Limitations

The LIFO Campaign Groups functionality in OCS requires CX Contact and is not supported in a
standalone OCS deployment.

Configuration Options
To enable this functionality, configure the following configuration options:

¢ |ifo-mode—Enables a LIFO Campaign Group record processing.

* lifo-record-expiration—Specifies the timeout for record expiration in the dialing buffer.

 lifo-unload-pace—Specifies the number of chains that OCS attempts to process per second while a LIFO

Campaign Group is unloading.
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Typical Data Flow Scenarios

The following sections describes typical dialing scenarios for Predictive mode (or Progressive mode)
and Preview mode.

Predictive Mode (or Progressive Mode)

The following is a typical data flow scenario for Predictive mode or Progressive mode:

1. When an outbound dialing session for the Campaign Group is started, OCS places the call.

2. If the call is answered by a "live" voice, it is connected to an agent. User data attached to the call is
delivered to the agent's desktop.

3. The agent updates the user data and the call result. The agent then either processes the call or, if
requested by the customer, reschedules the call for a later time as a personal or campaign callback.

The following figure illustrates the data flow for a typical Predictive mode or Progressive mode call. In
this instance, the switch has Call Progress Detection (CPD) capability, and T-Server requests the
switch to dial the customer number. Alternatively, you could configure the system with the CPD
Server, which uses a Dialogic board to dial the call. In either case, the agent is already logged in to
the system.
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Predictive Mode Data Flow

OCS sends a request to the database to retrieve a record.
A record is sent back to OCS, which forwards it to T-Server along with a request to initiate a call.
T-Server initiates the call.

T-Server, or another device, interprets the call and determines that the call should be forwarded to an
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agent. The call result information goes back to OCS.

At the same time, T-Server transfers the call and customer-specific information to an agent. The
agent and the customer are now connected.

The customer provides data to the agent, who updates the record. This information might include a
rescheduled call date and time, a do not call back request, or other data. The agent sends the
updated record to OCS.

After receiving the request, OCS sends an acknowledgment or error message back to the agent.

The agent can update the record as many times as
Note: necessary. With each update, OCS stores the data
’ to its internal buffer and responds with an
acknowledgment or error message.

When the agent and customer have finished, and the call ends, the agent sends the final event to
OCS that the record is completed.

OCS responds to the agent desktop with either an acknowledgement that the transaction is complete
or with an error message.

At the same time, the final update goes to the database.

Preview Mode

The following is a typical data flow scenario for Preview mode:

1. The agent requests that Preview mode begin.
2. The agent requests a preview record.

3. The agent either rejects the record or makes the call.

* If the agent rejects the record, it is returned to OCS. The agent then has two choices:
* Request the end of Preview dialing mode and log out.

* Return to Step 2.

¢ If the agent makes the call and if the customer requests no further calls for this campaign or no more
calls ever, the agent requests OCS to mark the record as RecordCancel or DoNotCall. The agent then
has two choices:

* Return to Step 2.

* Request the end of Preview dialing mode and log out.

If the call reaches the customer, the agent updates the call results and custom fields. Next, the agent
can terminate the call, sending the final call transaction back to OCS, or the customer can ask to
reschedule the call.

¢ The agent then receives the rescheduled record. The agent then has two choices:
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* Return to Step 2.

* Request the end of Preview dialing mode and log out.

e |If the call does not reach the customer, the agent can call an alternate (chained) record.

e If there are additional records in the chain, the agent requests a chained preview record and returns the
beginning of this Step 3.

¢ If there are no additional records in the chain, the agent updates the call results and custom fields,
sending the final call transaction back to OCS. The agent then has two choices:

* Return to Step 2.
* Request the end of Preview dialing mode and log out.
The data flow for Preview mode starts differently from that of the data flow for Predictive mode or

Progressive mode, but is identical once the agent is connected to the customer. The following figure
illustrates the data flow for a typical Preview mode call. The agent is already logged in to the system.
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Preview Mode Data Flow

1. The agent reports to OCS that the agent is ready to begin work in Preview mode.

2. OCS sends back an acknowledgment or error message.

3. The database sends a record or records to OCS, which forwards the records to the agent. These records
might include previously scheduled calls.

4. The agent signals T-Server to initiate a call. T-Server initiates the call.

5. T-Server determines that the call is connected and signals the agent. The agent determines the status
of the connection (fax, answering machine, modem, or customer). If the call is connected to a
customer, the agent proceeds with the call.

6. The customer provides data to the agent, who updates the record. This information might include a

rescheduled call date and time, a Do Not Call request, or other data. The agent sends the updated
record to OCS.

7. OCS either sends an acknowledgment or error message back to the agent.

The agent can update the record as many times
Note: as necessary. With each update, OCS stores the
data to its internal buffer and responds with an
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acknowledgment or error message (Steps 6
through 8).

8. When the agent and customer have finished, and the call is terminated, the agent sends the final event
to OCS that the record is completed.

9. OCS sends the agent either an acknowledgment that the transaction is complete or an error message.

10. At the same time, OCS sends the final update to the database.
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Separate Tracking of Engaging CPD Ports

OCS allows you to explicitly set a limitation on the maximum number of ports that will be used for
agent engagements. This feature is only applicable to Campaign Groups that run with CPD Server or
SIP Server in Progressive with Seizing (see Progressive with Seizing Dialing Mode) or Predictive with
Seizing (see Predictive with Seizing Dialing Mode) dialing modes. When this configuration is in effect,
the number of CPD ports that are used for dialing outbound calls and the number of CPD ports that
are used for agent engagement can be configured and tracked separately by the OCS Predictive
Algorithm. This allows more precise control of the dialing resources in the configurations where
engaging lines and regular lines are separated. It also allows more flexibility if a number of Campaign
Groups (possibly with different logical priorities) simultaneously share the same SIP Server or CPD
Server and the same set of hardware lines.

Provisioning

Separate tracking of the engaging ports is controlled by the asm_channel_num option.
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Dynamic Port Allocation Between
Campaign Groups

Dynamic port allocation allows the optimization of dialing ports usage in configurations where
multiple Campaign Groups share the same dialing and call progress detection resources (for example,
Switch ports or CPD Server ports). This feature is only available for Campaign Groups running in the
Progressive, Predictive, Progressive with Seizing and Predictive with Seizing dialing modes.

Dynamic port allocation requires that Campaign Groups using the same dialer must all
be running in either non-ASM mode or ASM mode. It does not support mixed-modes.

When dynamic port allocation is in effect, OCS performs the proportional dynamic allocation of ports,
based on the estimated average numbers of ports required for each Campaign Group. OCS
periodically recalculates these estimated numbers in accordance with the current dialing parameters,
the number of available agents, and historical statistics. OCS calculates the maximum number of
ports available for each Campaign Group so that this value is directly proportional to the estimated
average number of ports required for this Campaign Group so that the sum of all these numbers for
all Campaign Groups equals the total number of available ports.

Provisioning

Dynamic port allocation is configured by several parameters that combine to form a distinct
configuration. The dynamic-port-allocation option defines whether dynamic allocation is in effect.

Dynamic Port Allocation in VolP environments

For the dynamic allocation of ports among Campaign Groups running in a VolP environment, OCS
uses the total number of ports, which is reported by SIP Server in the total-ports parameter of
EventResourcelnfo messages, instead of the channel_num option that is defined for a Switch object.

Dynamic Port Allocation with CPD Server

In ASM mode with separated regular and engaging ports, OCS performs a dynamic allocation of ports
when the Number of CPD ports property of the Campaign Group or the asm_channel _num option is
set to 0.
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For ASM mode with separated regular and engaging ports, the asm_channel_num option for these
Campaign Groups can also be set to a desired value greater than 0. For these Campaign Groups, OCS
will not perform dynamic allocation of ports, regardless of the dynamic-port-allocation option setting.
In this case, OCS reserves ports for these running Campaign Groups in accordance with their Number
of CPD ports property and the asm_channel _num option setting.

To restrict the maximum number of engaging ports that can be used for a Campaign Group in ASM
mode, the asm_channel_num option can be set to a desired value greater than 0. In this case, OCS
performs dynamic allocation for this Campaign Group only if the Number of CPD ports property is set
to 0.

To restrict the total maximum number of regular and engaging ports that can be used for a Campaign
Group in ASM mode with separated regular and engaging ports, the Number of CPD ports property
can be set to a desired value greater than 0. In this case, OCS performs dynamic allocation for this
Campaign Group only if the asm_channel_num option is set to 0.

Examples

The following three examples describe how ports are allocated dynamically between Campaign
Groups that share the same dialing and CPD resources:

Example 1

¢ OCS runs two Campaign Groups which dial calls in Predictive mode through the same Switch using T-
Server as a dialer. The channel_num option for the Switch configuration object is set to 100, and the
dynamic-port-allocation option is set to true for the same Switch object. Both Campaign Groups have
the Number of CPD Ports property set to 0. OCS estimates the required number of ports for those
Campaign Groups to be 20 and 30. Since the total number of ports is configured as 100, the maximum
number of ports allowed for the Campaign Groups are 40 and 60, respectively.

Example 2

¢ OCS runs two Campaign Groups which dial calls in Progressive mode through the same CPD Server. CPD
Server is configured to use a total of 25 ports. The dynamic-port-allocation option is set to true at the
CPD Server Application level. Both Campaign Groups have the Number of CPD Ports property set to 0.
OCS estimates the required number of ports for the Campaign Groups to be 20 and 30. The total
number of available ports is 25, therefore, the maximum number of ports that are actually available for
the Campaign Groups are 10 and 15.

Example 3

¢ OCS runs two Campaign Groups which dial calls in Progressive mode through the same CPD Server. CPD
Server is configured to use a total of 50 ports. The dynamic-port-allocation option is set to true at the
CPD Server Application level. Both Campaign Groups have the Number of CPD Ports property set to 0.
OCS estimates the required number of ports for the Campaign Groups to be 5 and 100. OCS considers
the number of ports required by the first Campaign Group as small, since 5 > (50 / 2 * 0.3). Therefore,
the maximum number of ports available for the Campaign Groups are 5 and 45.
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Multiple Sites, Users, and Tenants

Multi-Sites

Outbound Contact Server supports multi-site operation. Multi-site operation means that you can run
several dialing sessions for Campaigns independently in different locations using only one Outbound
Contact Server, or you can run one dialing session from different sites at the same time. A site is a
location with a contact center and an agent group.

OCS also supports environments in which agent groups or place groups are distributed across
multiple sites. In this scenario, dialing is performed by one CPD Server or T-Server. OCS relies on ISCC
call distribution to deliver successful calls to agents in multiple sites. If the value of the
transfer_to_unknown_dn option is set to true or yes, OCS correctly processes the route of successful
outbound calls or transfer calls between agents on different switches.

The use-data-from option must be configured with the value
consult-user-data in the extrouter section of all T-Servers used
with OCS. This value enables OCS to correctly process
transferred calls between agents/DNs on different switches.
When this value is set, AttributeUserData and AttributeConnID
values are identified from the consultation call before the
transfer or conference is completed. After the transfer or
conference is completed, the EventPartyChanged message is
Note: generated, and then the AttributeUserData and AttributeConnID
’ values can be taken from the original call.

If a Voice Transfer Destination DN and a T-Server, used as a
Dialer, belong to one switch in a multi-site environment, but the
call is distributed by external routing to an agent who is on a
different site, at least one queue from this site must be listed in
the Origination DN list of the corresponding Campaign Group.
This forces OCS to register regular DNs on the remote site and
receive related events.

In multi-site scenarios, OCS generates statistical user events only on the Communication DN that is
configured under the same Switch object as the Voice Transfer Destination DN.

OCS makes multi-site operation possible because it connects to the T-Server at each site and tracks
the campaign data that is assigned to each agent group at each site.

One example of a multi-site campaign is as follows: A customer has three sites with agents at each
site. One campaign is assigned to three agent groups and runs concurrently at all three sites.

Multi-site does not necessarily mean that a dialing session for a Campaign Group is started at one
site from which calls are distributed to agents in one of three sites; however, with a centralized CPD
Server, it is possible to run a dialing session for a campaign from the central location and connect to
agents who are at outlying sites.

Outbound Contact Deployment Guide 77



Architecture Multiple Sites, Users, and Tenants

Multiple Users

OCS can support multiple instances of Genesys Administrator or Outbound Contact Manager that run
concurrently.

Multi-Tenant Environment

A tenant is typically a contact center (single-site or multi-site). In a multi-tenant site, the
administrator can grant permissions to other users to view their own tenant and run their own
campaigns. Outbound Contact supports multiple tenants. However, Genesys Administrator
(Outbound) works with only one tenant at a time.

Genesys Administrator supports the Environment tenant, which can be used by administrators of
multi-tenant sites or by a user with permission that is granted by an administrator. When multiple
tenants are set up, an administrator can select any tenant, including the Environment tenant, from
the Select Tenant dialog box. The Select Tenant dialog box displays the tenants that are available to
each user, based on that user's permissions.

The Environment tenant is created during the installation of the Configuration Layer. Although the
Environment tenant is on the same level as all other tenants in the directory, it provides the
administrator of a multi-tenant site with the following:

e A single location for all the configuration objects that are shared by sub-tenants (for example,
Applications, Application Templates, and so on).
* Preset templates in some folders (for example, the Formats folder includes a preset format).

e Privacy through restricted access to all users except the administrator.

The elements of the Environment tenant simplify the process of adding new tenants.

Centralized Configuration and Shared HMP Resources

In release 7.6.101 and higher, Outbound Contact supports a centralized configuration and sharing of
HMP resources in multi-tenant deployment. This functionality can be used for HMP deployment in the
ASM mode and the Transfer mode because of rapid ISCC call routing between SIP Servers.

This functionality includes the ability to:

* Have a centralized configuration of HMP in a multi-tenant environment.
¢ Share HMP resources among multiple Tenants.
e |solate HMP configuration from Tenant access.

e Configure a capacity-based resource allocation. (This configuration involves dedicating one CPD Proxy
Server for each Tenant or any subset of Outbound Campaigns in a Tenant, as described in Managing
Dialing Resources.)

¢ Configure a demand-based resource allocation. (This configuration is based on one CPD Server shared
among all Tenants.)
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Configuration Requirements:

¢ All configuration of HMP must be accomplished under Environment/SIP switch and is not accessible by
Tenants.

¢ The Tenant configuration contains only Outbound/agent-specific configurations.

The following figure provides a sample architecture of this configuration environment.
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The preceding figure does not show component
connections. Be aware that CPD Proxy Server,
Note: which is used by the Tenant and connects OCS with
CPD Server, is configured under Environment. The
Tenant is not able to change its configuration.

Managing Dialing Resources

To restrict the number of dialing resources available for each Tenant or for any subset of Outbound
Campaigns in a Tenant:

¢ Configure CPD Proxy Server that controls the usage of dialing resources:
* One for each Tenant that is used by all Campaign Groups for that Tenant, or

* Multiple CPD Proxy Servers, one for each subset of Outbound Campaigns for the Tenant. For
example, CPD Proxy Server 1 may have a maximum of 30 channels to handle Campaign A and B.
CPD Proxy Server 2 might have a maximum of 50 channels to handle Campaigns C, D, and E.

e For each CPD Proxy Server, configure the max-dialing-channels option and the max-engaging-channels
option, which set the maximum number of dialing and engaging channels for that CPD Proxy Server.

When OCS starts a dialing session for a Campaign Group, it requests and receives the maximum
number available for these respective channels from CPD Proxy Server, as configured in these
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options.

The following figure illustrates how restricted dialing resources might be configured for two or more
Tenants.
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Dialing Resources for Tenant Campaigns

Dialing and Distribution of Engaging Calls

When OCS is running a dialing session associated with a campaign for a particular Tenant, it sends
requests to make transfer calls (for HMP Transfer mode) or make engaging calls (for HMP ASM mode)
to the Route Point under Environment SIP switch, instead of the Voice Transfer Destination (VTD) on
the Tenant SIP switch that is associated with a specific Campaign Group. A routing strategy (loaded
on the Route Point)/URS routes these calls to the VTD under the Tenant SIP switch.

This two step process is required because CPD Server cannot manage calls across multiple switches.
By using this method, CPD Server works with the Environment/SIP switch only and OCS works with
the premise SIP Servers only.

For additional information about configuring SIP
Server to make transfers to external DNs, see the
"Multi-Site Support" chapter in the Framework SIP
Server Deployment Guide.

Note:

To accomplish this:
e For every VTD on the Tenant (premise) SIP switch, configure a corresponding Voice Transfer Destination
on Environment SIP switch.
¢ Configure at least one Trunk Group DN for each Tenant to handle engaging calls.

e Create a routing strategy for each Environment/SIP Switch Route Point to route calls to the associated
Route Point (VTD) on the Tenant switch.

e Configure the vtd-override option to specify the dialing number that OCS sends to CPD Server and that
it will use as the destination number where a transfer call (HMP Transfer mode) or an engaging call
(HMP ASM mode) is delivered.
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Two Tenant Configuration Example

The following figure provides an example of a two Tenant configuration for handling engaging call
distribution in HMP ASM mode.
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Engaging Call Dialing and Distribution Diagram
In this configuration:

e Tenantl includes the following:

e Switchl, SIPServerl, two Campaign Groups (CampaignGroupl and CampaignGroup2), and two
Agent Groups.

e Two route points, as VTD.
* One external route point for the switch used by that Tenant (not shown in the preceding figure).
e Tenant2 includes the following:
e Tenant2 has Switch2, SIP Server2, one Campaign Group (CampaignGroup3), and one agent group.
* One route point as the VTD.
* One external route point (not shown in the preceding figure).
e The Environment SIP switch DNs includes the following:

* Three route points. Two route points are the central VTDs for the two Campaign Groups for Tenantl.
The third route point is the central VTD for the Campaign Group for Tenant2.

e Two Trunk Group DNs for transferring engaging calls to premise SIP Servers.
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Qutbound Contact and HTTP Server

OCS supports communication with OCS clients, such as GVP using HTTP requests and responses. This
enables an HTTP client to send requests to update records over HTTP or HTTPS.

Starting with release 8.1.516.04, OCS supports custom security-related headers sent by the OCS
HTTP Server in HTTP responses. The Application-level option http-custom-headers allows you to

specify custom headers sent in OCS HTTP Server responses. The following HTTP headers are
supported:

e X-Frame-Options: SAMEORIGIN

e X-XSS-Protection: 1; mode=Dblock

¢ X-Content-Type-Options: nosniff

e Content-Security-Policy: script-src 'self'; object-src 'self'

e Strict-Transport-Security: max-age=31536000; includeSubDomains

Configuring HTTP/HTTPS

To configure HTTP support, see the procedure Configuring OCS for HTTP.
Support for HTTPS

OCS supports communication over HTTPS, or strictly speaking, HTTP over Transport Layer Security
(TLS) connection, using a Genesys TLS implementation.

For a detailed description of a Genesys TLS implementation, see the Protection of Data in Transit in
the Genesys Security Deployment Guide.

For the installation procedure of Genesys Security Pack on UNIX, see the Installing Genesys Security

Pack in the Genesys Security Deployment Guide. On Windows platforms, support for SSL/TLS is
integrated into the operating system.

How Outbound Contact Uses HTTP/HTTPS

The HTTP server-side interface in OCS, HTTP Proxy, is a gateway between HTTP version 1.1 and
outbound protocols (the Desktop protocol and the Third Party protocol).

At its startup, when OCS determines that an HTTP port is configured, it automatically starts HTTP
Proxy. As the end user, you do not need to start this child process manually.

In OCS, this HTTP Proxy translates:

e HTTP requests into OCS proprietary protocols.

e OCS proprietary protocols responses into HTTP responses.

HTTP Proxy supports UTF-8 encoding. OCS sends the value of the encoding option value to HTTP
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Proxy, which can transcode (or convert) the JSON body of HTTP requests or responses (such as
AddRecord and PreviewRecord events, or pre-dial validation requests) according to the value
specified. If no value is specified, no conversion takes place.

At OCS startup, OCS starts HTTP Proxy, and HTTP Proxy opens the associated port that is configured
in the OCS application object. If HTTP Proxy cannot open the port, it shuts down. If HTTP Proxy
terminates unexpectedly, OCS tries to restart it after the Reconnect Timeout expires. This
Reconnection Timeout is specified on the OCS Configuration tab/Server Info section (in Genesys
Administrator).

Previously, HTTP Proxy did not have its own log and passed log messages to OCS, which logged them
into the OCS log file. Starting with version 8.1.504.14, OCS writes all HTTP Proxy-related activity

traces to a separate HTTP Proxy log. This log file is stored in the same location as the OCS log, but
has the suffix HTTPPRX added to the filename.

Be aware that using NMAP or similar port scanners

plote can cause OCS to close HTTP ports.

Configuring OCS for HTTP
Purpose

e To configure the OCS application object to communicate with clients using HTTP requests/responses.
Start

1. In Genesys Administrator, go to Provisioning > Environment > Applications and double-click your OCS
application object.

2. Configure a separate listener port on the Configuration tab/Server Info section with the Connection
Protocol set to http.

End
Configuration Changes

Dynamic changes to this port are not supported. As a result, any such changes are not
communicated to an HTTP Proxy that is already running. However, any HTTP Proxy started that is
after that port change will reflect the change.

HTTP terminates if the HTTP listener port is removed from the OCS Configuration tab/Server Info
section or if the connection is lost between OCS and HTTP Proxy.

Primary and Backup OCS and HTTP Proxy
If you have configured primary and backup OCS applications, the primary instance starts an

associated HTTP Proxy and opens a listening port. The backup OCS only starts HTTP Proxy and opens
a listening port when it is switched into primary mode.
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Other Supporting Solutions

This topic describes other Genesys applications that enable and support Outbound Contact. They
include the following solutions:

¢ Framework 8.x
¢ Genesys eServices (formerly, Multimedia)
* Genesys Voice Platform

* Reporting

Framework 8.x

Outbound Contact 8.x is built on Framework 8.x, which includes DB Server, Configuration Server, the
Management Layer, T-Server, and Stat Server.

DB Server

Outbound Contact relies on the DB Server for access to data in the Calling List database tables, any
Do Not Call list, and any other additional lists that are stored in the database.

The DB Server is limited to a maximum of 1024 connections for each OCS instance. As
Outbound Contact opens a new DB Server connection for every Campaign +
Campaign Group + Calling List combination (for example, if three campaigns are
loaded that share a single calling list, this opens three DB Server connections; if one
campaign is loaded, and it is associated with six calling lists, then six connections are
opened), Genesys recommends that you distribute these so that no single OCS
instance requires more than 1024 DB Server connections.

Configuration Server

Outbound Contact is configured through the Configuration Layer of Framework. More specifically, you
use Genesys Administrator to configure the components (applications and configuration objects) that
enable Outbound Contact. OCS reads the configurations from the Configuration Server in order to
perform its operations. Outbound Contact supports dynamic reconfiguration—that is, you can make
changes to Outbound objects (such as Calling List, Table Access, and Campaign objects) in Genesys
Administrator or Outbound Contact Wizard without stopping and restarting Outbound Contact.
Messages that notify the user of changes are displayed in Genesys Administrator. For information
about configuring Outbound objects, see Manually Define Outbound Configuration Objects/Table
Access Object.
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Management Layer

The Management Layer of Framework includes Local Control Agent (LCA), Message Server, Log
Database, Solution Control Server (SCS), and Solution Control Interface (SCI). LCA is used to start and
stop applications. Message Server provides centralized processing and storage of every application's
maintenance events. Log Database stores events as log records, so that they are available for further
centralized processing. SCS is the central processing center of the Management Layer. SCI displays
the status of all installed Genesys solutions and provides information about each active alarm
condition.

Genesys Administrator can be used instead of SCI.

T-Server

T-Server is the key element of Genesys computer-telephony integration (CTI) because it handles call
traffic. Each T-Server is linked to a switch, which it monitors. T-Server is also a "messenger" that
enables communication among Outbound Contact components. For details, see the "Communications
Protocol" chapter in the Outbound Contact Reference Manual.

Network T-Server

Outbound Contact supports Network T-Servers in deployments that do not include CPD Server. To
enable this functionality in Predictive dialing mode:

e The Service Number DN type, in addition to any applicable DNs of type ACD Queue and Route Point in
Genesys Administrator must be identified on the appropriate place group or agent group.

e The Campaign object must specify the same Service Number DN as the Voice Transfer Destination
within the place group or agent group that is specified on the Group tab.

Outbound Contact Server does not support the load-balancing capabilities of the
Network T-Server. Outbound Contact Server should not be configured to connect to
multiple Network T-Servers that are associated with the same switch.

Stat Server

Stat Server provides the data source for the CCPulse+ application. It also provides agent-state
information to Outbound Contact Server so that it can dial effectively.
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Optional Solution Integration

In addition to the Framework components, Outbound can work with the following Genesys solutions:

* Genesys eServices (formerly, Multimedia)
* Genesys Voice Platform

e Reporting

Genesys eServices (formerly, Multimedia)

Outbound Contact Calling List and Campaign management are now integrated with the Customer
Information Management (CIM) platform. This feature extends the Outbound Contact Calling List and
Campaign management to multimedia channels, and it improves agent efficiency by pushing preview
records to agents without waiting for an agent request. Therefore, it enables the prioritization of
outbound interactions with other interaction types for blending purposes. This dialing method can
also be referred to as "proactive routing" or "push preview". The following figure illustrates how
Outbound Contact integrates with the CIM platform.
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The basic process for completing a proactive interaction is as follows:

* OCS submits a preview interaction request to Interaction Server.

e Interaction Server requests that Universal Routing Server execute a strategy to determine which agent
to send the interaction to based on skill abilities. The agent must be logged in to Interaction Server and
can still process other interactions during this process. The communication between the agent desktop
and OCS is through Interaction Server in this scenario.

* The agent processes the preview record appropriately, transfers the call to another agent, or places the
call back into the queue.

e Special strategy blocks enable the routing strategy to process the preview call interaction automatically
without agent involvement.

e Refer to the Universal Routing documentation

Notes: for more information about configuring
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strategies for proactive interaction routing.

* Refer to Campaign Group Object for more
information about configuring a Campaign
Group object for proactive routing (or push
preview) campaign.

ESP Port

In the Push Preview dialing mode, Interaction Server must be specified in the Connections tab of the
CampaignGroup object to establish a client-server relationship between OCS (as the client) and
Interaction Server (as the server). However in order for OCS to process requests and responses from
Interaction Server, OCS must be a server for Interaction Server and receive these responses on a
special ESP-type port rather than its default listening port.

Create this additional port PortID—called ESP—on the Server Info tab of the OCS Application object.
Use this ESP PortID instead of the default PortlD, when you are configuring a connection to the OCS
Application object on the Connections tab of the Interaction Server Application object. In effect, this
makes OCS a server for Interaction Server and Interaction Server a client for OCS.

This ESP PortID will be available as a connection in
Note: the Interaction Server Application object only after
you configure PortID in the OCS Application object.

Interaction Media Type

Interactions that are submitted to Interaction Server must contain a certain media type. By default,
OCS creates interactions with the outboundpreview media type. However, OCS can assign other
media types to interactions from particular calling list or to interactions that were created for the
entire campaign. Refer to the interaction-media-type option on for more information.

* Refer to the direct-personal-callback option
when you are configuring this solution.

Notes: » Refer to the "Proactive Interaction Support"
section in the Outbound Contact Reference
Manual for more information about Proactive
Interactions with Outbound Contact.

Genesys Voice Platform

Outbound Contact can integrate with Genesys Voice Platform (GVP) in order to run campaigns in the
Power GVP or the Progressive GVP dialing mode.

Proactive Contact with GVP 7.6 Deployment

In a T-Server deployment that is running in the Power GVP dialing mode, OCS uses the Outbound
Notification Manager (OBN) application as a connector to GVP to request that GVP dial records. The
OBN Manager GVP application should be created in Genesys Administrator to provide its host and
port information to OCS. This application must be specified on the Configuration tab/Connections
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section of the Campaign Group configuration object (in Genesys Administrator) to enable GVP
integration. This configuration will enable basic connection capabilities.

If full connection abilities—including Advanced Disconnect Detection Protocol (ADDP) is required —
this application also should be present on the Configuration tab/Connections section of the OCS
application, where the ADDP connection protocol can be specified.

For more information about how to configure the
Note: Campaign Group configuration object for the Power
GVP dialing mode, see Campaign Group Object.

When configured to enable connections, OBN opens a predefined port (for listening purposes) and
then accepts requests from OCS in a client-server fashion.

Dialing Algorithm

In a GVP-assisted campaign, dialed outbound calls are dialed from GVP ports, and they can be
completely processed and released by GVP. GVP issues information about call processing (such as call
results and modified user data) to OBN Manager, which relays this information to OCS. OCS processes
this information accordingly, applies any necessary treatments, and updates the records.

Do Not Call Records

OCS issues an EventOBNRecordStopProc message to OBN when it receives a DoNotCall request and
determines that records are currently being processed by OBN. OBN immediately attempts to stop
processing the specified record.

Calculating the Number of Records

The procedure that OCS uses to calculate the number of records (or chains) to retrieve from the
database when a dialing session for a Campaign group is loaded, is similar for both Push Preview and
Power GVP modes, but differs from traditional Predictive, Progressive, or Preview modes.

For the Power GVP dialing mode, when a dialing session is loaded for a Campaign Group object
configured to use this dialing mode, OCS calculates the number of records for retrieval from the
database as a percentage (specified in the Optimal Record Buffer Size dialog box) of the
MaxQueueSize parameter for this Campaign Group. If more than one Calling List is used in the
Campaign, the number of records retrieved from each Calling List is determined by the specified list
weight.

OCS then submits the records to OBN Manager using the following criteria:

e The total number of dialing requests that are submitted is equal to the MaxQueueSize value for the
Campaign Group.

¢ OCS retrieves records from the Calling List table in the database to replenish its buffer when the
number of Calling List records in the OCS buffer is less than the number calculated as the percentage
(specified in the Minimum Record Buffer Size dialog box) of the MaxQueueSize value for this Campaign
Group.
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» Refer to the dialer-ttl and dialer-num-attempts
options when you are configuring this solution.

Notes: e Refer to the GVP 7.6 documentation for more

information about using Outbound Contact with
the OBN application.

GVP 8.1 VoIP/SIP Server Deployment

For an description of this deployment, see Overview of the GVP VoIP/SIP Server Deployment.

Reporting

The Genesys Reporting solution contains tools for collecting historical and real time data, and for
viewing and analyzing contact center performance. In Outbound Contact, the calculation of some
real-time metrics is provided by the OCC Extension. All data that is required for the OCC Extension is
directly submitted by OCS through the OCS DataStream protocol. For more information about the
Genesys Reporting solution and the templates provided with Outbound Contact, see the Reporting
Technical Reference Guide for the Genesys 7.2 Release.
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Outbound-VoIP Deployment

These topics explain the configuration when you use Outbound Contact in a VolIP environment:

* Overview of the GVP VolIP/SIP Server Deployment
» Dialing Modes and VolP Deployment

¢ VolP Dialing Modes

e Qutbound-VolIP in ASM Dialing Modes

* Outbound-VolP in Transfer Modes

¢ Assured Connection

Outbound-VolP deployment is not supported in a
multi-tenant environment when it is used with GVP

Note: 8.1.1. To support Outbound-VolP deployment in a
multi-tenant environment, GVP 8.1.2 or higher
must be used.
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Overview of the GVP VolP/SIP Server
Deployment

Outbound Contact supports a VoIP deployment that enables automated outbound dialing when using
SIP Server 8.0 and GVP 8.1 (Media Server).

In this environment, Outbound Contact and Universal Routing components function on top of SIP
Server, Media Server, and a SIP Media Gateway.

The VolP Environment/Outbound Contact Architecture figure illustrates the architecture.
Instead of requiring new dialing modes for a VoIP deployment, Outbound Contact uses the existing
dialing modes and runs these as VolP modes when Outbound Contact is configured as VolP-ready (see
the procedure Configuring Outbound Contact and SIP Server for a VolP Deployment).

GVP 8.0 uses SIP Server and MCP/Media Server(s) call processing in a VolP environment. It can
perform call-progress detection on outbound calls and can process those calls that are connected to
customers, based on the logic that is built into VoiceXML scripts. These scripts allow GVP to
manipulate user data and perform call control; for example, the call can be completed or transferred
to the live agent for further processing. GVP 8.0 can also communicate with OCS by using HTTP or
HTTPS (see Outbound Contact and HTTP Server), which enables automated outbound record
processing.

Dialing Algorithm

This deployment supports two dialing modes: Power GVP and Progressive GVP. In this environment,
calls originate on the Trunk Group DN and are communicated to the GVP platform after the
established CPD is completed using the ApplyTreatment T-Library API.

Calculating the Number of Records

e For the Power GVP (VolIP) dialing mode, the number of records is calculated the same way they are
calculated when using the Power GVP dialing mode with GVP 7.6.

e For the Progressive GVP dialing mode: When a dialing session is loaded for a Campaign Group object
configured to use this dialing mode, OCS calculates the number of records for retrieval from the
database as a percentage (specified in the Optimal Record Buffer Size dialog box) of the total number
of channels that are available for this Campaign Group. If more than one Calling List is used in the
Campaign, the number of records retrieved from each Calling List is determined by the specified list
weight.

OCS then submits outbound call requests to SIP Server based on the total number of channels that
are available, while trying to keep as many calls in progress as there are available channels.

OCS retrieves records from the Calling List table in the database to replenish its buffer when the
number of records in the OCS buffer is less than the number calculated as a percentage (specified in
Minimum Record Buffer Size dialog box) of the total number of channels that are available for this
Campaign Group.
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In a VolP-ready deployment, OCS is responsible for initiation of outbound and engage calls dialing and
partial control of call distribution.

For more information on dialing modes functioning
in a VoIP environment, see VoIP Dialing Modes.
Note: If the Campaign Group object is not configured with a Trunk

Group DN, the dialing modes function as they would in a non-
VoIP environment.

The Genesys components/applications function as shown in the following figure.

Cuthound Inbound /
Contact Liniversal Routing
TLib TLib
SIP Server
SIF IP
Media Gateway . T GVP
.- — —— — — — — RTP-— -

VoIP Environment/Outbound Contact Architecture

¢ Qutbound Contact components handle the following:
e Outbound call pacing
¢ QOutbound call initiation toward the customer (Transfer, ASM, and Proactive Contact modes)
* Engaging call initiation toward agents (ASM mode)

e Outbound call distribution toward agents (Transfer and ASM modes) and toward the voice platform
(Power GVP and Progressive GVP modes)

¢ The Universal Routing components handle routing outbound and engaging calls to the agent.

e SIP Server controls all SIP signaling for initiated calls and also acts as an interface between solution
components.

* GVP Media Server handles the following:
* Playing the basic announcement (ASM Mode)
e Call recording
e Call-progress detection
e Media bridging (ASM mode)
* Playing voice applications (Power GVP and Progressive GVP dialing modes)
In addition to Media Server, the GVP components also include Resource Manager, Fetching Module,

and Squid and Reporting Server. For more information on the GVP components, see the Genesys
Voice Platform 8.1 Deployment Guide.

Note: GVP Resource Manager manages Media Server
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resources. If two or more Media Servers are

configured to serve a Trunk Group, Resource
Manager distributes the engaging calls and

customer calls among them.

Supported Deployments

Outbound supports several types of VoIP deployments for agent connectivity including:

e |P agents located on the same SIP Server.
e |P agents who are on multiple SIP Servers.

e Both IP agents on SIP Server and TDM agents who are located on T-Server.

Resources

The resources available for each dialing session/outbound campaign are determined by the Trunk
Group DN that is specified in the Advanced tab of the Campaign Group object (see Campaign Group
Object).

For GVP 8.1.1, the Trunk Group DN must be named
Note: Environment working in any tenant; in GVP 8.1.2
there is no restriction for Trunk Group DN name.

On behalf of the Trunk Group DN, SIP Server provides OCS with media-resources usage (total ports
and available ports). OCS initially receives this information in EventRegistered when it registers this
DN with SIP Server. Once OCS registers Trunk Group DNs, SIP Server automatically provides updated
resource/port information for Trunk Group DNs, which OCS uses to run dialing sessions/campaigns. In
addition to this information, a dialing session limits the number of ports it can use to the number
specified in the Number of Channels parameter in the Campaign Group object (Configuration tab/
Advanced section).
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Dialing Modes and VolP Deployment

Dialing Modes and VoIP Deployment

An Outbound-VoIP environment supports all auto-dialing modes.

The following table provides a comparison of the modes in both a traditional and an IP environment.

Dialing Mode

Predictive

Predictive GVP
Progressive

Predictive with seizing

Progressive with seizing
Power GVP

Progressive GVP

Configuration

Dialing Mode Comparison
Traditional

Predictive

Predictive

Progressive

Predictive ASM using CPD Server
Progressive ASM using CPD
Server

Power GVP using OBN

Not applicable

Outbound-VolP - Ready

IP-predictive
IP-predictive
IP-progressive
IP-ASM (predictive)

IP-ASM (progressive)

IP-VoiceXML (based on the calls
per second setting)

IP-VoiceXML (based on port
availability)

Configuring Outbound Contact and SIP Server for a VolP Deployment

Purpose

» To configure Outbound Contact and SIP Server so that a Campaign Group is VolP-Ready.

Start

1. Configure a Trunk Group DN on the SIP Server switch object. For more information, see Framework

Genesys Administrator Help.

2. Configure a Campaign Group object with the Trunk Group DN. For more information, see Campaign

Group Object.

w

. Configure a SIP Server application object that controls the Trunk Group DN.

4. In the OCS application object, add this SIP Server on the Configuration tab/Connections section.

End
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VolIP Dialing Modes

Outbound Contact supports the following VoIP dialing modes: Predictive, Progressive, Predictive with
seizing, Progressive with seizing, Power GVP, Predictive GVP, and Progressive GVP. In these VolP
dialing modes, the call control/flow is as follows:

e The call is dialed from the Trunk Group DN.

e OCS controls the call.

¢ In Transfer modes, OCS transfers the call to VTD.

¢ In ASM modes, OCS bridges the call with engaging call.

In GVP modes, OCS also controls the Treatment VoiceXML application.

If a Campaign Group is not Outbound-VolP-ready,
these dialing modes function like the non-VolP
dialing modes (with the exception of the
Progressive GVP mode which is not available in

non-VolP dialing modes).

Note:
For information on how OCS works with VoiceXML applications in
these modes, see VoiceXML Applications. For information on
how OCS handles Apply to Call treatments in these modes, see
Apply to Call Treatments. For more information on Outbound in a
VoIP environment, see OutboundVolPDeployment.

Progressive, Predictive, Predictive GVP, Progressive with Seizing, and Predictive with Seizing
Dialing Modes

When a Campaign Group/environment is Outbound-VolP-ready (see VolP Environment Configuration),
these modes function like their standard, non-VoIP counterparts, but in a VoIP environment with its
associated components. See their associated descriptions.

Power GVP Dialing Mode

The Power GVP dialing mode uses SIP Server to dial outbound calls, to detect call results, and to
further process successfully connected calls. This Power GVP mode dials calls so that the number of
calls in progress equals the Max Queue Size setting of the Campaign Group. Like the non-VolP usage,
this dialing mode can be very effective when running "agent-less" campaigns, because it enables you
to use custom-created VoiceXML scripts to automate call processing and allow for self-service of the
contacted outbound customers. See Genesys Voice Platform for more information.

Progressive GVP Dialing Mode

The Progressive GVP dialing mode dials calls from a Calling List when a GVP port is available. The
dialing pace is calculated based on port availability; so this mode dials calls equal to the number of
Call Progress Detection ports configured for the Campaign Group. This dialing mode requires SIP
Server for placing outbound calls, instead of T-Server, and uses GVP Voice XML applications for call
processing.
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In this dialing mode, the predictive algorithm does
not calculate the dialing rate based on agent
availability. Instead, it calculates the number of dial
requests to maintain the total number of customer
calls in any state (for example, dialing or
established) that is not greater than the number of
ports available for the Campaign Group, in
accordance with Resources assignment (see
Resources).

Note:

Warning: OCS considers a port available when it is notified as
such by SIP Server.

VoiceXML Applications

When running Outbound Contact using the VolIP dialing modes, OCS identifies which VoiceXML
application that GVP should start by including the URI of that application in the TApplyTreatment
function.

e (All call results) OCS determines the URI based on the value set in the initial-page-url option of the Voice
Platform Profile configuration object and whose DBID is specified in the IVR Profile ID attribute for the
Campaign Group.

* (Answering Machine call results only) If you want to use a dedicated VoiceXML application for Answering
Machine call results, OCS determines the URI based on the value set in the am-initial-url option of the
Voice Platform Profile configuration object and which is associated with the Campaign Group. If a URI is
not specified in the am-initial-url option, OCS uses the URI set by the initial-page-url option.

The URI Answering Machine VoiceXML application is
Note: never passed in ivr-profile-id pair to SIP Server,
which means that it cannot be prefetched by GVP.

In addition, for Answering Machine Detection call results, OCS can instruct GVP on how to handle
beep detection. The am-beep-detection option specifies whether GVP is forced to detect an
answering machine beep before starting the VoiceXML application. This information is passed on to
GVP in the Extensions KV list of the same TApplyTreament function.

For information on the initial-page-url and am-
initial-url options, see the Genesys Voice Platform

Note: 8.1 User's Guide.

For information on the IVR Profile ID attribute for the Campaign
Group, see IVR Profile.

Apply to Call Treatments

In a VoIP environment, after an outbound call is established on the Trunk Group DN, OCS can apply
Transfer/Connect or Drop treatments to the call. These treatments—which you configure by using the
Treatment configuration object with an Apply to Call action—always have a higher priority than
VoiceXML application call handling.

This approach is helpful in the following scenarios:

e A Connect treatment is configured for an Answering Machine call result. A Destination DN is also
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configured. OCS receives EventEstablished with an AM call state. Despite the configured IVR Profile ID,
OCS issues RequestSingleStepTransfer to the Destination DN and completes call/record processing.

* A Drop treatment is configured for an Answering Machine call result. OCS receives EventEstablished
with an AM call state. Despite the configured IVR Profile ID, OCS issues RequestReleaseCall and
completes call/record processing.

Apply to Call treatments offer an alternative mechanism for call handling. Although it is possible to
perform the same call processing in the VoiceXML application (transfer or drop), treatments can be
used to improve performance, so that GVP does not need to fetch (or retrieve), parse and execute the
VoiceXML application in these basic scenarios.

Outbound Call Transfer by Treatment Application after Processing by the VoiceXML Script

OCS can now apply a treatment of type Transfer or Connect as a step of processing of an outbound
call when running in VoIP environment in Power GVP, Progressive GVP, or Predictive GVP dialing
modes, if requested by the VoiceXML script. Whenever the processing of a successful outbound call is
completed by a VoiceXML application, and further processing of this call is still required, the call can
be transferred by OCS to a pre-configured arbitrary destination DN. For example, an outbound call
can be transferred to an ACD queue for delivery to a live agent for assisted service after the call has
been self-serviced by VoiceXML script execution.

In the Predictive GVP dialing mode, to deliver a call to the Voice Transfer Destination that is
configured for the Campaign Group, the VoiceXML application can also send to OCS a
ContinueProcessing request without the GSW_TREATMENT attribute instead of a RecordProcessed
request with the GSW_TREATMENT attribute.

The advantage of this feature is that the transfer is handled by OCS after receiving a specific
message from the VoiceXML application. There is no need to implement the transfer by means of the
VoiceXML application itself or by any other system component.

Provisioning

Enabling this functionality requires that the Calling List reference the Treatment configuration object.

This object should have the Apply to Call action set to Transfer or Connect, a destination DN specified
(for example, ACD queue), and the Number in sequence property set to 1. The Apply to Record action
of the Treatment configuration object can be set to either No Treatment or Update all records in chain.

A treatment of type Transfer or Connect can be
configured for certain call results only. It is
supported for Answer, Answering Machine, Pager,
Fax, and OK call results. Genesys recommends that
you configure it to the Answer call result, since

MBI other call results might affect how OCS makes
outbound call on the first stage of call processing
(when requesting SIP Server to make an outbound
call and when processing EventEstablished on the
Trunk Group DN for a successful call results).
Processing

The following is an example of a RecordProcessed request which will be delivered to OCS by the
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VoiceXML application so that OCS can attempt a Transfer treatment application:

POST http://hostl.domainl:8080/records/15?req=RecordProcessed HTTP/1.1
Host: hostl.domainl:8080

User-Agent: GVP/8.0 Banking self-service #4

Content-type: application/json

Content-length: 116

{

"GSW CALL RESULT":33,

"GSW TREATMENT":"RecordTreatCampaign",
"CUSTOMER CODE": 22,
"DATE LAST SERVED": "10/30/2008"

}

If the VoiceXML application delivers the RecordProcessed notification to OCS by using HTTP with the
GSW_TREATMENT attribute that is specified and the treatment is configured as described in the
example above, OCS uses a single step transfer to deliver the call to the destination DN that is
specified in the Treatment configuration object.

The Apply to Record property of the treatment controls how OCS treats the chain of records after the
transfer. If this property is set to Update all records in chain, OCS finalizes the chain of records in the
Calling List and the transferred call processing can no longer affect the chain. If the Apply to Record
property is set to No Treatment, OCS does not finalize the chain and awaits further updates for this
chain through HTTP from the VoiceXML application or through Desktop protocol from the agents
desktop.

If the chain of records is not finalized by this
treatment and the call is passed to an agent for the
further processing, OCS only processes the

Note: Desktop protocol requests from the agent if this
agent belongs to a Group that is associated with
the current Campaign Group and is properly logged
in.
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Outbound-VolP in ASM Dialing Modes

In VoIP environments, when Campaigns are running in ASM modes, agents are engaged by the RTP
stream from Media Server. Media Server bridges the engaging and outbound calls, connecting the
two RTP streams.

Campaign Group Configuration

In the Outbound-VolP ASM modes, configure a Campaign Group object the same way that you would
for the standard Predictive with seizing or Progressive with seizing dialing modes, but with the
addition of the Trunk Group DN configuration. For more information, see Campaign Group
Configuration.

If the Trunk Group DN is not configured in the
Campaign Group object, OCS processes that
Campaign Group by dialing on behalf of the Voice
Transfer Destination (VTD), as it did in 7.x releases.

Note:

Engaging Calls

In a VoIP environment, OCS requests that an engaging call be dialed. OCS sends this request to SIP
Server (using T-Library) for it to make a call from the Trunk Group DN to VTD. Similarly to the
standard ASM mode, the engaging call is then delivered from VTD to the agent's DN.

For engaging calls, the TMakeCall request includes
Note: the Trunk Group DN and the Voice Transfer
Destination DN.

The following options affect how the engaging call is dialed:
¢ beep-on-merge--Controls whether a beep is played to the agent immediately before the agent is

bridged to the customer call.

e call_wait agent connected_timeout--Specifies the timeout, in seconds, between when the engaging call
is dialed and when the agent answers the call.

For a successful engaging call (that is, one that is established with an agent), when SIP Server sends
EventEstablished to OCS, it includes the Media Server ID (GSW_MEDIA_SRV_ID) as a user data
attribute. This enables OCS to bridge only engaging and customer calls that reside on the same
Media Server.

For an unsuccessful engaging call (that is, one that is not established with an agent), note the
following:

e If an engaging-call request cannot be made, SIP Server issues an EventError on the Trunk Group DN
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identifying the reason for the failure. Error codes include 50 (Unknown error), 53 (Invalid attribute), and
415 (Invalid destination).

In a VoIP environment, the most likely cause of the failure is the unavailability of resources required
to make the call (for example, a lack of available ports on Media Server or the Media Gateway).

e If an engaging-call request is successfully placed but the engaging call is released because the agent is
busy, SIP Server issues EventDestinatationBusy and EventReleased on the Trunk Group DN.

¢ If the engaging-call request is successfully placed but the agent does not answer within the timeout
specified by the call_wait_agent_connected_timeout option, OCS releases the call.

Note: No announcements are supported for engaging
' calls.

Customer Calls

For customer calls, OCS uses the TMakePredictiveCall request to initiate customer calls. This request
includes the Trunk Group DN and the Voice Transfer Destination DN.

Call Progress Analysis

Call progress analysis (CPA) occurs based on the setting of the call answer_type _recognition option,
which specifies what has to be detected on the pre-connect (SIT tones) and post-connect (for either a
fax or an answering machine) phases of the call, as well as answering machine detection sensitivity.

If a record is configured with a

call_answer_type recognition value (see Per-Record

Basis) that is not supported by SIP Server (for
Note: example, ISDN messages that are based on

answering-machine detection only), or if the record

does not specify a value, OCS applies instead the

no_am_detection value.

The following options affect CPA for VolIP dialing modes:

e cpd-recording, which allows you to specify whether the call progress detection phase of the call should
be recorded.

e call _timeguard _timeout option, which specifies the maximum time that is allowed for CPA after the call
is connected.

e cpd-on-connect option. which specifies that CPA begins after the call is connected. Set this option to
false or no.

e Setting this cpd-on-connect option to false or no
enables the use of Color Ring Back Tones. If
Notes: cpd-on-connect is not configured or its value is
set to false or no, CPA starts as soon as the
media stream is available.
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e A Color Ring Back Tone (CRBT) refers to the
ability to play other audio sounds (music, voice,
and so on) instead of a standard ring tone while
a call is connecting.

OCS receives the results of CPA (performed by the Media Gateway or the GVP Media Server) in the
CallState attribute of EventEstablished (the call has been connected), EventDestinationBusy (the call
has been rejected) or EventReleased (call was not answered or it was released by SIP Server) and
assigns a call result.

When CPD Proxy is used in front of multiple CPD
Note: Servers, there is a probability of abandoned calls in
both Progressive ASM and Predictive ASM modes.

For information on attributes that are specific to VolP environment, see the Outbound Contact
Reference Manual.

Successful Call Flows

For a successful customer call, SIP Server passes the Media Server identifier to OCS.

Unsuccessful Call Flows

For an unsuccessful customer call, note the following:

e If a customer call (RequestMakePredictiveCall) cannot be placed, SIP Server issues an EventError on the
Trunk Group DN, providing the reason for the failure in the ErrorCode and the ErrorMessage attributes.
Error codes include 50 (Unknown error), 53 (Invalid attribute), and 415 (Invalid destination).

In a VoIP environment, the most likely cause for the failure is the unavailability of resources required
to make a call (for example, a lack of available ports on Media Server or the Media Gateway).

e If the call is initiated but is released because of a negative call-progress result (usually due to the
detection of a SIT tone or a busy response), SIP Server issues EventDestinationBusy and EventReleased
on the Trunk Group DN with the associated CallState attribute.

e |If the call is initiated successfully, but the call is released because it was not answered or is answered
by a fax or answering machine, according to the SIP Server configuration, SIP Server issues
EventReleased on the Trunk Group DN with the associated CallState attribute.

Merging Engaging and Customer Calls

For all dialing sessions, OCS maintains information about the distribution of engaging and customer
calls among Media Servers. There are two methods — bridging and transfer — for merging an
engaging call with a customer call when these calls might be on different Media Servers.

You specify the merge method (bridging or transfer) using the merge-method option at the Campaign
Group Level or the OCS Application Level.
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In a multi-site environment, to maintain the correct
Events and ensure user data propagation when
merging these calls, configure the SIP Server use-
data-from option with a value of current. For
more information about this option, see the
Framework SIP Server Deployment Guide.

Note:

Call Supervision functionality for engaging calls in ASM dialing modes in VolP
environments is not supported. If OCS receives an EventEstablished on the
supervisor's DN after receiving EventEstablished on the agent's DN, the engaging
call leg will not be merged with an outbound call.

Bridging Method

OCS controls when and how to bridge the engaging and customer calls. As the default method, when
a customer call is connected and call-progress analysis is completed, OCS attempts to find an
established engaging call on the same Media Server as the customer call and responds as follows:

* If OCS finds an established engaging call, it bridges the two calls.

e If OCS does not find an established engaging call (for example, in the Predictive mode) on the same
Media Server, OCS releases the customer call, with the option to play a configured announcement
before releasing it, as configured in either the asm_drop_announcement _data option or the
asm_drop_am_announcement_data option.

Tip
While the asm_drop_announcement_data option allows you to play the same announcement for all call

results, the asm_drop_am_announcement_data option allows you to play a different announcement for
Answering Machine call results than the one used for Answer call results.

For SIP Server, if the asm_drop_announcement_data option and/or the
asm_drop_am_announcement_data is configured, OCS releases the call only after the announcement is
played, which occurs after OCS receives EventTreatmentEnd from SIP Server.

You can configure OCS to handle a scenario in which it cannot find an established engaging call on
the same Media Server by setting the value of the on-bridging-unable option to transfer. By doing
so, OCS connects the customer call to the first found established engaging call, regardless of the
Media Server on which the engaging call is established. You configure this option at the Campaign
Group Level OCS Application Level.

Tip
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If the value of the merge-method option is set to bridging, then the on-bridging-unable option is taken into
account in scenarios where bridging is not possible; if the value of the on-bridging-unable option is set to
transfer, then OCS attempts to use the Transfer method; if the value is set to drop, then the call is
dropped.

Tip
When the bridging method is used, no SIP messaging is provided to OCS if the agent's SIP endpoint fails and
the calls are not merged. As a result, OCS is unable to identify the call with a Transfer error.

Transfer Method

For the transfer method, OCS merges each established outbound call with the longest-engaged agent
across all Media Servers, as follows:

e If the first attempt to merge an outbound call with the engaging call is failed, OCS keeps considering
that agent as the longest-waiting agent until the second attempt to merge the next outbound call with
this engaging call.

¢ If the second attempt is failed, OCS sends a request to release the engaging call and stops considering
that agent as the longest-waiting agent.

e If an engaging call is released, that agent becomes the shortest-waiting agent when a new engaging
call is established on the agent DN.

The following figure illustrates the event flow for the merging of the call legs.
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Transferring a Customer Call

If OCS determines that the customer call must be transferred to another destination (for example, a
treatment with a transfer call action), OCS uses a single-step transfer. OCS considers the transfer
complete when the customer call is transferred from the Trunk Group DN to the VTD. Then, OCS
finalizes the chain processing with a call result.

Using the Opt-Out Feature With SIP Server in VolP Environments

The OCS opt-out feature enables the call recipient to opt-out from any further outbound calls in ASM
mode. This feature addresses legislative requirements and enables call recipients to opt-out by
pressing certain buttons on the touch tone phone if there are no agents available to speak to them. A
typical supported scenario is described in the section, Opting Out of Outbound Calls in ASM Mode.

When SIP Server places outbound calls in VoIP environments and there are no available agents to
handle the answered outbound call, the post-connect outbound call processing is handled by Genesys
Voice Platform (GVP). GVP runs VoiceXML applications that can play announcements, collect DTMF (or
speech) input, compare the input that is provided by the call recipient with the pre-configured opt-out
pattern, and deliver the DoNotCall request to OCS by using HTTP or HTTPS. No pre-defined VoiceXML
application exists that can handle all of these tasks. Therefore, you must create your own ad-hoc
VoiceXML application.

OCS activates the VoiceXML application on GVP in this type of ASM mode when it cannot merge an
outbound call with an engaged call, and only if all of the following are true:

¢ The Campaign Group object in the configuration has an IVR Profile configured that defines which
VoiceXML application to activate.
¢ The OCS digits-detection-pattern configuration option is set to a non-empty string.
¢ The OCS digits-detection configured option is set to one of the following values:
e all
* answer and the detected call result is Answer

* am and the detected call result is Answering Machine

When OCS activates a VoiceXML application for the record being called, it makes available to the
VoiceXML application that is specified in the SIP Headers, the values of the following options:

» digits-detection-timeout
» digits-detection-pattern

¢ digits-reaction

This process enables the VoiceXML application to build its own logic to process the opt-out request
and adapt to the configuration changes in OCS. However, OCS must receive only correctly-formed
DoNotCall requests from the VoiceXML application by using HTTP or HTTPS, so that the specific call
recipient's phone number can be marked as DoNotCall. All of the underlying logic, such as playing the
message, receiving, and processing the called-party input (in the form of DTMF and/or speech)
contained in the VoiceXML application.
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For more information about how OCS works with GVP and VoiceXML applications in VoIP Environment,
see VoiceXML Applications. For information about how to create VoiceXML applications, see the
Genesys Voice Platform 8.1 Deployment Guide.

Overdialed calls in Progressive ASM or Predictive ASM modes

If you are running campaigns in Progressive ASM or Predictive ASM mode, OCS can optionally transfer
overdialed calls (outbound calls that cannot be bridged immediately to an established engaging call)
to a Voice Transfer Destination DN (typically a Routing Point) rather than terminate the calls. Those
calls can then be handled by the routing strategy and delivered to queues with available agents or to
IVR ports.

After an overdialed call is transferred by OCS, an agent or IVR application can still finalize the call
within OCS and update the record in a chain.

Tip
The distribution of overdialed calls to queues being monitored by OCS or to any of the

agents working on active campaigns within OCS can have a negative impact on call
pacing. Keep this in mind when planning your overdialed call distribution strategy.

Warning

You must ensure legislative compliance if using this type of transfer. If the router is
unable to locate an available agent, it can take longer than two seconds to transfer
the call to a new queue.

SIP Server and High Availability Limitation

When you are running a dialing session in an ASM mode for an outbound IP campaign and SIP Server
is part of a Network Load Balancing cluster that is operating in hot-standby mode, use the Switchover
command instead of the Stop command in Solution Control Interface (SCI) to switch from the primary
to the backup SIP Server. If you use the Stop command, the primary SIP Server will generate
EventLinkDisconnect and of all its associated clients will re-register all DNs on the backup SIP Server.
If the primary SIP Server had established calls for Outbound VoIP agents and the agents received an
Engaged status, the re-registration process will change the agent status to Busy Unknown or Ready,
depending on whether the agent was engaged before starting the backup SIP Server.

Call Supervision Limitation

Call Supervision functionality for engaging calls in ASM dialing modes in VoIP environments is not
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supported. If OCS receives an EventEstablished on the supervisor's DN after receiving
EventEstablished on the agent's DN, the engaging call leg will not be merged with an outbound
call.
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OQutbound-VolP in Transfer Modes

For Outbound-VolIP functioning in Transfer modes (Predictive or Progressive), the Campaign Group
also needs to be Outbound-VolP-ready (see Dialing Modes and VolP Deployment).

In these dialing modes, OCS dials outbound calls using SIP Server on behalf of the Trunk Group DN
and controls the transfer of successful outbound calls (that is, those calls answered by a person) to
VTD for further delivery to agents.

Customer Calls

In an Outbound-VolP Transfer mode, the dialing and transfer of a customer call are handled in the
same way as Outbound VolP ASM mode for the following:

e Call progress analysis

* Unsuccessful call flow handling (see Unsuccessful Call Flows)

e Call transfers (Transferring a Customer Call)

For transferring to a Voice Transfer Destination DN, see the next section.

Transferring to a Voice Transfer Destination DN

You can use either a single-step or a two-step transfer. Upon a positive call-progress detection, OCS
transfers an outbound call to a Voice Transfer Destination (VTD) DN according to the setting of the
call_transfer_type option. You define the transfer process by setting the option to one_step for a
single-step transfer and to two_step for a two-step transfer.

Single-Step Transfer

A single-step transfer is quicker than a two-step transfer, but it does not give the user control over
how the transfer occurs. When the call_transfer_type option is set to one_step, OCS looks to the
call_wait_in_queue_timeout option, which determines how long the call should wait (in the queue)
before an agent answers. If the timeout expires, OCS aborts the transfer by dropping the call, and the
record is marked with the Dropped call result.

Note: Some switches do not support this type of transfer.
Two-Step Transfer

A two-step transfer is slower than a single-step transfer, but it creates a consult call that allows the
user more control over the transfer (for example, to cancel it). This type of transfer depends on the
following:

e The SIP Server consult-user-data option must be set to inherited. For more information on the SIP Server
consult-user-data option, see the Framework SIP Server Deployment Guide.
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e The OCS call wait in_queue_timeout option must be specified.

e For the consult call, if the timeout expires, OCS
aborts the transfer, tries to reconnect to the call
and releases the call if unsuccessful. OCS also
assigns the Transfer Error call result.

Notes:

e |f the timeout expires while OCS is waiting for
the call to be established at the Trunk Group
DN, OCS aborts the transfer, releases the call,
and assigns the Dropped call result.

OCS applies a treatment to the chain-call result, if the treatment is configured. It does not attempt to
play any voice file for an outbound call before it is released.

Outbound calls that do not reach a destination (for example, an agent DN or an IVR port) are
considered abandoned and reported as overdialed to the predictive algorithm.
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Assured Connection

Assured connection is available in the Predictive
Note: and Progressive dialing modes when dialing with
SIP Server in a VoIP environment.

Sometimes, it may be beneficial to dial an outbound call in an automated dialing mode that is
guaranteed to be connected to an agent. For example, this may be desirable for outbound customers
of high importance, or for calling some numbers as required by government regulations.

Neither the Predictive or Progressive dialing mode can typically guarantee connection of the call to an
agent. In Predictive dialing mode, the number of calls initiated by OCS is always larger than the
number of agents available to handle those calls once they are answered. Therefore, it is probable
that some calls may be abandoned due to a long waiting time in the queue.ln the Progressive dialing
mode, an agent targeted for an outbound call may become unavailable or receive an inbound call.
Normally, these are acceptable risks, and in some countries, government regulations set an allowable
level of abandoned calls.

For Assured Connection functionality, when using Progressive mode and skill-based routing
functionality, OCS provides the ability to engage the most suitable agent to handle a conversation.
Agent selection criteria (for example, skill requirements) are defined by the data in the mandatory
and user-defined fields of a calling list record. OCS attaches all user data that are related to the
record being processed to the engaging call that was dialed for this record. All the data that are
associated with the customer contact are made available to URS in the attached data of the engaging
call. OCS attaches all pairs that are attached to the outbound call that was dialed for the record,
except for GSW_RECORD_HANDLE pair. The following types of pairs are attached:

e Mandatory pairs, such as GSW_PHONE and GSW_CHAIN_ID

* User-defined pairs, as defined by the send_attribute option configuration of the mandatory and user-
defined fields

e Auxiliary pairs, such as GSW_APPLICATION_ID and GSW_SWITCH_DBID

e Pairs as defined by using Script configuration object(s) that are associated with Calling List, Campaign,
and Campaign Group objects to which the outbound record belongs

This feature enables the selection of the most suitable agent to handle the assured connection
conversation. It also enables you to meet specific business requirements, for example, to avoid call
transfers in the following scenario: callback requests are added to a single calling list which is used to
guide a Progressive outbound campaign and an agent must be available when a contact call is
established and that the agent is able to communicate with the contact in the language that is
specified by the contact, as well as being able to service the specific contact request.

Starting in release 8.1.1, OCS can guarantee connection of pre-selected calls to agents in the
Predictive or Progressive dialing mode when running campaigns in a VoIP environment. To ensure
connection to an agent, OCS verifies each call before sending it to be dialed, to determine if this call
should be dialed with a guaranteed connection. If so, OCS first dials an engaging call and waits until it
establishes on an agent. After the agent is engaged, which guarantees that the agent will not log out,
receive another call, or be reassigned to another activity, the outbound call is dialed. After the
outbound call is answered by the customer, it is immediately merged with the engaging call. If the
outbound call does not reach the customer, the engaging call is released and the agent is returned
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back to handle regular campaign calls.

There are two ways to define if the outbound call for a specific record needs to be dialed in assured
connection mode:

By selecting a field in the calling list and a set of values for this field using the assured-connect-field
option that indicates that the record should be dialed in assured connection mode.

When it retrieves the record, OCS reads the specified field and checks its value. If the value falls
within the pre-configured set of values for the field, OCS marks the record for assured connection.

By using SCXML treatments, with the set_flex_attr custom action, by setting the assured-connect
option to true for a given record or chain of records. This setting has a higher priority than a definition
using the assured-connect-field option.

The following configuration options are used to implement assured connection:

e assured-connect---Enables or disables the assured connection feature.

e assured-connect-field--Specifies the field name and set of values which nominate the record for assured
connection.

Assured Connections and Predictive Algorithm

This section describes how the Predictive Algorithm (PA) handles assured calls. The port usage for
each assured call is as follows:

¢ One port is used for an engaging call from the request to dial the engaging call, until this call is merged
with an outbound call or released.

¢ One port is used for an outbound call from the request to dial the outbound call, until this call is merged
with an engaging call or released.

e Two ports are used for an established call if the merging method is bridging.
* No ports are used for an established call if the merging method is transfer.

The PA takes into account the extended port usage related to assured calls for the following
operations:

e To restrict the outbound dialing rate so that the total number of busy ports does not exceed the total
number of ports available for Campaign Group. This latter value is specified by the Number of CPD
ports for the Campaign Group or by the dynamic allocation of ports.

e To perform the dynamic allocation of ports between running Campaign Groups.

¢ To perform the dynamic reassignment of agents in accordance with the effective size of the Agent Pool.

The PA cleans up an assured call when the pa-dial-expire option has expired since the most recent
dialing of engaging or outbound call associated with the assured call.

For the calculations of Agent Busy Factor and Average Waiting Time, the engaged agents without
outbound calls are considered Ready. The PA adds all of the engaged time intervals (from when an
engaging call is connected to an agent to when that call is merged with an outbound call or is
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released) to waiting times.

For the Predictive dialing mode, the PA adjusts the outbound dialing rate to achieve the optimization
goal, taking into account that the engaged agents can be connected only to individual assured
outbound calls. This increases the actual traffic load and decreases the useful efficiency of agents,
especially if many assured calls are not answered by live persons. When the optimization goal is not
achieved, the PA causes OCS to generate a self-diagnostic log event (12-50131) for call-related
factors, as follows:

e "Assured Calls" when there are assured calls.

e "Assured Dialing Influence" when the Optimization Goal can not be achieved due to the presence of
assured calls.

* A standard practice is to have just a few assured
outbound calls during the lifetime of a
campaign.

Notes: « A considerable percentage of assured calls may

significantly affect dialing performance of the
campaign and produce a high Abandon Rate as
well as a low Busy Factor.

Assured Connection vs. ASM (Engaging) Dialing Mode

Assured connections and ASM (engaging) dialing mode differ in the following ways.

In ASM dialing mode, engaging and regular call dialing are unrelated processes, especially in
predictive ASM. You cannot precisely define which regular call will be bridged with what engaging call.
Also, there is no guarantee that there will be an engaging call with which to complete the bridge
transfer.

In ASM dialing mode, OCS does not release an engaging call that is not bridged while the Campaign
Group is running, regardless of the result of regular call dialing. In the assured-connect dialing
sequence, an engaging call is released if the regular call dialing has a negative result.

The purpose of an assured connection is to guarantee the presence of an agent for a specific call in
predictive dialing, where the agent's presence is not guaranteed by definition. The assured
connection can be used for only a limited number of contacts in the Campaign; otherwise the quality
of predictive dialing is compromised.

ASM is supported in IP and TDM environments (with restrictions for certain line protocols and Dialogic
board types).

Assured connections are supported in Outbound IP environments (with SIP Server and Media Server)
only.

Outbound Contact Deployment Guide 111



Outbound-VolP Deployment OCS Load Balancing in SIP Cluster

OCS Load Balancing in SIP Cluster

Starting with release 8.1.522.05, when operating in SIP Cluster deployments with multiple SIP Cluster
nodes, OCS supports load distribution in the following dialing modes: Progressive, Predictive,
Progressive with Seizing, Predictive with Seizing, Progressive GVP, Predictive GVP, and Power GVP.
OCS distributes the load by issuing requests to dial outbound and engaging calls to multiple SIP
Cluster nodes. OCS uses one of the SIP Cluster nodes (called the prime node) to subscribe and
receive all DN-related events.

See the Configuring Outbound Contact topic about configuring OCS in the SIP Cluster environment.

Regular (non-ASM) Dialing Modes (Progressive, Predictive, Progressive GVP,
Predictive GVP, Power GVP)

When load balancing is enabled, in the regular (non-ASM) dialing modes, OCS evenly distributes
TMakePredictiveCall requests for outbound calls between all SIP Cluster nodes in round-robin fashion.
OCS maintains a list of active (connected) primary/backup SIP Cluster nodes and sends each new
TMakePredictiveCall request to the subsequent active node. OCS checks the state of an inactive node
on the next round and attempts to send a TMakePredictiveCall request to it when it becomes active.

OCS receives all DN-level T-Events from the prime SIP Cluster node.

OCS attempts to reconnect to a backup SIP Server Application if a connection with the primary SIP
Server is lost. OCS considers a SIP Cluster node inactive if connections to both the primary and
backup SIP Server Applications are lost. OCS stops dialing if a connection is lost to the prime SIP
Cluster node (both the primary and backup SIP Server Applications are disconnected).

ASM Dialing Modes (Progressive with Seizing, Predictive with Seizing)

In ASM dialing modes, OCS balances the load per Campaign Group, where each Campaign Group can
use a different SIP Cluster node for dialing. OCS always uses the same SIP Cluster node to dial
outbound and engaging calls for the same Campaign Group. You designate a SIP Cluster node to be
used for dialing for a Campaign Group in the Agent Group level option sip-cluster-asm-dial-node.
OCS sends TMakePredictiveCall (for outbound calls) and TMakeCall (for engaging calls) requests to
that SIP Cluster node. If this option is not configured or a SIP Server Application with the configured
DBID is not present in the OCS Application connections, OCS uses the prime SIP Cluster node for
dialing for that Campaign Group.

OCS attempts to reconnect to a backup SIP Server Application if a connection with the primary SIP
Server is lost. OCS considers a SIP Cluster node inactive if connections to both the primary and
backup SIP Server Applications are lost. OCS stops dialing for a Campaign Group if a connection is
lost to the prime SIP Cluster node or to the dialer node that is used for the Campaign Group.
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Enabling Load Balancing Mode

To enable load balancing mode:

1. Add primary SIP Server Applications of the SIP Cluster nodes (all that will be included in load balancing)
to the Connections tab of the primary OCS Application object. OCS can be connected to T-Controller

ports (TCport) or Smart Proxy ports (SmartProxy) of SIP Cluster nodes.
Designate one SIP Custer node as the prime node to distribute DN-related events to OCS.

(For ASM modes only) Designate a SIP Cluster node for each Campaign Group to use as a dialer node.
Genesys recommends distributing Campaign Groups equally between SIP Cluster nodes, so that the

final load on SIP Cluster is balanced.
4. Configure the following configuration options:

* sip-cluster-lb-mode—Set this option to round-robin.

* sip-cluster-prime-node—Set this option to the valid DBID of the primary SIP Server Application object
of the SIP Cluster node that is designated as the prime one for outbound dialing.

* sip-cluster-asm-dial-node—(For ASM modes only) Set this option to the valid DBID of the primary SIP
Server Application object of the designated dialer SIP Cluster node at the Agent Group object that is
associated with the Campaign Group. This option must be set for every Agent Group associated

with Campaign Groups which will run in ASM modes.

5. Restart OCS for the configuration changes to take effect.
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Deployment Planning

These topics provide an overview of the deployment process for Outbound Contact, and includes
tools for deployment planning:

* About the Deployment Process

¢ How to Use The Deployment Planning Topics

* System Requirements

¢ Worksheet Definitions

¢ QOutbound Deployment Planning Worksheet

e Other Resources

The Outbound Contact installation uses information
that was set up during Framework configuration
Note: and installation. You can install Outbound Contact
’ only after Framework is installed. For more
information, see Outbound Object-Creation
Sequence.
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About the Deployment Process

The deployment process involves the configuration and installation of the applications and
components that are needed for a functional setup of Outbound Contact.

Before deploying Outbound Contact, review the System Requirements, as well as the following
documents that contain information about licensing requirements, supported platforms, and sizing
specifications:

e Genesys Licensing Guide

* Genesys Supported Operating Environment Reference

¢ Genesys Supported Media Interfaces Guide

In addition, use the Worksheet Definitions to gather information for the configuration and installation
of Outbound Contact.

¢ The Outbound Contact deployment process in a traditional voice environment involves the following
components:

¢ Outbound Contact Server (OCS)

e Genesys Administrator

* CPD (Call Progress Detection) Server (optional)
e CPD Proxy Server (optional)

Outbound Contact 8.1 supports Outbound Contact

i Manager 7.6.

¢ The Outbound Contact deployment process in an IP environment involves the following components:
* Outbound Contact Server (OCS)
* Genesys SIP Server
* Genesys Administrator
e Either GVP Media Server or CPD (Call Progress Detection) Server (optional)
e CPD Proxy Server (optional)

¢ In a blended environment, with both IP and traditional telephony, all the components listed above are
required.

During installation, test each component before you continue to the next.

Make sure that you install all Framework components, including Configuration Server, Configuration
Manager, T-Server, the Management Layer, DB Server, and Stat Server. In addition, install Genesys
Administrator, which can be used instead of Configuration Manager to handle all configuration
requirements.

For information about configuring and installing Framework products, see the Framework
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documentation.

If necessary, install Dialogic boards and software for call-progress detection. For more information
about installing Dialogic boards, see Introduction to Dialogic Boards.

For additional information about Formats, Calling Lists, Campaigns, Campaign Groups, and how to
start or stop a Dialing Session, see Framework Genesys Administrator Help.
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How to Use The Deployment Planning
Topics

Before beginning Outbound Contact configuration and installation, review the System Requirements,
and then complete the Worksheet Definitions.

The worksheet provides space for your notes, and multiple boxes (cells) provide room to write
additional values, if needed. If you need to provide additional information, you can make copies of
the worksheet.

The structure of these topics is based on the configuration sequence found in the Outbound
Configuration Wizard. Outbound properties for Genesys Administrator are also included.

After completing the installation, keep the worksheet as a reference. In the future, if you need help
from Genesys Technical Support, you can fax the worksheet to a support engineer in order to provide
the complete system configuration.
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System Requirements

This section describes some of the system sizing requirements for the installation of Outbound
Contact.

In addition, the following documents on the Technical Support website provide detailed information
about the operating systems and databases supported by Outbound Contact:

e Genesys Supported Operating Environment Reference

e Genesys Supported Media Interfaces Guide

Environmental Sizing

The information provided in this subsection helps you create the most effective environment for
running Outbound Contact in your contact center.

The following table shows the recommended sizing requirements for various contact centers.

Outbound Contact Environmental Sizing for Components

Outbound Contact Transactions per

CPU Memory Network

Component Second
Pentium lIl, 400 128 MB (Windows

I\O,Igtnt;%uer:d Contact MHz 2000 or Windows }r?wim%pusm) Not applicable
(recommended) XP)

Outbound Contact e 1, 120 10 mbps U4

S — MHz 512 MB (minimum) Gt transactions per
(recommended) agent per second

CPD Server Supported

interfaces:

e LSI

e Line-side (E1/

T1)

e PRI . 0.5—1
Single or dual - 10 mbps .

.« HMP processor, 1GHz 512 MB (minimum) (minimum) transactions per

The CPD Server and the
Dialogic cards and
drivers it controls must
be installed on the
same computer.IP
version 6 addressing
schema (IPv6) is not
supported by Dialogic

agent per second
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HMP.

Environmental
recommendation
for 240 Ports

Number of Agents

25—100

10—200

20—600

60—1000

100—2000

200—4000

Note:

Dual processor
Pentium Ill, 600
MHz

Pentium IlI, 400
MHz

Pentium Ill, 400
MHz

Pentium llI, 400
MHz (minimum) +
100 MHz for every
200 agents

Single/dual
processor,1 GHz

Dual processor,
1GHz

Dual processor,
1.5 GHz

Database Sizing

256 MB

128 MB

256 MB

256 MB

512 MB

512 MB (minimum)

512 MB (minimum)

100 mbps

10 mbps
(minimum)

10 mbps
(minimum)

10 mbps
(minimum)

100 mbps

100 mbps

100 mbps

0.5—1
transactions per
agent per second

0.5—1
transactions per
agent per second

0.5—1
transactions per
agent per second

0.5—1
transactions per
agent per second

0.5—1
transactions per
agent per second

0.5—1
transactions per
agent per second

0.5—1
transactions per
agent per second

The list of Dialogic boards might be extended
based on their support by the CPD Server. Refer to
the Genesys Supported Media Interfaces Guide for
the current list of supported boards.

Outbound Contact Server supports IBM's DB2 database, in addition to the previously supported
database management systems (Oracle, Microsoft SQL Server, Informix, and Sybase).

The sizing of your database can affect the performance of the Outbound solution. The term sizing
pertains to how the database is tuned, the available memory, and the number of processors. The
term tuning pertains to the indexing of the calling list. The higher the number of transactions that the
database processes, the more the database performance is affected, unless it is properly sized.

When sizing your database, consider the factors shown in the following table.

Format

Database Sizing

Estimated Size for Each
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Record
Transaction
Database

1 KB
1 KB

100 MB per 100,000 records per campaign

If the size of one record is equal to the size of one transaction (1 KB) and if the size of the calling list
is 100,000 records, the estimated size of the database is 100 MB. See the Outbound Contact
Reference Manual for more information about database tuning.

Network Traffic

The following table provides basic data about network traffic produced by Outbound specific activities
among various Framework and Outbound components. This information can help you determine the
optimal component location on the network.

Network Traffic Among Framework and Outbound Components

Primary Data Types

OCS <-> DB Server

Record from
Calling List

Update of Record
Attributes

OCS <-> CPD Server

Dialing Request

Agent Seize
Request (ASM
mode only)

Average Message
Length

0.25 KB + total
length of Field

Names + average
Record Data length

0.5 KB

0.25 KB + User
Data

0.5 KB

Messages Per

Transaction

1if OCS is not
configured to save
intermediate
results, otherwise,
1 per treatment

1 per Dial Attempt

1 per AgentReady
TEvent

Elements Determining
Total Message

Number of Records
requested per
Select = <Number
of Agents in
Campaign Group>
* <Optimal Buffer
Size Coefficient> -
<Minimum Buffer
Size Coefficient>

Hit Ratio,
Treatments

Hit Ratio,
Treatments

Conversation
Duration

Traffic Total Traffic
Volume

<Number of
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>

<Number of
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>

<Number of
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>

Total Number of
successful
Contacts
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Call Progress
Result

OCS <-> Agent
Desktop

Record

Desktop Protocol
Requests

OCS <-> T-Server

Requests (no CPD
Server)

TEvents

0.25 KB

0.25 KB + User
Data

0.25 KB

0.25 KB + User
Data

0.25 KB + User
Data

1 per Dial Attempt

1 per Answered
Call or Preview
Record Request

Typically 2

1 per Dial Attempt

5 for simple call-
distribution
scenario

Hit Ratio,
Treatments

Number of Records
processing
Desktop sessions

Number of Records
processing
Desktop sessions

Hit Ratio,

Treatments

Hit Ratio,
Treatments

<Number of
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>

Total Number of
successful
Contacts, in
Predictive or
Progressive
mode, <Number
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>, in
Preview mode

Total Number of
successful
Contacts in
Predictive or
Progressive
mode, <Number
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>, in
Preview mode

<Number of
Records from all
Calling Lists in
Campaign> *
>Average Number
of Attempts per
Record>

<Number of
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>
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CPD <->ET-Server

Dialing Request

Transfer Request

Agent Seize
Request (ASM
mode only)

TEvents

0.25 KB + User
Data

0.25 KB

0.5 KB + User
Data

0.25 KB + User
Data

1 per Dial Attempt

1 per Dial Attempt

1 per AgentReady
TEvent

10 for simple call-
distribution
scenario, 1 for
unsuccessful dial
attempt

Hit Ratio,
Treatments

Hit Ratio,
Treatments

Conversation
Duration

Hit Ratio,
Treatments

<Number of
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>

<Number of
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>

<Number of
Records from all
Calling Lists in
Campaign> *
<Average Number
of Attempts per
Record>
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Worksheet Definitions

For more information about the following items, see "Other Resources".

Logging In to Genesys Administrator

e User name--Enter the user ID authorized to log in to Configuration Server.

* User password--Enter the password for the user ID authorized to log in to Configuration Server.
e Application--Enter the name of the Genesys Administrator Application object.

e Host--Enter the host name of the computer on which the Configuration Server is installed.

e Port--Enter the port that the Configuration Server uses for client connections.

License Manager

¢ Path to License Manager--Enter the path to the License Manager. License Manager must be available for
licensed application.

Outbound Solution Object

¢ Name--Enter a name for the Outbound solution object.

¢ Solution Control Server--Enter an existing Solution Control Server.

Tenant

¢ Name(s)--If this a multi-tenant environment, enter the names of the tenant to be used for Outbound
Contact.

Switches

As part of the Framework configuration and installation, you will have already assigned agent names,
agent logins, and DNs (see DNs in the Planning Worksheet) to switches.

In most systems, the telephone directly notifies the switch when the telephone set (teleset) status
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changes--for example, when agents begin or end a call. By default, Outbound Contact registers
teleset states internally. Older PBX software does not enable the teleset to notify the switch directly
when its status changes. If the contact center's PBX software does not enable direct notification, you
must customize the contact center's teleset state disposition. Use configuration settings that instruct
Outbound Contact to send Framework's T-Server a notice for each teleset status change. For more
information, see Outbound Contact Configuration Options.

The following refer to the capabilities of a switch:

¢ Name(s)--A switch set up during Framework configuration. Other switches can include numbers and
types of all telephony devices (DNs) to be monitored and controlled through the CTI (computer-
telephony integration) link. Enter the switch name(s) to be used for Outbound Contact. If new switches
are needed, they must be added through Framework.

e CPD capability--Does the switch have call-progress detection (CPD) capabilities? If the switch does not
provide call-progress detection, and you wish to use CPD Server as a part of Outbound Contact for the
contact center, collect the following information about the Dialogic boards:

* Call transferring--Does the switch have this capability?
* Call conferencing--Does the switch have this capability?
* Call forwarding--Does the switch have this capability?

* Do Not Disturb--Does the switch have this capability?

Special DNs

Communication DN
Outbound Contact reports on outbound activity by using a DN that is set up as a Communication DN.

¢ Number--Enter the name or number of the Communication DN.

¢ Type--Always enter "Communication DN".

Overflow DN

Outbound Contact monitors calls that cannot be handled by available agents. It does this through a
DN set up as an Overflow DN.

e Existing DN name--Enter the name or number of the overflow DN.

Applications

Each application name must be unique, and it can contain alphanumeric characters and underscores.
the properties for most applications are the same; therefore, definitions are given only once for the
"Applications" section of the worksheet.
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¢ T-server name(s)--Enter the name of the T-Server.

» Stat Server name(s)--Enter the name of the Stat Server.

e DB Server name(s)--Enter the name of the DB Server.

* OCS name--Enter the name of the Outbound Contact Server.

e CPD Server name(s)--Enter the name of the CPD Server.

e Genesys Administrator name--Enter the name of Genesys Administrator.

e Reporting--See the Reporting documentation.

Tenants

¢ Tenant name(s)--If this is a multi-tenant environment, select the name of the tenant.

Server Info
¢ Host--Select the host computer on which your application will be running.

e« Communication port--Enter the port number that the application's clients will use to establish
connections to the named server.

e Back up Server--Select the back up server to be contacted if connection to the primary server fails.
Options

¢ Option names--Options are changed according to the user's needs. For detailed information about
options, see Outbound Contact Configuration Options.

Database Access Point(s)
¢ Name--Enter the name of the Database Access Point (DAP) object.

Server Info

¢ DB Server name--Select the name of an existing DB Server.

e DB Server host--Select the host computer on which the DB Server will be running.

Tenants

¢ Tenant name(s)--If this is a multi-tenant environment, select the name of the tenant.
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DB Info

¢ DBMS name--Select the name of the host computer on which the database resides.
e DBMS type--Select the type of database.

¢ Database name--Enter the name of the database.

e User name for login to DB--Enter the user name for accessing the database.

* Password for login to DB--Enter the password for access the database.

User-Defined Fields

A calling list must contain Genesys mandatory fields, and it can also contain user-defined fields. For
more information about mandatory fields, see Field Object and Format Object. The user must create
additional fields, containing business information that is used for sorting and chaining records--for
example, Last Name.

* Name--Enter the name of the user-defined field--for example, cust _id.

» Data type--Enter the type of data, for example, the data type for cust_id would be int, and must
always be numeric.

e Length--Enter the number of characters needed for field contents--for example, cust_id can be limited
to five numeric characters.

¢ Default value (optional)--Enter the value that will be assigned to the field unless it is changed.

Formats

A format contains a collection of Genesys mandatory fields and user-defined fields. It defines the
layout of a calling list. More than one format can be created and named for the specific needs of
particular calling lists.

Identify the number of formats that you need, assign names to them, and identify the user-defined
fields required for each.

Plan and create your formats and all custom fields
Note: carefully. You cannot modify existing fields or add
’ new fields after the calling list table is created in
Genesys Administrator.

¢ Name--Enter the name of format.

¢ User-defined field names--Enter the names of the user-defined fields to each format.

Outbound Contact Deployment Guide 126



Deployment Planning Worksheet Definitions

Table Access

¢ Name--Select the name of the Table Access object.

¢ Table type--Select "Calling List."

* DB access point name--Select the name of the database access point through which the table can be

accessed.
e Format name--Enter the name of the format applied to this table.

* Database table name--Enter the name as specified in the database.

Dialing Filters

Dialing filters select records from a calling list for dialing, based on specified criteria. They can be
created in Configuration Manager or in Genesys Administrator and stored in the Filters view in
Genesys Administrator > Provisioning tab > Outbound Contact. For more information, see
Filter Object.

* Name--Enter the name of the dialing filter.

e Criteria SQL statement--Enter the SQL statements that give the criteria for the filter.

e Order by SQL statement--Enter the field on which the list will be sorted.

Treatments

Decide on treatments to use for unsuccessful call results. For more details and examples, see Call
Handling Treatments.

* Name--Enter the name of the treatment.

e Call result--Enter the result of dialing a calling list record.

e Apply to record--Enter the action to be applied to a calling list record, based on the call result.

¢ Apply to call (very limited use)--Enter the final outcome of attempts to dial a record.

e Destination DN (if "Apply to call")--Enter the DN to which a treatment will forward a call.

¢ Number in sequence--In a treatment sequence, each treatment contains a unique number that

determines the order in which it will be applied to the same call result, on calls from the same calling

list.

¢ Cycle attempt (only for redial)--Enter the maximum number of consecutive times that the treatment
be performed on the record.

* Interval--Enter the time interval, in minutes, that the application will wait between the first dialing
attempt and the first treatment attempt, or between consecutive attempts.

¢ Increment--Enter the number of minutes that the application will add to the interval (see the previou
item) after the first treatment attempt, and after each consecutive attempt.

will

S
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* Date/Time--Enter the date/time when another treatment attempt will be performed.

Calling Lists

Calling lists contain dialing records. Decide where you will store the calling lists. They can be located
either in the Genesys Configuration Database or in a separate database. The size of the calling lists
and the ease of maintenance are the deciding factors when identifying the appropriate location. Very
large calling lists should be maintained in a database other than the Genesys Configuration
Database.

* Name--Enter the name of the new calling list.

e Table Access Point name--Enter the name of the Table Access object to which the calling list refers.

Dialing filter name (optional)--Enter the name of default dialing filter to apply to the calling list.

e Script property--The Script property in the campaign, in the calling list, and in the Campaign Group
defines the Script object, which contains all of the attributes that are required by Agent Scripting.

Treatments

* Treatment names (optional)--Identify or create treatments that will be applied to the records on the
calling list if calls are unsuccessful.

Campaigns

Campaigns are collections of callings lists and agent or place groups. Agent skills that might be
considered during the processing of customer interactions include language or marketing knowledge.
* Name--Enter the name of the campaign.
e Calling list name(s)--Enter the names of the calling lists to be used by each campaign.

¢ List weight (if more than one list)--Enter the percentage of call records to be retrieved from a calling list
for a campaign. For more information, see Framework Genesys Administrator Help.

Campaign Group

e Group name(s)--Enter the names of the agent or place groups assigned to each campaign.
e Group type--Enter the type (agent or place) of each group assigned to each campaign.

e Dialing mode--Decide on a dialing mode to use as the default for the agent groups in a campaign. The
dialing modes are Progressive, Predictive, Preview, Push Preview, and Power GVP.

¢ Voice Transfer Destination ("Origination DN" in previous releases)--Enter the queue or Routing Point to
which a call is transferred after a "live" answer.
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¢ Optimization method--Sets the default dialing optimization method for the Campaign Group and applies
only to Predictive dialing mode.

e Target value--Enter the percentage value of the optimization method.

e Buffer size coefficient minimum--Enter the minimum number of chains per active agent that OCS can
keep on hand for dialing.

* Buffer size coefficient optimal--Enter the optimal number of chains per active agent that OCS can keep
on hand for dialing.

¢ Number of CPD ports--Enter the number of dialing ports that can be used for dialing on behalf of a
Campaign Group. If you are using ASM mode, at least one port is required for each agent for the
engaging calls, in addition to ports for outbound dialing.

¢ CPD Server name (if more than one)--Enter the name of the CPD Server to use for this Campaign Group.
e Script property--The Script property in the campaign, calling list, and Campaign Group defines the Script
object, which contains all of the attributes that are required by Agent Scripting.

For an Outbound-IP environment, configure Trunk
Note: Group DNs on the Configuration tab/Advanced
' section. For more information, see Outbound VoIP
Deployment.

Reporting (Optional)

¢ Real-time reporting--If you install real-time reporting (CCPulse+), see also the Reporting 8.0 Deployment
Guide and the Reporting 8.0 CCPulse+ Administrator's Guide.

Note: You can also use CCPulse+ to view historical
' reports.

¢ CCPulse+ name--Enter the name of the CCPulse+ to be used.

e Stat Server name--Enter the name of the Stat Server to be used with CCPulse+.

e Historical reporting--If you install historical reporting (ICON and/or CCPulse+), see the Reporting 8.0
Deployment Guide and/or the Interaction Concentrator Deployment Guide.
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Outbound Deployment Planning Worksheet

This planning worksheet provides a single place in which to record the information that is required to
configure and install Outbound Contact. The cells on the worksheet provide room to write additional

values. After it is completed, the planning worksheet expedites the installation and configuration

process. It serves as a "look-up" sheet for critical information that you will need in order to complete
the process. The information about the items in the Sample Planning Worksheet is important to have

on hand.

Sample Planning Worksheet

The following table is a sample planning worksheet in which to record information that you need to

have on hand during the configuration process.

T-Server(s)

Logging In to Genesys Administrator

1.

Ul =~ RO N

License Manager

Name Item

User name
User password
Application
Host

Port

Path to License
Manager

Outbound Solution Object

7.

Tenant

8.

Switches

Name

Names

Name(s)
Type of switch

Planning Worksheet
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Internal or

10. External CPD
capability
T-Server
connected to

11. each switch
(one-to-one
relationship)
Special
DNs.19for
example,

12. .
Communication
DN and
Overflow DN

DNs

13. ACD positions

14. Extensions

15 Call processing

’ Ports (CPP)

16. ACD Queues

17. Routing Points

18. Virtual Queues
Communication

LEl DNs
Trunk Group
DNs (for
Outbound-IP
dialing modes)

20.
Note: For more
information, see
Outbound VolP
Deployment.

Applications

21 T-Server
name(s)

22. Host

23. Port

24. Back-up
Designated
switch (one-to-

25. one

relationship)

Stat Server(s)
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26.

27.
28.
29.

DB Server

30.
31.
32.
33.

34.

35.

Stat Server
name(s)

Host
Port
Back-up server

DB Server
name(s)

Host
Port
Back-up server

Options (see
Database
Access
Point(s).)

DBMS type

Outbound Contact Server (OCS)

36.
37.

38.

39.

39.

40.

CPD Server

41.

42.

43.

44.

45.

46.

OCS name
Host

Communication
port

Back-up server

Name(s) of T-
Server(s) to
which OCS
connects

Name of
Message
Server to which
OCS connects
(optional)

CPD Server
name(s)

Host

Communication
Port

Back-up server
for CPD Server

Name of T-
Server to which
CPD Server
connects

Type of
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47.

Dialogic
board(s)

DTI Ports (DNs
for Dialogic
board). (See
DNs, near the
top of the
table, starting
at row 13.)

Genesys Administrator

48.

49.

Objects

Genesys
Administrator
name
(application)

Name of OCS
to which
Genesys
Administrator
connects

Database Access Point(s)

50.

51.

52.

53.

54.

55.

56.

57.

58.

59.

Name

DB Server
name. (See
row 30.)

DB Server
host. (See row
31.)

DB Server
communication
port. (See row
32.)

DBMS name

DBMS type.
(See row 35.)

Database
name

User name for
login to DB

Password for
login to DB

Case
Conversion

User-Defined Fields

60.

Name
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61.
62.

63.

Formats
64.

65.

Table Access
66.
67.

68.

69.
70.
Dialing Filters
71.

72.
73.

Treatments
74.
75.
76.
77.

78.

79.

80.

81.
82.
83.
84.

Data type
Length

Default value
(optional)

Name

User-defined
field names.
(See above.)

Name
Table type

DB Access
Point name.
(See row 50.)

Format name.
(See row 64.)

Database table
name

Name(s)

Criteria SQL
statement

Order by SQL
statement

Name

Call result
Apply to record
Apply to call

Destination DN
(if "Apply to
call")

Number in
sequence

Cycle attempt
(only for redial)

Interval
Increment
Date/Time
Range
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Calling Lists

85. Name

86 Table Access

' Point name

Dialing filter

87. name
(optional)

88 Script property

' (optional)

Treatment
names

89. (optional). (See
Treatments.)

Campaigns

90. Name

91 Calling list
name(s)
List weight (if

92. more than one
list)

Campaign Group

Session

3. name(s)

94. Session type
95. Dialing mode

Voice Transfer
Destination

96. ("Origination
DN" in previous
releases)

Optimization

97. method

98. Target value

Buffer size
99. coefficient
minimum
Buffer size
100. coefficient
optimal
Number of CPD
ports

CPD Server
name (if more
than one)
(optional)

101.

102.

103. Script property
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104.

105.

106.

107

(optional)

Stat Server
name

OBN Manager
name (optional
component)

Interaction
Server
(optional
component)

Trunk DNs (for
Outbound-IP
dialing modes)

Note: For more
information, see

OutboundVolPDeployment.

Reporting (Optional)

108.

109.

Real-time
reporting; if
yes, see
Reporting

documentation.

Historical
reporting; if
yes, see
Reporting

documentation.
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Other Resources

You may want to use the following additional resources for reference.

* Framework Genesys Administrator Help--This Help system contains details about setting up application
and component objects, and performing other important configuration tasks.

e Framework--You can obtain information for the Outbound Deployment Planning Worksheet from
Framework. For example, Tenants and Switch objects usually are created in the Framework Wizard, but
sometimes they are created in Genesys Administrator. Outbound Contact uses some Framework
Application objects that are created in the Framework Wizard or Genesys Administrator--for example,
the Stat Server and DB Server. For some objects, you only need to identify their names in Framework
and write those names on the worksheet.

e Qutbound Contact 8.1 Reference Manual--This document explains the constants and communication
protocols for Outbound Contact.

e Wizard Advisories for Outbound Contact, Framework, and Reporting, also contain useful information,
and are located on each specific solution CD. All other documents are provided on the documentation
library software CD that is specific to Outbound Contact as well as to other Genesys software products.

Refer to the appropriate GVP and Interaction Server
Note: documentation if you are implementing Power GVP
or Push Preview dialing modes.
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Manually Configure and Install Outbound
Applications

These topics describe how to configure and install Outbound Contact manually:

¢ QOverview
* Configuration
¢ Installing On Windows

* Installing On UNIX
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Overview

These topics provide instructions for a manual, first-time configuration and installation of the
Outbound Contact components, which include Outbound Contact Server (OCS), CPD (Call Progress
Detection) Server, CPD Proxy Server, and Outbound solution objects. This topic also describes an
Outbound-specific aspect of Stat Server.

These topics include instructions for installing
Outbound Contact Manager (OCM), even though
Genesys Administrator replaces OCM as the

Note: preferred configuration interface in release 8.1.

‘ OCM 7.6 can be used with Outbound Contact 8.1.

For installation instructions for Genesys
Administrator, see the Framework Genesys
Administrator Deployment Guide.

Use the completed Worksheet Definitions in this guide, as well as the other relevant chapters in this
guide, to configure and install Outbound Contact applications (components) and objects.

Genesys does not recommend installing its
Note: components via a Microsoft Remote _Desktop
) connection. You should perform the installation
locally.

The overall process of configuring and installing Outbound Contact components involves the following
steps:

Configuring and Installing Outbound Contact Components

Objective Related Procedures and Actions

1. Configure and install all Framework
components, which include Configuration
Server, T-Server, the Management Layer, DB
Server, and Stat Server.

Configure and install Genesys Administrator.
Start Configuration Server.

1. Configure application objects. Start Genesys Administrator.

u A~ W N

Configure OCS as described on Outbound
Contact Server.

6. Configure CPD Server as described on CPD
ServerCPD Server.

7. Configure Genesys Administrator. See the
Framework Genesys Administrator Deployment
Guide.
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1. Install OCS as described for Windows (Installing
OCS on Microsoft Windows 2003 or 2008) or for
UNIX (see Installing OCS on UNIX).
2. Install CPD Server as described on Installing
2. Install Outbound Contact components. CPD Server on Microsoft Windows 2003 or

2008.

3. Install Genesys Administrator. See the
Framework Genesys Administrator Deployment
Guide.

?e'pcoc:,?i?]%ure and install real-time and historical Refer to Real-Time and Historical Reporting.
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Configuration

All of the information in this section is based on
using Genesys Administrator to configure and
install your Outbound applications. However, you
can still use Configuration Manager.

Note:

Before you create an Application object, make sure that an application template exists. The
template provides most of the application's configuration options and default values.

To locate an existing template, open the Environment view in Genesys Administrator and then the
Application Templates view. If the template is absent, import one from the Templates folder on
the Outbound Contact Center CD.

Importing a template

Start

Select the Application Templates view.

Open the Tasks panel, if necessary, and click Import Application Template.
In the file-selector dialog box, do the following:

If necessary, navigate to where the template is stored.

Select the appropriate .apd file.

Click Open.

On the Configuration tab, enter or modify information as required.

On the Options tab, enter or modify information as required.

© ® N o U A~ W N

If the Templates folder also contains a metadata file, import that metadata into the Application
Template.

=
o

. To save the new Application Template and register it in the Configuration Database, perform one of the
following:

a. Click Save and Close to return to the list of Application Templates.
b. Click Save to continue configuring the Application Template.

c. Click Save and New to save the new Application Template and start creating another one.

End

Configuration Advisory

Application objects represent software components in Genesys Administrator. This topic describes
four Outbound Contact application objects:
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Outbound Contact Server (OCS)
e CPD Server (optional)

CPD Proxy Server (optional)

¢ Outbound Contact Manager (optional if you are using Genesys Administrator)

Outbound Contact also requires the following applications:

e Genesys Administrator--Allow you to configure all Outbound Contact applications and objects, run
dialing sessions, and monitor all related activities

e Stat Server (Reporting)--Determines what agents are assigned to which Agent or Place Groups,
identifies the current Agent State, and for reporting purposes.

¢ CCPulse+ (Reporting)--Calculates real-time and historical Outbound-specific statistics

e ICON (Reporting)--9Calculates historical Outbound statistics

The person who will run or change an Outbound dialing session/campaign requires access
permissions that include Read access privileges to all campaign-related configuration objects. Click
the Permissions tab of each configuration object to view the Access Groups that have permission to
read it.

Warning

Starting with release 8.1.527.14, OCS supports Stat Server that has the accept-
clients-in-backup-mode option set to true. See the stat-server-ha option
description for details. Earlier versions of OCS do not support Stat Server that has the
accept-clients-in-backup-mode option set to true. In Stat Server version 8.5.1,
this is the default value for this option when it is not configured.

Client-Side Port Security Configuration

To increase security, you can define a fixed port for the connection between an Outbound Contact
component and another server that is behind a firewall. The client-side port definition feature allows
a server application to control the number of client connections, preventing the server from an
excessive number of malicious requests to the same server-side port.

For configuration instructions, see the "Client-Side Port Definition" chapter of the Genesys Security
Deployment Guide. The following table identifies which Outbound Contact-specific components
support this configuration.

Component Support of Client-Side Port Security

Configuration Server/Configuration Server

Server Clients Proxy T-Server

0Cs Yes Yes

CPD Server Yes Yes

CPD Proxy Server Yes Not Applicable
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Connections to Configuration Server

During the application installation, new command-line arguments are added to connect to
Configuration Server using the port designated during installation, which are then used during
application startup. The arguments include:

-transport-address and -transport-port.
The command-line format for starting a connection to Configuration Server would be:

cm server.exe -host <host name> -port <port number> -transport-address <IP address>
-transport-port <port number> -app <application name>

After installation, these arguments appear in three places:

e Configuration Server Application object > Configuration tab > Server Info section.
¢ (Windows operating system) startServer.bat file; (UNIX operating systems) run.sh.

¢ In the Registry when the application (OCS, CPD Server, or CPD Proxy Server) is started as a Service

To support reconnection to Configuration Server,
you must still create or update the existing
connection to Configuration Server in the OCS
Configurations tab of the OCS Application

Note: object, following the standard procedure for
configuring connections to other servers. For
specific instructions associated with client-side port
connections, see the Genesys Security Deployment
Guide.

Outbound Contact Server

Outbound Contact Server (OCS) is the main component of Outbound Contact.

Configuring OCS

Start

=

. In Genesys Administrator, open the Environment view and then select the Applications view.

N

. From the toolbar, click New.

3. In the Browse dialog box, select the Application Template for this application (navigating to the
appropriate folder if necessary), and click OK.

If an Application Template for OCS is not
available, click Cancel and import or create a
template. Then restart this procedure to create
the new template.

Note:

4. On the Configuration tab, enter the following information for the OCS application:

Outbound Contact Deployment Guide 143



Manually Configure and Install Outbound Applications Configuration

* Name: Enter the name of the OCS application

e Connections: Click Add, and then add a T-Server application. Optionally, you can also add a
Message Server application.

Do not name the OCS application 0CServer
because this is a section name in the Options
tab of a configuration object. See Section Names
for more information.

Note:

The only servers for which OCS searches in the Connections section of its application at startup are T-Server and Message Server
(optional). Connection to other servers that are required to run an outbound dialing session (such as CPD Server, Stat Server, and
Interaction Server) can be specified on the Configuration tab of a Campaign Group object.

e |f you are configuring OCS to support TLS, see
the Genesys Security Deployment Guide for
configuration instructions; also, see Transport
Layer Security Connections for information
on which Outbound Contact components
support TLS connections for this release.

e |f you are configuring a connection to
Interaction Server, create a port called ESP.
Use this ESP PortlID instead of the default
PortID, when you configure a connection to
the OCS Application object of the
Interaction Server Application object. This
makes OCS a server for Interaction Server

Ml and Interaction Server a client for OCS.

e |If you are configuring TLS between OCS and
DB Server, add a Database Access Point
(DAP) to DB Server on the Configuration
tab/Connections section of the OCS
Application object.

e If you are configuring TLS between OCS and
CPD Server/CPD Proxy Server, add a
connection on the Configuration
tab/Connections section of the OCS
Application object to CPD Server/CPD Proxy
Server respectively.

5. In the Server Info section of the Configuration tab, do the following:

a. Enter the host name of the computer on which this application will be installed, and enter the port
that the application will use for client connections.

b. If you plan to use another server as a backup, in the event that the primary server fails, enter the
name of the backup server and adjust the value of the Reconnect Timeout option.

c. If you need OCS to support communication with clients when using HTTP or HTTPS requests (for
example, to update records over HTTP/HTTPS), configure the interface by specifying a separate
listener port for HTTP Proxy Server with the Connection Protocol set to http. For more information
about HTTP and HTTPS requests and HTTP Server, see Outbound Contact and HTTP Server and the
Proactive Contact 8.0 Solution Guide.

Dynamic changes to this port are not

B supported. As a result, any such changes are
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not communicated to an HTTP Proxy that is
already running. However, any HTTP Proxy
started after that change will reflect the
change.

6. Define the Working Directory and Command-Line properties - for example:
Working Directory: C:\GCTI\Outbound Contact ServerCommand Line: cm server.exeCommand
Line Arguments: -host <host name> -port <port number> -app <Capplication name>

If you are implementing the client-side port
security feature, specify the additional
arguments described in Client-Side Port Security
Configuration.

Note:

7. Click the Options tab, and change the values of the configuration options according to your
configuration.

For detailed information about OCS options, see the Outbound Contact Server
Options.

End

Genesys Administrator

For configuration and installation procedures for Genesys Administrator, see the Framework Genesys
Administrator Deployment Guide.

CPD Server

Outbound Contact requires hardware that recognizes call results, a capability known as call progress
detection (CPD). Outbound Contact works with a CPD device provided by the switch vendor, or with
CPD hardware from Dialogic.

If the switch does not have call progress detection capability, you must install switch-extending
equipment (a Dialogic board) to perform this function. Install the GlobalCall Dialogic package before
installing the CPD Server.

Beginning with release 7.5, you can also install the
Dialogic Host Media processing (HMP) software.

Note:
Only one instance of CPD Server using HMP software can be

executed on a host computer.

Before you configure CPD Server, have on hand the Worksheet Definitions. Refer also to CPD Proxy
Server and Dialogic Board Setup.
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Configuring CPD Server
Start

1. In Genesys Administrator, open the Environment view and then select the Applications view.

2. From the toolbar, click New.

3. In the Browse dialog box, select the Application Template for this application (navigating to the

appropriate folder if necessary), and click OK.

If an Application Template for OCS is not
Note: available, click Cancel and import or create a

template. Then restart this procedure to create
the new template.

4. On the Configuration tab, enter the following information for the CPD Server application:
a. Name: Enter the name of the CPD Server application.

b. Connections: Click Add, and then add a T-Server application and a Message Server application to
which this server will connect.

5. In the Server Info section of the Configuration tab, perform the following,

a. Enter the host name of the computer on which this application will be installed, and enter the port
that the application will use for client connections.
If you plan to use another server as a backup in the event that the primary server fails, and if a

Dialogic board is installed, enter the name of the backup server and adjust the value of the
Reconnect Timeout option.

If you are configuring CPD Server to support
TLS, see the Genesys Security Deployment
Guide for configuration instructions. Also, see
Note: Transport Layer Security Connections for
information on which Outbound Contact

components support TLS connections for this
release.

b. Define the Working Directory and Command Line properties—for example:
Working Directory: C:\GCTI\cpd server
Command Line: cpdserver.exe
Command Line Arguments:

-host <host name> -port <port number> -app <application name>

If you are implementing the client-side port
Note: security feature, specify the additional
' arguments described in Client-Side Port
Security Configuration.

6. Click the Options tab, and change the values of the configuration options according to your
configuration.

For detailed information about the options for CPD Server, CPD Server Options.

End
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CPD Proxy Server

CPD Proxy Server is the core load-distribution component of CPD Server. The main task of this
optional component is to distribute client requests among various CPD Servers, in order to balance
the call load and optimize the use of hardware resources within the system. You must configure CPD
Proxy Server before you install it.

Configuring CPD Proxy Server

Start

=

. In Genesys Administrator, open the Environment view and then select the Applications view.
2. From the toolbar, click New.

3. In the Browse dialog box, select the Application Template for this application (navigating to the
appropriate folder if necessary), and click OK.

If an Application Template for OCS is not
Note: available, click Cancel and import or create a
) template. Then restart this procedure to create
the new template.

4. On the Configuration tab, enter the following information for the CPD Proxy Server application:
a. Name: The name of the CPD Proxy Server application.

b. Connections: Click Add, and then add the CPD Server(s) and the Message Server to which CPD Proxy
Server will connect.

5. In the Server Info section of the Configuration tab, perform the following,

a. Enter the host name of the computer on which this application will be installed, and enter the port
that the application will use for client connection.
If you plan to use another server as backup, in the event that the primary server fails, enter the
name of the backup server and adjust the value of the Reconnect Timeout option. See Connection
and Reconnection for more information.

If you are configuring CPD Proxy Server for TLS,
see the Genesys Security Deployment Guide
for configuration instructions. Also, see

Note: Transport Layer Security Connections for
information on which Outbound Contact
components support TLS connections for this
release.

b. Define the Working Directory and Command Line properties--for example:
Working Directory: C:\GCTI\cpd proxyCommand Line: cpdproxy.exe Command Line
Arguments: -port <port number> -host <host name> -app <application name>

If you are implementing the client-side port
Note: security feature, specify the additional
’ arguments described in Client-Side Port
Security Configuration.

6. Click the Options tab, and change the values of the configuration options according to your
configuration.
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For detailed information about these options, see Log Files.

If you have a multi-tenant environment and want
to share HMP resources, you can also configure
Note: options to restrict dialing and engaging
channels. For more information, see Centralized
Configuration and Shared HMP Resources.

End

DM3 Boards with CPA Functionality

If you are using ASM mode, and if you are using the DM3 families of boards with CPA functionality
that CPD Server supports, you must install the GlobalCall Dialogic package before you install CPD
Server. These families include the following:

e DM/V1200-4E1 (number of ports = 120)

e DM/V600-2E1 (number of ports = 60)

¢ DM/V960-4T1 (number of ports = 96)

e DM/V480-2T1 (number of ports = 48)

Outbound-Specific Statistics for Stat Server

In addition to determining which agents are assigned to which Agent or Place Groups and identifying
the current Agent State, Stat Server requires Outbound statistic definitions in order to monitor the
Outbound activities of Campaigns, Calling Lists, Dialing Sessions, ACD Queues, and agents.

Importing Outbound-Specific Statistics into the Stat Server Object

Start

1. In Genesys Administrator, open the Environment view and then open the Applications view.
2. On the Details panel, double-click the Stat Server object.
3. Click the Options tab.
4. Locate and import StatProfile.cfg.
* The latest version of this file is available on IP_CCPOCTemp 8000003b1 ENU multi, in the following
folder: multi\b1l\ip\realtime.

Stat Server is usually configured using the
Framework Configuration Wizard or in

Note: Configuration Manager. In release 8.x, you can
also configure it in Genesys Administrator and
using the Outbound Contact Wizard.
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End

The following sections provides information on Outbound-specific real-time statistics that were
introduced after Release 7.2.

New Real-Time StatServer Java OCCExtensions Statistics as of Release 7.6 or

higher
Note: These statistics require Stat Server version 7.6.1 or
’ higher with OCC Extension 7.6.1 or higher.
CurrentTrustFactor

* Category: JavaCategory
¢ JavaSubCategory: 0CCStatExtension.jar:CurrentTrustFactor

e Objects: Agent, Place

This metric, with values ranging from 0% to 100%, defines the trust factor for a specific agent. For
more information about how this factor is calculated and when it is used, see the time-to-ready-
tolerance option. This statistic is calculated based on the following formula: Aindiv = (1 - trust

factor) * 100 = Ncorrect notifications/ Ntotal notifications * 100%

CurrentFeedbackAccuracy

* Category: JavaCategory
¢ JavaSubCategory: 0CCStatExtension.jar:CurrentFeedbackAccuracy

* Objects: CampaignGroup

This metric, with values ranging from 0% to 100%, defines the current accuracy of the agent's ready
time feedback for a session.

This statistic is calculated based on the following formula:
Asess = (1 - Total Number of False Notifications/ Total Number of Notifications) *

100%

New Real-Time StatServer Java OCCExtensions Statistics as of Release 7.5 or
higher

CurrentAgentAssignment

e Category: JavaCategory
e JavaSubCategory: 0CCStatExtension.jar:CurrentAgentAssignment

¢ Objects: Agent, Place
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CurrentCampaignGroupDBID

* Category: JavaCategory
e JavaSubCategory: 0CCStatExtension.jar:CurrentCampaignGroupDBID
¢ Objects: Agent, Place

CurrentNumberAgentsAssigned

e Category: JavaCategory
e JavaSubCategory: 0CCStatExtension.jar:CurrentNumberAgentsAssigned

e Objects: CampaignGroup
New Real-Time StatServer Java OCCExtensions Statistics as of Release 7.2 or
higher
CurrentNumberChainsReady

e Category: JavaCategory
¢ JavaSubCategory: 0CCStatExtension.jar:CurrentNumberChainsReady
¢ Description: Current number of chains ready.

e Objects: CampaignGroup, CallinglList, CampaignCallingList
CurrentHitRatio

* Category: JavaCategory

JavaSubCategory: 0CCStatExtension. jar:CurrentHitRatio

e Description: Current hit ratio.

Objects: CampaignGroup
CurrentNumberDialPortsUsed

e Category: JavaCategoryl2:31 PM 2/17/2010
¢ JavaSubCategory: 0CCStatExtension.jar:CurrentNumberDialPortsUsed

e Description: Current number of dial ports used.

Objects: CampaignGroup
CurrentNumberEngPortsUsed

e Category: JavaCategory
¢ JavaSubCategory: 0CCStatExtension.jar:CurrentNumberEngPortsUsed
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¢ Description: Current number of engaged ports used.

e Objects: CampaignGroup
CurrentBusyFactor

* Category: JavaCategory

JavaSubCategory: 0CCStatExtension. jar:CurrentBusyFactor

e Description: Current number of busy factor.

Objects: CampaignGroup
CurrentOverdialRate

e Category: JavaCategory
e JavaSubCategory: 0CCStatExtension.jar:CurrentOverdialRate
¢ Description: Current number of overdial rate.

¢ Objects: CampaignGroup
CurrentAverageWaitingTime

* Category: JavaCategory

JavaSubCategory: 0CCStatExtension.jar:CurrentAverageWaitingTime

e Description: Current average waiting time.

Objects: CampaignGroup
CurrentNumberChainsFinalized

e Category: JavaCategory
¢ JavaSubCategory: 0CCStatExtension.jar:CurrentNumberChainsFinalized
e Description: Current number of chains finalized.

¢ Objects: CampaignGroup, CallinglList, CampaignCallinglList
CurrentNumberChainsRetrieved

e Category: JavaCategory

JavaSubCategory: 0CCStatExtension.jar:CurrentNumberChainsRetrieved

¢ Description: Current number of chains retrieved.

Objects: CampaignGroup, CallingList, CampaignCallinglList
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The Outbound Solution Object

You can start Outbound Contact through Solution Control Interface (SCl), a Framework application.
SCI uses the Outbound Solution object to start and stop the Outbound Contact components.

You can also start Outbound Contact through
Note: Genesys Administrator. For more information, see
Framework Genesys Administrator Help.

In Genesys Administrator > Provisioning tab > Environment, select the Solutions folder, and
determine if the Outbound Solution object is in the list. If it is not, you must import it from the
product CD and then configure it.

Importing and Configuring the Outbound Solution Object
Start

1. In Genesys Administrator, select Provisioning > Environment > Solutions.
2. From the Tasks panel, select Create > Upload solution.

3. Inthe Click Add and choose. .. dialog box, click Add and navigate to the Template folder on the
product CD.

4. Select the 0CSolution 80.sd file, click Open and then Upload.
5. Double-click the solution to open the Outbound Solution object.
6. On the Configuration tab:

* In the Name field, enter a name.

* In the Assigned Tenant field, select a tenant.

¢ Inthe Solution Control Server field, select a server.

7. Click the Components section and then add the applications that Outbound Contact needs in order to
run (see the following table).

8. Click Save and Close.

End

The following table shows the applications that you could add to the Components section for the
Outbound Solution Object. The table heading definitions are as follows:

* Application--The name of the application that Outbound Contact needs in order to run.

¢ Optional--The requirement status for the application: False means that the application is mandatory

in

order for Outbound Contact to be able to run; True means that the application is optional, and that it is
not mandatory for Outbound Contact to be able to run.
¢ Priority--The order in which the application starts, relative to the other applications.
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Configuration

Outbound Solution Object Components Tab

Application

T-Server

Interaction Server

DB Server

Stat Server

Data Sourcer

ETL Proxy

Outbound Contact Server
Message Server

CPD Server

Outbound Contact Manager or
Genesys Administrator

Optional

False
True
False
False
True
True
False
True

True

True

Priority

A A W NN DNDNNPRP

(6,1
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Installing on Windows

The Genesys Outbound CD contains the installation packages for the OCS and OCM applications. The
CPD Server installation package is located on the Genesys Outbound CPD Server CD.

The setup files for these components are located in the following folders:
e OCM: \\solution specific\outbound contact mgr\windows

Note: The OCM release 7.6.x is packaged with Outbound
' Contact 8.1.

e OCS: \\solution specific\outbound contact server\windows

e CPD Server: \\solution specific\cpd server\windows

If you downloaded Outbound Contact from an FTP site, the installation package is contained in a ZIP
file and you must extract it using the WinZip utility. After you extract the files, the setup files for the
applications will be in the Windows folder.

Installing OCS on Microsoft Windows 2003 or 2008

Note: The OCS Application object must already be
' configured before you begin the installation.

Start

1. From the product CD, open the following folder:
solution specific\outbound contact server\windows and run setup.exe

If you are installing a new version of the same
Note: release, you will need to select Install new
) instance of the application as the Setup

Type.

2. If you are setting up client-side port configuration for the initial connection to Configuration Server,
select the Use Client Side Port check box and then specify the following parameters:

e Port--Enter the port number for the client, as preconfigured on your firewall. (This is not the
Listening port of the OCS application.)

e IP Address--Enter the IP Address of the computer on which you are installing and running the OCS
application.

e After selecting this option, the installation
process will add the necessary command line
Notes: arguments -transport-address and
: -transport-port) for connecting to
Configuration Server at the application
startup.
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e In IPv6 deployments, you cannot set the IP
address of the host--only IPv4 addresses can
presently be set for the host. Therefore, do
not try to specify the IP address of the host.
OCS will use the host name in the URI.

3. Enter the host name, port, username and password of the Configuration Server.
4. Select the Application object that you created in Genesys Administrator.
5. Select the license options:

* License Manager--Enter the port and name for the license server.

e License File--Use the Browse button to locate the license file.

6. To select the destination directory, either click Next to accept the default (displayed) or click Browse to
locate another directory.

7. Click Install to start the installation.
On Windows operating systems, all servers are installed as services. Therefore, during installation, you
will not be asked whether you want to install OCS as a Windows service. See Using Windows Services,
for more information.

8. Click Finish to complete the installation.

End

Tip
To maximize OCS performance, Genesys recommends that you set the power profile
of your Windows operating system to High Performance.

Installing CPD Server on Microsoft Windows 2003 or 2008

CPD Server is an optional application.

e |t is not advisable to mix board technologies.

* Do not use different protocols (such as ISDN and
Melcas) in one box.

e The CPD Server Installation Wizard may not
recognize that the Dialogic drivers had been
already installed if its version is different from
the version of the drivers that are packaged on
the Genesys CPD Server CD.

Notes:

e CPD Server supports only the Dialogic drivers
(for Service Release 6) that are provided on the
CPD Server CD.
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Start
1. From the product CD, open the following folder:
solution _specific\cpd server\windows and run setup.exe

2. As the Maintenance Setup Type, select either Install new instance of the application or
Maintenance of the existing installation.

3. Select Call Progress Detection Server as the component to install.

4. If you are setting up client-side port configuration for the initial connection to Configuration Server,
select the Use Client Side Port check box and then specify the following parameters:

* Port--Enter the port number for the client, as preconfigured on your firewall. (This is not the
Listening port of the CPD Server application.)

e IP Address--Enter the IP Address of the computer on which you are installing and running the CPD
Server application.

After selecting this option, the installation
process will add the necessary command line
Note: arguments (-transport-address and
-transport-port) for connecting to
Configuration Server at the application startup.

5. Enter the host name, port, username, and password of Configuration Server.
6. Select the license options:
e License Manager--Enter the port and name for the license server.

e License File--Use the Browse button to locate the license file.

7. To select the destination directory, either click Next to accept the default (displayed) or click Browse to
locate another directory.

8. Click Install to start the installation.
On Windows operating systems, all servers are installed as services. Therefore, you will not be asked
whether you want to install CPD Server as a Windows service. For more information, see Using Windows

Services.

9. Click Finish to complete the installation.

End

Installing CPD Proxy Server on Microsoft Windows 2003 or 2008

CPD Proxy Server is an optional application. CPD Proxy installation does not require Dialogic hardware
to be installed on the target computer. Start

1. From the product CD, open the following folder:
solution specific\cpd server\windows

2. As the Maintenance Setup Type, select either Install new instance of the application or
Maintenance of the existing installation.

3. Select Call Progress Detection Proxy as the component to install.

4. If you are setting up client-side port configuration for the initial connection to Configuration Server,
select the Use Client Side Port check box and then specify the following parameters:
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* Port--Enter the port number for the client, as preconfigured on your firewall. (This is not the
Listening port of the CPD Proxy Server application.)

 IP Address--Enter the IP Address of the computer on which you are installing and running the CPD
Proxy Server application.

After selecting this option, the installation
process will add the necessary command line
Note: arguments (-transport-address and
-transport-port) for connecting to
Configuration Server at the application startup.

5. Enter the host name, port, username, and password of the Configuration Server.
6. Select the Application object that you created in Genesys Administrator.

7. To select the destination directory, either click Next to accept the default (displayed) or click Browse to
locate another directory.

8. Click Install to start the installation.

On Windows operating systems, all servers are installed as services.
Therefore, during installation, you will not be asked whether you want to
install CPD Proxy Server as a Windows service. See Using Windows Services
for more information.

9. Click Finish to complete the installation.

End

Real-Time and Historical Reporting
The Reporting Technical Reference Guide describes the Reporting templates.
For information about importing templates, refer to the following resources:

e Reporting 7.5 CCPulse+ Help, "Using the Import/Export Utility"
* Reporting 7.2 Data Modeling Assistant Help, "Importing and Exporting Templates"

For information about actions the user should take if the CCPulse+ Import/Export Utility is disabled,
refer to the Reporting 7.5 CCPulse+ Administrator's Guide.

Using Windows Services

An application that is set up as a Windows Service starts automatically when the computer is started
and runs in the background, without a console window.

Stopping or Modifying the Startup Type for an Application Running as a Windows
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Service
Start

1. On the Windows taskbar, click Start and then select Control Panel > Administrative Tools >
Services.

. Double-click the application to open its Property dialog box window.

2
3. Under Service Status, click the appropriate button to change the operational status of the service.
4. From the Startup type drop-down list, select the desired startup type.

5. Click Apply.

End
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Installing on UNIX

The only Outbound Contact component that can be installed on a UNIX operating system is Outbound
Contact Server.

Installing OCS on UNIX

Start

1.

8.
9.
10.
11.
12.

On the Outbound Contact 8.1 CD, locate the directory for your UNIX vendor:
solution_specific/outbound contact server/<UNIX directory>

. Copy the directory into a temporary directory.

. In the temporary directory, locate the install.sh shell script.

Note: All files require permission to execute.

. Run the script by executing the following command: sh install.sh

. Type the host name of the computer on which Outbound Configuration Server will be installed, or press

Enter to accept the default.

. When/if prompted, enter the host, network port, user name, and password of Configuration Server.

. When prompted, specify whether you want to use the Client Side Port option. Then specify the following

parameters:
e Port--Enter any free port number. (This is not the Listening port of the OCS application.)

 IP Address--Enter the IP Address of the computer on which you are installing and running the OCS
application. (The installation script will propose an IP Address for you to use.)

After selecting this option, the installation
process will add the necessary command line
Note: arguments (-transport-address and
-transport-port) for connecting to
Configuration Server at the application startup.

From the list of applications configured for this host, select a specific OCS application.
Select the destination directory into which OCS will be installed.

When prompted, enter either 32 or 64 to specify the version that will be used.

Enter the full path to the license file.

After the installation process is complete, a message appears, indicating that the installation was
successful.

End

Next Steps

e Set the Environment Variable for the xerces-c shared library.

Outbound Contact Deployment Guide 159



Manually Configure and Install Outbound Applications Installing on UNIX

Setting the Environment Variable for the xerces-c Shared Library

Purpose

¢ OCS on UNIX uses the xerces-c shared library. This library is copied to the same directory as the OCS

executable by the installation program. Before OCS can be successfully started, you must provision the
path to this library in your UNIX system.

Start

1. Review the following table to locate the name of the Environment Variable to be used with your
operating system.

Environment Variables

Operating System Environment Variable Name
AIX LIBPATH

HP-UX 32-bit SHLIB_PATH

HP-UX 64-bit LD_LIBRARY_PATH
Linux LD_LIBRARY_PATH
Solaris 32-bit LD_LIBRARY_PATH
Solaris 64-bit LD_LIBRARY_PATH_64

2. Set the Environment Variable.
The following examples show how to set the Environment Variable if you are using C-Shell on Linux:

e setenv LD LIBRARY PATH /home/0CS:$LD LIBRARY PATH
* setenv LD LIBRARY PATH .:$LD LIBRARY PATH

3. If you use LCA and Solution Control Server to start OCS, you can use the following approach:

a. After you install OCS, replace the Command Line property on the Start Info tab of the OCS
Application object with the env UNIX command.

b. At the beginning of Command Line Arguments field, insert the following string (see the table above
for the correct Environment Variable name) followed by the executable file:
<Environment Variable Name>=<value>

The rest of the line should remain as it was set up during installation.
Example 1:

e Working Directory: /home/0CS

« Command Line: env

e Command Line Arguments: LD LIBRARY PATH=.:$LD LIBRARY PATH ./cmserver -host
HostName -port 8100 -app "OCS Name" -1 "LicensePort@LicenceHost"

Example 2:

 Command Line Arguments: LD LIBRARY PATH=/home/0CS:$LD LIBRARY PATH ./cmserver
-host HostName -port 8100 -app "OCS Name" -1 "LicensePort@LicenceHost"

End
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Qutbound Solution Wizard

This topic explains how to use the Outbound Solution Wizard, also known as the Outbound Contact
Configuration Wizard.

Genesys recommends that you use Genesys
Administrator instead of the Outbound Contact
Configuration Wizard for configuring your
enterprise, because much of the wizard
functionality is integrated into Genesys

Note: Administrator.

Warning: This Wizard was not updated for release 8.1. The
Outbound Contact Configuration Wizard 7.5 is included in the
Outbound Contact 8.1 package.

This Wizard creates a standard configuration of the Outbound Contact components (Outbound
Contact Server, Outbound Contact Manager, and Call Progress Detection Server). The wizard creates
all mandatory options with their default values. You can easily redefine these default values based on
the specific needs of your contact center.

The Wizard also provides a method for setting up the Dialogic board channels (ports) for CPD Server.

Use this Wizard for standard configurations only,
instead of for complex configurations (for example,
in an environment that has two Dialogic boards for
the same CPD Server or when configuring two or
more DNs on a switch that has the same dtiB
number).

Note:

Before You Begin

First, complete the Framework installation and configuration. Be sure to refer to the Worksheet
Definitions. New changes for the Outbound Configuration Wizard include:

¢ Introduces new component definitions in the Solution object for the GVP OBN Manager and
Interaction Server applications.

e Supports the Campaign Group object. The CampaignGroupInfo object is no longer supported.

¢ Dynamically adds new components in the Solution object.

e Supports the HMP configuration in the CPD Server Wizard.

Only one instance of CPD Server using HMP

Note: .
software can be executed on a host machine.
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Creating an Outbound Solution

As mentioned, the Outbound Solution Wizard enables you to create an Outbound solution. The wizard
is accessible through the Genesys Wizard Manager.

Using the Outbound Solution Wizard to create a solution
Start

1. Insert the Genesys 8.1 Outbound CD.

2. In the root directory, double-click setup.exe to install the Outbound Contact Configuration Wizard.
3. Open the Genesys Wizard Manager.
4

. On the left pane of the Genesys Wizard window, select Outbound Contact.
The Genesys Wizard Manager displays existing solutions, if any, and a prompt to deploy a new
Outbound Contact Solution.

5. Create an Outbound Contact Solution or reconfigure an existing one:

* To create a new Outbound Contact Solution, click Qutbound Contact on the right pane of the
Genesys Wizard Manager page.
The Outbound Solution Wizard launches and leads you through the process of creating a new
Outbound Contact Solution. Skip the remaining steps of this procedure.

* To reconfigure an existing Outbound Contact Solution object, click the object name on the right pane
of the Genesys Wizard Manager page.
The Properties dialog box opens for the Outbound Contact Solution object. Proceed to Step 6.

Complete Steps 6 through 10 only if you are
Note: reconfiguring an existing Outbound Contact
Solution object.

6. Click the Components tab and select a specific component.
7. Click Properties.

8. Click More.
The Properties dialog box opens for the component that you selected in Step 7.

9. Change the configurations, as needed.
For full explanations of the options in this dialog box, see Outbound Contact Configuration Options. Also
refer to the information in your Sample Planning Worksheet.

10. Click Apply.

End

Recommended Configuration for CPD Server

The Wizard will not allow you to create an incomplete configuration. If you abort the configuration,
the Wizard removes the incomplete configuration.
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Resources Configuration Activity

The Wizard implements a list of supported board types for selection. As more than one board may be
installed, the Wizard allows selection of a few boards for configuration, instead of one-by-one
configuration. When configuring a virtual board, the Wizard assigns a DN to every channel of the
board. The Wizard assigns the DNs in sequence, one by one. The following figure illustrates the
recommended configuration process for the CPD Server Application object.
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Recommended Configuration for CPD Server
Application Object

¢ Do not mix different board technologies.

e Do not use different protocols (such as ISDN and
Melcas) in one box.

e The CPD Server Installation Wizard will not
recognize that the Dialogic drivers had been
Notes: already installed if its version is different from
the version of the drivers that are packaged on
the Genesys Dialogic CD included with
Outbound Contact.

e The CPD Server Installation Wizard will not
create the Dialogic DN configuration if you do
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not create a CPD Server application.

e CPD Server supports only the Dialogic drivers
(for Service Release 6) that are provided on the
Dialogic CD included with Outbound Contact.

Deleting a previously configured Dialogic board

If you are creating a new configuration, you must first delete the previously configured Dialogic
boards.

Start

To delete a previously configured board:

1. When the Wizard displays a list of configured boards, select the boards you want to delete.

2. If a board is associated with a CPD Server application, then the Wizard will warn you and ask for a
confirmation.

If the Wizard receives a confirmation, it clears the value of the location option in all applications that
match the board name.

End

CPD Server Application Sections and Options

For information about the sections referenced in CPD Server Options.
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Silent Setup

InstallShield Silent allows for an automated electronic software distribution, also known as a Silent
Setup. InstallShield Silent only works on Windows operating systems. With InstallShield Silent, you do
not have to monitor the setup or provide input via dialog boxes. Once this information is stored in a
response file, an InstallShield Silent setup runs on its own, without any intervention by the end-user.
An installation procedure for a server application differs slightly from an installation procedure for a
GUI application. Both, however, require that you create a response file with the necessary
parameters and then use it for the actual installation. Outbound Contact Manager supports Silent
Setup installation.

Genesys Administrator also supports silent

Note: installation.

Creating the Response File

To select setup options and automatically record the InstallShield Silent response file, run your setup
with the following command line:

setup -r

Your responses to the dialog boxes are recorded and used to create a response file. By default, the
response file is named Setup.iss, and is stored in the Windows directory of your computer. To
specify a different directory or file name for the response file, add /f1--[full path to iss
file\]<FileName.3E" to the setup command. Include the double quotes and do not put a space
between /f1 and the path.19for example:

setup --r /fl--C:\GCTI\silent response files\mySetup.iss--
In the optional argument, the /f1 portion uses the numeral one (1), not the letter 1.

Subsequently, use the response file any time you need to install an application with the configured
parameters.

Sample Response File (setup.iss)

[InstallShield Silent]

Version=v7.00

File=Response File

[File Transfer]

OverwrittenReadOnly=NoToAll
[{C660F232-38A4-45AF-AEQ8-A332091BDC91}-DlgOrder]
D1g0={C660F232-38A4-45AF -AE08-A332091BDC91}-gctiGdWelcome-0
Count=4
D1g1l={C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdAskPath-0
D1g2={C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdReadyToInstall-0
D1g3={C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdFinish-0
[{C660F232-38A4-45AF-AE08-A332091BDC91} -gctiGdWelcome-0]
Direction=1

Outbound Contact Deployment Guide 165



Silent Setup Installing on UNIX

[{C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdAskPath-0]
Direction=1

Path=C:\Program Files\GCTI\Outbound Contact Manager
[{C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdReadyToInstall-0]
Direction=1
[{C660F232-38A4-45AF-AE08-A332091BDC91}-gctiGdFinish-0]
Reboot=0

[{45805BA8-94DF-4C49-A49E-9CC2179FDB8D}-D1lgOrder]

Count=0

The response file contains saved information about the number of dialog boxes displayed, the order

in which the dialog boxes were displayed, the values of any data entered or selected by the end user,
and which button the user clicked to close the dialog box.

Running the Silent Installation

Launch the InstallShield Silent Installation with this command line:
Setup.exe -s /fl--<full path to Setup.iss>-- /f2--<full path to setup log file>--

Where:
<full path to Setup.iss>

The full path to the Setup.iss file put within double quotation marks. For example:
c:\windows\setup.iss.

By default, Setup.exe looks for a response file called Setup.iss in the same directory as Setup.exe.
<full path to setup log file>

The full path to the setup log file put within double quotation marks. For example: c:\windows\
setup.log

By default, setup.log generated in the same directory as the response file being used.

A silent installation program does not display a dialog if an error occurs. The status information for
the silent installation is recorded (by default) in a file called setup.log.

Do not enter a space between the f1 or 2

MBI parameter and its value in double quotation marks.

The log file generated as a result of the Silent Setup procedure is described in the following section.

About the Silent Setup Log File

InstallShield Silent prints installation results into a Setup. log file. The default name for the silent
setup log file is Setup.log, and its default location is the same folder as Setup.iss. You can specify
a different name and location for your setup log file using the 2 switch when launching Setup.exe.
The Setup. log file contains three sections:
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* In the first section, the first entry, [InstallShield Silent], identifies the version of InstallShield
Silent used in the silent setup. The second entry identifies the file as a log file.

e Entries in the second section, [Application], identify the installed application's name and version and
the company name.

e The third section, [ResponseResult], contains the result code indicating whether the silent setup has
succeeded. The following table describes the integer return values that is assigned to the ResultCode

key name.
Silent Setup Result Codes
Result Code Description
0 Success
1 General error
2 Invalid mode
3 Required data not found in the Setup.iss file
4 Not enough memory
5 File does not exist
6 Cannot write to the response file
7 Unable to write to the uninstallation log file
8 Invalid path to the InstallShield Silent response file
9 Not a valid list type (string or number)
10 Data type is invalid
11 Unknown error during setup
12 Dialog boxes are out of order.
51 Cannot create the specified folder
52 Cannot access the specified file or folder
53 Invalid option selected

Sample Setup Log File
An example of a Setup.log file is as follows:

[InstallShield Silent]
Version=v8.100.00

File=Log File

[Application]

Name=Genesys Outbound Contact Manager
Version=7.6

Company=GCTI

Lang=0009

[ResponseResult]

ResultCode=0
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Manually Define Outbound Configuration
Objects/Table Access Object

These topics explain how to create and configure each of the Outbound-related objects in Genesys
Administrator:

* Overview

¢ QOutbound-Specific Configuration of Objects

* Table Access Object

¢ Field Object

¢ Format Object

* Calling List Object

¢ Filter Object

e Time Zones

* Treatment Object

¢ Campaign Object

¢ Campaign Group Object

e Qutbound Schedule Object

¢ You can also use Configuration Manager or Genesys Administrator to configure these
objects.

e Because the Dependencies and Permissions tabs for these configuration objects do not
contain any information that is specific to Outbound Contact, they are not described in
this chapter. For information about these tabs, see Framework Genesys Administrator
Help.
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Overview

After you configure and install the component applications for Outbound Contact, you configure
additional objects in Genesys Administrator to support and run dialing sessions for campaigns.

The following Framework objects should already exist before you create the Outbound-specific

objects: Tenants, Persons, and telephony configuration objects (Switches, Agent Logins, DNs),
Places, Place Groups and/or Agent Groups.

Outbound Object-Creation Sequence

Genesys recommends that you create the Outbound-specific objects in the following order:

1. Fields. Create user-defined fields (if necessary) before you create the Format object that will contain
them.

2. Format. Create a Format before you create the Table Access Point object to which it will be applied.

w

Table Access Point. Create the Table Access Point before your create the Calling List object to
which it will be applied.

Filters.
Treatments.
Calling Lists.

Campaigns.

@ N o v e

Campaign Groups.

Permissions in Campaign-Related Objects

For users to run or change a dialing session for an outbound campaign, they must be assigned to an
Access Group object that has special access privileges to all campaign-related configuration objects.
Special access is the default value.

Verifying or Changing Permissions for an Access Group Object

Start

1. Open each campaign-related object.
2. Select the Permissions tab.

3. Make the necessary changes.

For more information about setting permissions, see Framework Genesys Administrator Help.
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End
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Outbound-Specific Configuration of Objects

The following objects require specific configurations for Outbound Contact:

e Special DNs
e Place Groups or Agent Groups

¢ Places

This section discusses the configuration of each of these objects in turn.

Special DNs

The DNs that require Outbound-specific configurations include Communication DNs and Overflow
DNs.

Communication DN

Outbound Contact reports on outbound activity through a DN set up as a Communication DN. This
type of DN enables communication between Outbound Contact Server (OCS) and Stat Server (which
determines what agents are assigned to which Agent or Place Groups, identifies the current Agent
State, and provides the statistics for Outbound real-time and historical reporting). This DN type also
enables communication between OCS and other parties, using a Communication DN API. It is a virtual
DN, meaning that it does not exist in a switch. The name of this DN type can be either text or
numeric.

Creating a Communication DN

Start

1. Open the Switch object and select the DNs tab.
2. Click New.
3. On the Configuration tab of the DN, define the fields as follows:

* Name

e Required; default value is [DN]. Specifies the name of the DN. The name that you enter must be unique
within the tenant and it must not match any actual directory number in the switch.

* Type

¢ Required; default value is [Unknown DN Typel]. Specifies the type of DN. Select the Communication DN
type from the drop-down menu.

¢ On the Options tab, create a default section.

¢ In the default section, create an outbound contact server option by entering the Option Name and
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Option Value in the Edit Option dialog boxes.

Click Save and Close.

End

Overflow DN

A predictive campaign sometimes overdials and, as a result, has outbound calls waiting in the queue.
Some contact centers define (by using Virtual DN or routing strategy) business rules to send these
outbound calls to another queue. This other queue is commonly known as an overflow queue. There
are two types of overflow DNs:

e ACD Queue or Routing Point; used to mark the record as dropped.

e Extension or ACD Position; used to send RequestReleaseCall to T-Server.

Designating an Overflow DN

* To designate an existing DN as an Overflow DN, you must configure an overflow _dn option on the
Options tab of a particular DN object.

Start

1. On the Switching tab, select Switches > DNs > <specific DN>.
2. On the Options tab, create a section that is named default.
3. Create the overflow dn option with a value of true.
4. After you configure the overflow dn option--depending on your overflow DN type--do the following:
* Fora ACD Position or Extension type DN, create a Place and add this overflow DN into this Place.

e For an ACD Queue or Routing Point type DN, add your overflow DN to the list of origination DNs of
the group(s) that will be used when you run your dialing session for campaigns.

End

Agent and Place Group Objects

Agents, Places, and Agent/Place Groups are configured in Framework; however, Agent Groups and
Place Groups still need to be configured specifically for Outbound Contact. The following sections
pertain to these Outbound-specific configurations.

Agent or Place Group Object--Advanced Tab Fields

An Agent/Place Group object needs at least one DN (directory number) associated with it in an
Origination DN list (see Origination DNs). An ACD (automatic call distribution) queue is a required DN
for an Agent/Place Group. Other DN(s) in the list could be VQ (virtual queue) or Routing Point.
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Outbound Contact Server (OCS) monitors queues to determine how to pace outbound calls and to
determine which group an agent logs into for a particular campaign. OCS monitors the telephony
events EventQueued, EventDiverted, and EventAbandoned to determine the number of calls that
are waiting in the queue. Stat Server notifies OCS about agent logins, that provides information about
which queue or group an agent exists.

As of OCS version 7.6.101.18, OCS no longer
considers the number of inbound calls in a queue
when it calculates the outbound dialing pace in the
Progressive with seizing and the Predictive
with seizing dialing modes for the Small Group
and Advanced Small Group predictive algorithms.

Note:

Origination DNs

Found in Genesys Administrator: Agent/Place Group object > Configuration tab, Advanced section,
Origination DNs.

The primary role of an Origination DN is for OCS to monitor it for EventQueued and EventDiverted so
that calls can be properly tracked as they are dialed and moved to agents (or Abandoned). For this
reason, if a Route Point is used, it may be necessary to use a Virtual Queue also if the Route Point on
the T-Server does not support the correct events.

The origination DNs can be of the following types:

¢ ACD Queue
¢ Routing Point
e Virtual Queue
e Service Number
Any DN of these types will be registered in the relevant T-Server on start up or when they are added

to the Origination DN (if OCS is already started). OCS will not allow a dialing session/campaign group
to be loaded unless the Origination DNs for a Campaign Group are monitored.

Agents log into an ACD queue that has a DN number. OCS recognizes that DN as an identifier for an
Agent/Place Group and might use that DN as the point of origin for Outbound calls. OCS might use an
alternate DN (for instance, a Routing Point) as the point of origin for Outbound calls.

Do not share DNs in the Origination DNs List
among Agent/Place Groups. Assign each Agent/
Note: Place Group to a unique Origination DN.The pacing
of outbound calls in the Predictive dialing mode can
cause unpredictable results if DNs are shared.

Adding DN(s) to the Origination DNs List
Start

1. In Place Group (on the Provisioning tab > Switching) or Agent Group object (on the Provisioning
tab > Accounts) > Configuration tab > Advanced/Origination DNs section, click Add.
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2. Select (that is, highlight) the DN(s).
3. Click OK in the DN dialog box.
4. Click Save and Close.

End

Place Object

Telesets are assigned to Place objects. A Place might contain more than one DN. Prepare an actual
layout of the numbering plan to configure the Places and assign DNs to them.

OCS works only with DNs that are assigned to places. Genesys recommends that you do not assign
more than two DNs (Extension and ACD Position) to one place and that you do not assign DNs from
several switches to one place.

Beginning with release 7.6, OCS does not take into
consideration or monitor the configuration state
(State Enabled or State Disabled) of the DNs
included in Places where agents log in to both an
Agent Group and a Place Group that are used for a

Note: campaign. OCS considers an agent valid and
available if the Place and Person configuration
objects indicate State Enabled. In release 7.5, OCS
checked the state of the first DN only in the DNs
list configured for the Place where an agent logged
in.
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Table Access Object

A Table Access object defines the relationships among calling list(s), formats, and the database.
This object points to a database table of a specified format by providing a Database Access Point.

You cannot delete a Table Access object as long

MO as it is associated with at least one calling list.

Creating a New Table Access Object

Start

1. In Genesys Administrator, go to Provisioning > Outbound Contact > Table Access.
2. Click New.

3. On the Configuration tab, define the fields as described in the following subsection.
4

. Click Save and Close.

End

Table Access Object--Configuration Tab Fields
Name

Required; the default value is [Table Access]. Specifies the name of the Table Access object. The
name that you enter must be unique within the tenant.

You can define the Table Access names for calling
Note: lists but the Table Access object for the Do Not
Call table has a gsw_donotcall list fixed name.

Table Type

Required; the default value is [Unknown Table Type]. Specifies the type of Table Access in the
database. Select either Calling List or Log Table for the Do Not Call list.

After you define and save the table type for a
Table Access object, you cannot change it.

Note:
Description
Optional; the default value is [Blank]. A brief description of the Table Access object.

DB Access Point

Required; the default value is [None]. Specifies the Database Access Point through which the table
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is accessed. Enter a value by locating an existing Database Access Point object.
Format

Required; the default value is [None]. Specifies the name of the format to be applied to the table.
Enter a value by locating an existing Format object.

After you define and save the format, you cannot
change it. The Do Not Call table has a fixed
structure, and therefore, it does not require format
or field configurations.

Note:

Database Table
Required; the default value is [Blank]. Specifies the name of the table in the database.

The name of table must conform to SQL language
Note: rules, which may vary for each supported database
management system (DBMS).

State Enabled
Required; by default, this checkbox is selected. Indicates whether a check box that indicates a

customer interaction can be directed to this target. For a more complete description of this check
box, see Framework Genesys Administrator Help.
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Fleld Object

The Field object defines a field in a Calling List database table. Fields are single pieces of data (for
example, a telephone number) within a record.

There are two types of fields in a calling list:
* Genesys mandatory fields--These fields must exist in all Calling List tables. See "ldentifying Mandatory
Fields" in the "Formats" topic in Framework Genesys Administrator Help (Provisioning Your

Environment < Outbound Contact Objects > Formats). This topic contains a list of mandatory fields
and associated data types, as well as a short description for each field.

¢ User-defined fields--These custom fields contain business-related data.

Creating a New Field Object

Start

. In Genesys Administrator, go to Provisioning > Outbound Contact > Fields.

. Click New.

1
2
3. On the Configuration tab, define the fields as described in the following subsection.
4. On the Options tab, define option(s) in the default section.

5

. Click Save and Close.

End

Field Object--Configuration Tab Fields

Name
Required; the default value is [Field]. The field name is the name of the column in the database
table. This value must be unique within the tenant. Depending on the database management system

(DBMS), the field name in this object has to conform to the same rules as the field's name in the
database table.

Tenant
Automatically populated by the system.
Data Type

Required; the default value is [Unknown Data Type]. You must select a value other than default for
this object. The type of data stored in this field corresponds to a data type supported by the relational
database management system.

The Campaign Data Type Values table provides information on data type values. The DATETIME
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Field Object

formats table provides information on DATETIME formats.

Data Type Value

char

datetime

float

int2

varchar

[Unknown Data Type]

Campaign Data Type Values

Description

Character string with a fixed length

Date and timel Data for the DATETIME field type is
presented in the specific format of the Calling List
when it is populated. This format is database
dependent.

Real number

Integer; the maximum value for this field with this
data type that OCS can handle is 4294967295,

which is 232-1.
String of variable length
Default value. You must change this default value

and replace it with another value from this table.
DATETIME formats

Data type for Date/Time User

DBMS Required Format Example

Field

MSSQL DATETIME YYYY.MM.DD hh:mm:ss  2003.04.15 11:32:56

Sybase DATETIME YYYY.MM.DD hh:mm:ss  2003.04.15 11:32:56
MM/DD/YYYY .

Oracle DATE HH24: M55 /15/2003 23:32:56

. DATETIME YEAR TO - .

Informix SECOND YYYY-MM-DD hh:mm:ss 2003-04-15 12:32:56

DB2 TIMESTAMP yyyy-mm-dd- 2003-04-15-12.32.56.123456
hh.mm.ss.nnnnnn

Description

Optional; the default value is [Blank]. A brief description of the field.
Length

Required for char and varchar data types only; not used for any other data types. The default value
is [0]. The length of the field in the database.

Field Type

Required; the default value is [Unknown Field Type]. You must select a different value than the
default for this object. Outbound business-specific information is stored in this field. The Field Type
Values table provides information on field type values.
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Field Type Value

Agent

Application
Call Time

Campaign

Chain

Contact Info

Contact Info Type
Dialing Result
From

Group

Number in Chain

Number of Attempts
Record ID
Record Status

Record Type

Scheduled Time
Switch ID

Time Zone
To

Treatments History
User-Defined Field

[Unknown Field Typel

Field Type Values

Description

Login ID of the last agent who handled an
outbound call associated with this record.

Unique Application identifier (DBID).
Time of the actual dialing attempt.

Campaign database identification number (DBID)
with which this record is associated.

ID of records that are linked in a chain. All records
associated with one customer account have the
same chainlD.

Important: When OCS retrieves a record from a database, it
converts a string with a chain_id value to an integer value. The
maximum integer value that OCS supports is 2,147,483,647.

Contact telephone number (home, work, cell) or e-
mail address. Contact Infoin 7.1 was Phone
Number in 6.5.1.

Type of contact information, such as telephone or
e-mail address. Contact Info Typein 7.1 was
Phone Typein 6.5.1.

Result of a dialed call.
Earliest time after midnight to dial a call.

Unique Agent Group or Place Group identifier
(DBID).

Priority assigned to a given record in the chain. The
smallest number is processed first.

Number of dialing attempts.
Unique ID number for the current record.
Status of the record.

Type of record, such as General, Scheduled,
Personal CallBack, NoCall

Time at which scheduled call should be dialed
Unique Switch identifier (DBID).

Time-zone database identification number (DBID)
of the record.

Latest time after midnight to dial a call.

History of applied treatments for the given chain
(see the treatment sched threshold option).

An optional field that contains custom business
data.

Default value. You must replace this value with
another value from this table.
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Default Value

Optional; the default value is [Blank]. The default value for the field. All formats that include the
field will use this default value. The value should be consistent with the data type of the field. For
example, if the data type is integer, the default value should be an integer value only. When
Genesys Administrator imports records from an ASCII file in which a field is missing or has no value,
Genesys Administrator populates the field with this default value--if the nullable checkbox is not
selected. If the field is nullable, Genesys Administrator accepts a blank value. See also Framework
Genesys Administrator Help (Provisioning Your Environment > Qutbound Contact Objects >
Calling Lists > Overview).

Primary Key

Optional; the default is unchecked. The checkbox indicates whether the field is a primary key in a
database table. In Outbound Contact, the only primary key fields are chain_id and chain_n. For
more information about these fields, see Framework Genesys Administrator Help.

Unique

Optional; the default is unchecked. The checkbox indicates whether the field value is unique within
the table.

Nullable
Optional; default is unchecked. The checkbox indicates whether the field value can be set to NULL.
State Enabled

Required; default is checked. Unchecking this checkbox disables the entire format object. Do not
change the default.

Editing Fields in the Field Object

Default and Description are the only fields in the Field object that you can edit after you save the
object. To modify the Default and Description of a field, double-click the Field object. A field cannot
be deleted as long as it is associated with at least one format. Field objects are closely related to
Format, Table Access, and Calling List objects. Refer to Calling List Objects and Format Objects for
more information.
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Format Object

Format objects contain fields that form a structure for a database table. Outbound Contact provides
two default Format objects: Default Outbound 6 (for backward compatibility) and
Default Outbound 70. By default, both of these objects contain Genesys mandatory fields only.

Creating a New Format Object

Start

In Genesys Administrator, go to Provisioning > Outbound Contact > Formats.
Click New.
On the Configuration tab, define the fields, as in the following subsection.

On the Options tab, define option(s) in the default section.

u A W N

Click Save and Close.

End

Format Object--Configuration Tab Fields
Name

Required; the default is value [Format]. The name must be unique within the tenant. When the name
is specified, it cannot be changed.

Tenant

Automatically populated by the system.

Description

Optional; the default value is [Blank]. A brief description of the named format.
State Enabled

Required; default is checked. A check box that indicates a customer interaction can be directed to
this target. A more complete description can be found in Framework Genesys Administrator Help.

Populating Format with Fields

¢ To populate a newly created Format object (currently empty) and with fields (all mandatory and perhaps
some custom fields).

Start
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After creating and saving a Format object, in the Details panel, double-click the format.
In the Navigation panel, click the Fields tab.

In the Details panel, click Add.

A W N -

From the Field dialog box, select one or more fields that you want to include in the Format object.

These fields were created by default as part of
Note: the Default Outbound 6 and
Default Outbound 70 formats.

5. To customize this format with user-defined field(s), in the Field dialog box, click New.
6. Define the field(s) following the procedures in the section Creating a New Field Object.
Do not remove mandatory fields.
Warning: You cannot delete a format if it is associated with a
Note: Table Access object or Filter object. You cannot modify
existing fields after you associate the format with a Table
Access object.

7. Click OK in the Field dialog box.
8. Click Save and Close.

End
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Calling List Object

Calling Lists are tables that contain customer contact information, including telephone numbers to be
called during an outbound campaign. Calling Lists are also configuration objects in Genesys
Administrator. Define a Calling List object after you have created the Format and Table Access
objects. If you need user-defined fields in your Calling List, create those fields and add them to the
Format object before you create the Table Access object. When a format is associated with a Table
Access object, you cannot add or delete fields in that format. You can create Filter and Treatment
objects before, while, or after you define the Calling List object and add or remove these objects
at any time.

Only calling lists based on a 7.1 or higher format
can be migrated to Outbound Contact 8.x.

Warning: Calling lists that are associated with formats that do
not contain the switch id, group_ id, and treatments fields
Note: (such as those from version 7.0 or earlier), or that contain the
phone and phone_type fields instead of the contact info and
contact info type fields (respectively) must be migrated to
Outbound Contact solution 7.1 first, and then migrated to
release 8.x. See the Genesys Migration Guide for more details.

Create the Calling List object before the Calling List table exists in the relational database. This
approach enables Genesys Administrator to create the Calling List table according to the properties
of the Calling List configuration object. If the table does not exist yet, OCM displays this message The
table [table name] does not exist. Create it? Click Yes to create the Calling List table.

If the Calling List table already exists in the database, the properties of the Calling List object must
exactly match the structure of the table (as defined by its Format and Table Access objects) in the
database.

Creating a New Calling List Object
Start

1. In Genesys Administrator, select Provisioning > Outbound Contact > Calling List.
2. In the Details pane, click New.

3. Define the field values in the associated tabs, including the Configuration tab, the Options tab, the
Campaigns tab, the Format tab, and the Treatments tab.

For other tabs, see the Framework Genesys

Note: Administrator Help.

4. Click Save and Close.

End
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Calling List Object--Configuration Tab Fields

General Section

Name

Required; the default value is [Calling List]. The name of the calling list. This value must be
unique within the tenant.

Description

Optional; the default value is [Blank]. A brief description of the calling list.
Tenant

Automatically populated by the system.

State Enabled

Required; default is checked. A check box indicating that a customer interaction can be directed to
this target. You can find a more complete description in Framework Genesys Administrator Help.

Calling Time From

The default value is [8:00:00 AM]. Not used at the list level, at this time.
Calling Time To

The default value is [6:00:00 PM]. Not used at the list level, at this time.
Maximum Attempts

Required; the default value is [10]. The maximum number of attempts to call a single record in this
Calling List during one campaign. You cannot set this value to zero.

This parameter is taken into account by Outbound
Contact Server when applying treatments only. If

Note: the record is being processed again as a Personal
or Campaign Callback, this parameter is not used
by OCS.

Script

The Script Property in the Campaign, Calling List, and Campaign Group defines the Script object,
which contains all of the attributes that are required by Agent Scripting. For more information, see
the section, "Attaching Script Information to OCS User Events and Telephony Events", in the
Outbound Contact Reference Manual.
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For descriptions of the fields in the Data Base and
Note: Query sections of the Configuration tab, see
Framework Genesys Administrator Help.

Format

The Format for the Calling List.

Data Base and Query Sections/Calling List object

These entries are associated with using SQL queries to create a Calling List.
Table Name

The name of the table in the database.

Data Access Point

Required; the default value is [None]. Specifies the Database Access Point through which the table
is accessed. Enter a value by locating an existing Database Access Point object.

DB Server

Required; the default value is [None]. Specifies the name of the DB Server associated with the
database.

SQL Server

Required; the default value is [None]. Specifies the name of the SQL Server used for running the SQL
query.

Type

Required; the default value is [None]. Specifies the type of database: MSSQL, Informix, DB2, Oracle,
or Sybase.

DB Name

Required; the default value is [None]. Specifies the name of the database in which the table exists.
Login

Required; the default value is [None]. Specifies the login name for the database.

Password

Required; the default value is [None]. Specifies the password for the database.
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Case Conversion

Case conversion method for key names of key-value lists coming from DB Server. This value specifies
whether and how a client application converts the field names of a database table when it receives
data from DB Server. If you select upper, field names are converted into uppercase; if you select
lower, field names are converted into lowercase; and if you select any, field names are not converted.
This value corresponds to the dbcase option in a configuration file.

e This setting does not affect the values of key-
value lists coming from DB Server. That is,
actual data is presented exactly as it appears in

Notes: the database tables.

¢ Use the default value (any) unless directed to
do otherwise by Genesys Technical Support.

SELECT FROM

Required; the default value is [None]. Specifies the table name from which to select records for the
Calling List.

WHERE
Required; default value is [None]. Specifies the SQL query to identify the records.
ORDER BY

Required; the default value is [None]. Specifies how to order the records identified, based on the
query.

Calling List Advanced Entries

If you use the Calling List Advanced object instead of the Calling List object, you create lists based on
specified Table Access and Filter objects rather than a SQL query.

Table Access

Required; the default value is [None]. The Table Access object to which the Calling List refers. The
Table Access object defines the format of the Calling List and identifies the DB Access Point used to
access the Calling List table. Use the Browse button to locate an existing value.

Log Table Access
The default value is [None]. Not used at this time.
Filter

Optional; The default value is [None]. The filter to be applied to this calling list. A filter defines which
call records within the Calling List table will be dialed by the campaign.
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The Filter field becomes enabled only when the

MBI Table Access field is populated.

Calling List Object--Options Tab

Use this tab to define Outbound Calling List--related options.

Calling List Object--Campaigns Tab

This tab lists the Campaigns that include this Calling List.

Calling List Object--Format Tab

On the Calling List object only (not Calling List Advanced object), use this tab to add the fields that
define the Format for this calling list.

Calling List Object--Treatments Tab Fields
You can add an existing treatment to the Calling List by clicking the Add button and selecting an
available treatment. You can delete an applied treatment by selecting a displayed treatment and

clicking Remove. Click Save and Close to the changes. This tab displays the following information for
applied treatments.

Name
Name of applied treatment.
State

Indicates whether the Treatment is enabled or disabled. See Treatment Object for more information
about setting up treatments for unsuccessful calls.

Changing the Structure of a Calling List

The database administrator can make changes directly to the Calling List table using the database
management system (DBMS) tools; however, Genesys Administrator will no longer be able to access
this table. Genesys recommends that you create a new Calling List object, which will match the new
physical structure of the table, as described on Creating a New Calling List Object.

Fine-Tuning a Calling List

When Genesys Administrator creates a physical table for the Calling List, It also creates appropriate
indexes on the table; however, if the structures of the dialing filters require additional indexes, the
customer must create them. The customer also must perform tune-up procedures, such as updating
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index statistics and maintaining transaction logs. To assign a List Weight to a calling list, see List
Weight (in Configuration Manager); Share (in Genesys Administrator).

Record Cancellation Requests and Customer ID

In addition to making record cancellation requests according to the record handle and the phone
number, they can now be made according to the customer ID, which is currently leveraged by the Do
Not Call feature.

Both the Desktop protocol and the 3rd party protocol have been extended to include (optionally) the
GSW_CUSTOMER _1ID attribute in the RequestRecordCancel and the CM_ReqCancelRecord requests
respectively.

With this ability, record cancellation requests can identify sets of records not only by the record
handle and the telephone number, but also by the customer ID. If more than one record identifier is
included in the same request, the identifiers are prioritized as follows: record handle (highest),
telephone, and customer ID (lowest). OCS processes RequestRecordCancel by customer ID in the
same way that the other types of RequestRecordCancel are processed. The only difference is that
the records that are subject to cancellation are determined by the value of the customer ID field in
the Calling List table.

Configuring Objects to Identify Records by Customer ID for Record Cancellation
Requests

* To configure object to enable identification of record cancellation requests by customer ID.

If you have already use the Customer ID for Do Not
Note: Call requests, you do not need to configure
anything else.

Start

1. Create a new user-defined field object. On the Configuration tab, define the fields as follows:
* Name = <user-specific name>
e Data Type = varchar
* Length = 64
* Field Type = User-Defined
Also select the Nullable and State Enabled options.

2. On the Options tab for the Field object, assign the send _attribute to it by adding a default section.
On the Option tab, define the fields as follows:

* Option Name = send attribute

* Option Value =GSW CUSTOMER ID

3. Designate the new user-defined field as the customer_id option in the 0CS Application object.
In Genesys Administrator > Provisioning > Environment > Applications > Qutbound folder >
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0CS application > Options > 0CServer section, create and define the customer _id option. Use
the name of the new user-defined field as the value of customer_id.

e Option Name = customer_ id

e Option Value = <name of new user-defined field>

4. Add the new field (defined in Step 1) to a new Format object.
In Genesys Administrator > Provisioning > <Tenant> > Format object, create a new format for a
Calling List table that will include the new user-defined field.

5. Create a Calling List object with the new format. In Genesys Administrator > Provisioning >
<Tenant> > Calling Lists, configure a Calling List Advanced object with the following:
In the Configuration tab, specify the following:

e Table Access: <New Calling List>

This is a new Calling List, formatted with the customer id field.

End

Customized Stored Procedures for Calling List and Campaign
Objects

OCS uses stored procedures to get the values of different counters from the calling list database table
(for example, the number of retrieved records), and to enable end users to customize them by
defining or modifying the procedures code.

Customizing your stored procedures enables you to fine-tune a stored procedure for the following
purposes:

¢ To adjust statistical calculations for pre-defined statistical counters.

¢ To define up to five custom database-related counters.
Starting in release 8.1.2, you can develop your own customized stored procedures by completing the
following steps:

e Determine if the default procedure can be extended or should be completely rewritten.

¢ Create and debug code for the customized stored procedure, by using third-party DBMS tools.

e Store the body of the customized stored procedure in the Genesys configuration, by using Genesys
Administrator.

e Configure OCS to completely replace the standard procedure code (using the instead option) or extend
the code of the standard procedure with the customized procedure (using the before or after
options).

Although you are limited by the predefined names, and input and output parameters in the custom
procedure, there are no limitations within the body of the custom procedure.
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Configuring Custom Procedures

Custom procedures are configured in Genesys Administrator, in the Annex (Options) section of
Campaign and Calling List objects. The section hames for OCS options are standard and the calling
list level options take precedence over the Campaign level options.

Reporting procedures are defined by configuring this pair of options: report-procedure-body and
report-procedure-location.

Genesys Administrator has a simple, built-in text editor that enables you to define the body of the
customized procedure. After the code has been defined and the location object for the code
determined, Genesys Administrator stores the custom procedure code in the option value field as a
binary string.

Define custom procedures in Genesys Administrator by navigating to one of the following locations in
the interface:

e Provisioning > Outbound Contact > Campaigns > Campaign object name > Configuration tab
> Stored Procedures

e Provisioning > Outbound Contact > Calling Lists > Calling list object name >
Configuration > Stored Procedures

Custom Reporting Procedures

Each DBMS has its own requirements for stored procedures. The following table describes the
requirements for customization of stored reporting procedures for each DBMS, whether you are
adding custom counters to existing procedures, or creating completely new user-defined stored
procedures.

Customizing Reporting Procedures

If Using for Reporting Procedure, Use this Template
for Procedure Body

MS SQL, Sybase
CREATE PROCEDURE $sr proc_name(

If Using Before/After for Custom Counters

Use variables @CustomCounter®1Num - @CTime VARCHAR(20),
@CustomCounter05Num predefined as NUMERIC in @ReadyCount VARCHAR(20) OUTPUT,
procedure body for counters. Then use variables @RetrievedCount VARCHAR(20) OUTPUT,
@CustomCounter0l - @CustomCounter05 defined as @FinalCount VARCHAR(20) OUTPUT,
VARCHAR (20) to return values. @TotalCount VARCHAR(20) OUTPUT,
@TotalRecsCount VARCHAR(20) OUTPUT,
For example: @ReadyRecsCount VARCHAR(20) OUTPUT,
@CustomCounter®1l VARCHAR(20) OUTPUT,
SELECT @CustomCounter®1Num = (SELECT @CustomCounter02 VARCHAR(20) OUTPUT,
COUNT(distinct record id) FROM @CustomCounter03 VARCHAR(20) OUTPUT,
$list tbl name WHERE $dial filter where) @CustomCounter®4 VARCHAR(20) OUTPUT,
@CustomCounter05 VARCHAR(20) OUTPUT)
SELECT @CustomCounterQl = AS
CONVERT (VARCHAR(20) , BEGIN
ISNULL (@CustomCounter@1Num, 0)) -- TODO: Add custom code here
END
Oracle
Use variables v_CustomCounter01 - CREATE OR REPLACE PROCEDURE $sr proc_name(
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p_CTime VARCHAR2,
p_ReadyCount OUT VARCHAR2,

v_CustomCounter05 predefined as NUMBER in p_RetrievedCount OUT VARCHAR2,

procedure body for counters. Then use variables p_FinalCount OUT VARCHAR2,

p CustomCounter0l - p CustomCounter05 defined p TotalCount OUT VARCHAR2,

as VARCHAR? to return values. p_TotalRecsCount OUT VARCHAR2,
p_ReadyRecsCount OUT VARCHAR2,

For example: p_CustomCounter0l OUT VARCHAR2,

p_CustomCounter02 OUT VARCHARZ2,
SELECT COUNT(*) INTO v_CustomCounter®l FROM p CustomCounter®3 OUT VARCHAR2,

(select DISTINCT record id FROM p_CustomCounter@4 OUT VARCHAR2,
$list tbl name WHERE $dial filter where); p_CustomCounter05 OUT VARCHAR2)
AS
p_CustomCounter0l := BEGIN
TO CHAR(NVL(v_CustomCounter0l, 0)); -- TODO: Add custom code here
END;
END $sr proc name;
DB2

CREATE PROCEDURE $sr proc_name (
IN CTime INTEGER,

OUT ReadyCount CHAR(32),

OUT RetrievedCount CHAR(32),
OUT FinalCount CHAR(32),
OUT TotalCount CHAR(32),
OUT TotalRecsCount CHAR(32
OUT ReadyRecsCount CHAR(32
OUT CustomCounter0l CHAR(
OUT CustomCounter02 CHAR(
OUT CustomCounter03 CHAR(
OUT CustomCounter04 CHAR(
OUT CustomCounter05 CHAR(
LANGUAGE SQL

Use variables iCustomCountero01l -
iCustomCounter05 predefined as INTEGER in
procedure body for counters. Then use variables
CustomCounter01l - CustomCounter05 defined as
CHAR(32) to return values.

For example:

SELECT COUNT(DISTINCT record id) INTO
iCustomCounter@l FROM $list tbl name WHERE

)
)
2
2
2
sdial filter where; :

32),
3 )I
3 )I
32),
32))
SET CustomCounter0l=

- BEGIN

CHAR(VALUE (iCustomCounter0l, 0)); - TODO: Add custom code here

END

Informix

CREATE PROCEDURE $sr _proc_name(
Use variables v_CustomCounter01 - p CTime CHAR(32))
v_CustomCounter05 predefined as INT in the RETURNING INT, INT, INT, INT, INT, INT,
procedure body for counters. Procedure returns INT, INT, INT, INT, INT;
these variables in the RETURN statement. -- TODO: Add custom code here

RETURN v_ReadyCount, v _RetrievedCount,
For example: v_FinalCount, v TotalCount,

v_TotalRecsCount, v_ReadyRecsCount,
SELECT COUNT(DISTINCT record id) INTO v_CustomCounter0l, v_CustomCounter02,
v_CustomCounter®l FROM $list tbl name WHERE v CustomCounter03, v CustomCounter04,
$dial filter where; v_CustomCounter05;

END PROCEDURE

PostgreSQL

Use variables v_custom@l - CREATE OR REPLACE FUNCTION $sr _proc_name (
v_custom05 declared as INTEGER in procedure c_time numeric(18,0),
body for counters. Then use variables OUT p ReadyCount varchar(32),
p_CustomCounter@l - p CustomCounter05 OUT p RetrievedCount varchar(32),
declared as VARCHAR(32) to return values. OUT p FinalCount varchar(32),
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OUT p TotalCount varchar(32),

OUT p _TotalRecsCount varchar(32),
OUT p ReadyRecsCount varchar(32),
OUT p CustomCounter@l varchar(32),
OUT p_CustomCounter02 varchar(32),

For example: (
OUT p CustomCounter@3 varchar(32),
(
(

DIECGEATE W EUensomen, IiIEGER 6= G OUT p CustomCounter04 varchar(32),
SELECT COUNT(DISTINCT record id) INTO O 17 (CUSTEEEEUREeres) VErehe (2] )

. AS $%
v_custom@1l FROM $list tbl name WHERE - . .
(3dial filter where); TODO: Declare variables here

2 CUEIETIEBNI AN, B BE'(;(I)'I;IO Add custom code here
CAST (COALESCE(v_custom@l, 0) AS VARCHAR); RETURN:
END;

$$ LANGUAGE plpgsql;
Customized Stored Procedures Macro Expressions

To simplify the creation of customized procedures, OCS supports the use of macro expressions in
custom procedures. OCS substitutes this macro expression for the actual values when the SQL code
for the custom procedure is generated, depending on the calling list for which the code generation is
executed. By using macro expressions, OCS enables you to define a custom procedures template on
a Campaign level that can be generated for each calling list that is configured under the Campaign.
See the Macro Expressions for Custom Stored Procedures table for macro expressions for
custom stored procedures. Refer also to the OCS Supported Macro Expressions table that also
contains other macro expressions supported by OCS.

Macro Expressions for Custom Stored Procedures

Usage example in the custom procedure

Parameter name To be submitted for:
body

$list tbl name Name of the calling list table UPDATE $list_tbl_name SET

UPDATE $list tbl name SET
$dial filter where WHERE clause of the dialing filter ..." WHERE
$dial filter where

SELECT TOP 10 chain id FROM

ORDER BY clause of the dialing $list tbl name ORDER BY

$dial filter order by

filter $dial filter order by
$list dbid DBID of the Calling List
$camp_dbid DBID of the Campaign
$group_dbid DBID of the Group
. DBID of the Campaign Group
$camp _group dbid (session)

Monitoring Dynamic Modification to Custom Procedures

OCS monitors dynamic modifications to the dialing filter and recreates customized procedures if the
filter is updated, if the procedure contains the $dial filter where and/or $dial filter order by
macro expression.
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OCS also monitors the options that define the body and location of the customized procedure and
regenerates these procedures if these options are modified.
Implementation of Custom Procedures

There are three possible configurations:

1. Before--A call to the custom code is executed before any code execution in the hosting procedure,
immediately following the BEGIN clause.
2. After--A call to the custom code is executed after all of the code in the hosting procedure is executed.

3. Instead--The body of the standard stored code is fully replaced with the custom procedure code.
Logging and Debugging

To assist in debugging custom procedures, OCS logs all SQL code for custom procedures when it is
created and any errors in the custom procedures when they are created.

OCS logs the SQL code for procedures by using the DEBUG log level. Genesys recommends that any

errors that occur when procedures are created be logged with the TRACE log message severity to
ensure the proper alarms on Message Server are configured.

Omitting Verification of the Campaign DBID for Callbacks and
Rescheduled Records Retrieval

Stored procedures take the Campaign DBID (and optionally the Group DBID as configured in the OCS
callback-observe-group option) into account when any record type, other than General, is
retrieved.

Use the callback-observe-campaign option to control whether Campaign DBID is considered by the
OCS record-retrieval mechanism.
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Filter Object

Filters specify the criteria for data selection from a database table. Outbound filters are applied to
Calling Lists. See the Filter field under "Calling List Object".

Creating a New Filter Object

Start

In Genesys Administrator, select Provisioning > Outbound Contact > Filters.
In the Details pane, select New.
Define the fields in the Configuration tab.

Define options in the Options tab.

A

Click Save and Close.

End

Filter Object Configuration Tab Fields
Name

Required; the default value is [Filter]. The name of the filter. This value must be unique within the
tenant.

Tenant

Automatically populated by the system.

Description

Optional; the default is [Blank]. A brief description of the filter.
Format

Required; the default value is [None]. The format to which this filter is applied. When it is specified, it
cannot be changed. You assign a Filter object to a Calling List object with the same format. Use the
Browse button to locate an existing value.

State Enabled

Required; the default value is checked. A check box that indicates that a customer interaction can be
directed to this target. A more complete description is in Framework Genesys Administrator Help.
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Filter Object Options Tab Fields

Two options on the Options tab define a Dialing Filter: criteria and order by. Create a section
called default on the Filter object's Options tab; then add the options criteria (see the procedure
Configuring the criteria Option below) and order by. (see the procedure Configuring the order by
Option to Sort Records).

Configuring the criteria Option

The criteria option defines the where clause of a SQL statement. It defines the restricting
conditions for the records to be dialed by a campaign. The syntax for values in the criteria option is
SQL syntax.

The Outbound Contact Wizard was not updated for

Note:
ote release 8.x.

Start

1. Double-click the filter and select the Options tab.

2. Click Add.

3. In the New Option dialog box, enter default in the Section field and criteria in the Name field.
4

. Add a SQL statement in the Value field.
For example, to restrict the dialing records to contact only platinum credit card holders, type
card type='platinum' in the Value field.

When using Genesys mandatory fields in SQL
statements, the value must be in enum format.
Refer to "Genesys Enumeration Tables" in the

Note: "Communication Protocols" chapter of the
Outbound Contact Reference Manual. (When
creating viewing filters in Genesys Administrator,
this only applies on the Expert Mode tab.)

5. Click OK to save and close the option to this Filter object.

End

Configuring the order_by Option to Sort Records

The order_by option defines the sort order of the records that meet the restrictions defined in the
criteria option. Start

1. Click Add.

2. In the New Option dialog box, enter default in the Section field and order by in the Name field.

3. In the Value field, type the name of the field by which you want to sort.
For example, to order records by telephone number, enter phone in the Value field.

4. Click OK to save and close the option to this Filter object.

Note: If you use a filter on a large Calling List with more

Outbound Contact Deployment Guide 195



Manually Define Outbound Configuration Objects/Table Access Object Filter Object

than 1,000 records, Genesys recommends that
the Administrator create an index using DBMS

tools. This dramatically improves data-retrieval
performance.

End

Defining a Dialing Filter that Exceeds 255 Characters for Configuration Server
7.6.x and Earlier

If you are using Configuration Server 7.6.x or earlier and the dialing filter exceeds 255 characters,
you must divide the long string into several shorter strings. To do so, use configuration options with
the same name and add sequential numbers at the end of the option's name. OCS, OCM, and
Genesys Administrator builds a dialing filter by concatenating the values of these options.

Configuration Server 8.x supports configuring
options with values greater than 255 characters. If

Note: you are using Configuration Server 8.0 or higher,
you can configure a single option with a dialing
filter that exceeds 255 characters.

Sample Configuration:
In the following example, the values of these configuration options:

e criteria
e criterial

e criteria2
are the first, second, and third parts, respectively, of the dialing filter's WHERE clause.

In the following example, the values of these configuration options:

e order by
e order byl
e order_by2

are the first, second, and third parts, respectively, of the dialing filter ORDER BY clause.

When parts of the filter are concatenated, a single
space is added between the parts. As a rule, when
configuring these options, divide your SQL clause

Note: only at points where insertion of the white-space is
permitted by the SQL standard, otherwise the
result of concatenation will yield an invalid SQL
clause.
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Example 1

criteria = phone like '415%' AND tz dbid IN (116, 118,
criterial = 122) AND customer priority IN (10, 9, 4,
criteria2 3, 2, 18) AND customer type =1

order by = phone type ASC, tz dbid DESC,

order byl = customer priority ASC, customer policy n DESC,
order by2 = customer_id DESC

Resulting Filter 1

The options configured as shown above result in the following dialing filter: WHERE phone like '415%"
AND tz dbid IN (116, 118, 122) AND customer priority IN (10, 9, 4, 3, 2, 18) AND
customer type = 1 ORDER BY phone type ASC, tz dbid DESC, customer priority ASC,
customer policy n DESC, customer id DESC

Filters that Break a Chain of Records

You can write a filter so that it breaks a chain of records into two logical chains: one chain that
satisfies the filtering expression and a second chain that does not. For example:

List:

Record 1l:phone = '111', phone type = 1, chain id = 1, chain n = 0
Record 2:phone = '222', phone type = 2, chain id = 1, chain n =1
Record 3:phone = '333', phone type = 1, chain id = 1, chain n = 2
Record 4:phone = '444', phone type = 3, chain id = 1, chain n = 3

Example: The following filter where phone type =1
will break the given chain into two logical chains:

e Logical chain 1 includes records 1 and 3, which satisfy the filter condition.

¢ Logical chain 2 includes records 2 and 4, which do not satisfy the filter condition.

You should avoid such filtering conditions, if possible.

Record Cancel for Broken Chain

Under particular conditions, records with the same chain id are not all canceled by a cancel by
phone request (RequestRecordCancel with GSW_PHONE attribute).

This behavior occurs when four conditions coexist:

* The RequestRecordCancel has the ALl Chain attribute, which means to update the whole record
chain, not just the single record,

but
¢ a filter applied to the calling list breaks a single chain into two logical chains

while
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¢ the dialing session for a campaign group with a campaign (to which the calling list belongs) is loaded or
running,

and
* a phone number specified in the GSW_PHONE attribute is filtered out.

The records that are not filtered out are also not canceled even though the chain attribute is ALl
Chain.

Take, for example, these conditions applied to the list that follows:
e Filter: where phone type =1

¢ RequestRecordCancel: Phone = '222'

¢ ChainAttr = 'Al1Chain'

List:

Record 1: phone = '111', phone type = 1, chain id = 1, chain n = 0
Record 2: phone = '222', phone type = 2, chain id = 1, chain n =1
Record 3: phone = '333', phone type = 1, chain id = 1, chain n = 2
Record 4: phone = '444', phone type = 3, chain id = 1, chain n = 3

Records 1 and 3 meet the filter condition where phone type = 1. Records 1 and 3 compose logical
chain 1. These two records (with chain n = 0 and chain n = 2) are retrieved from the database
and dialed.

Record 2 ( with chain_n = 1) and record 4 (with chain_n = 3) compose the second logical chain.
Record 2 is subject to the RequestRecordCancel where Phone = '222'. Because
RequestRecordCancel has the ALl Chain attribute (ChainAttr = 'All1 Chain'), both records 2 and 4
are canceled.

Full Chain Update

The full chain update feature applies to configurations in which chains of records are separated by
the dialing filter and, therefore, are partially processed by OCS. After OCS finishes processing this
type of chain, by default it marks the records that were filtered out by the dialing filter (such as
Record 2 in the following example) as record status = Ready.

Ordinarily, if a dialing filter is changed and the chain processing is resumed, such an update will
cause repetitive dialing of other records that belong to the same chain. This could lead to contacting
the same customer again within that dialing period. Using the full chain update feature prevents this
unwanted behavior of OCS.

The following provides an example of the configuration when a chain of records is separated by the
dialing filter:
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Chain:

¢ Record 1: Phone = 4155551212, phone type = Home Phone, Chain ID = 1, Chain N =0
e Record 2: Phone = 6505551212, phone type = Direct Business Phone, Chain ID =1, Chain N =1

Dialing Filter Applied:
criteria = '‘phone_type = 1"

Outbound Contact provides the option update all records to enable control over how OCS updates
the status of records after the chain processing has been completed, in the following way:

e If the value for the update all records option is set to true: OCS updates all records in the chain,
regardless of the dialing filter applied. All records outside the parameters of the dialing filter are
updated with the same status that the chain receives after OCS has finished processing it.

* |If the value for this option is set to false (default): Records that were filtered out by the dialing filter are
marked as record status = Ready.

This option can be configured both on the
Application- and individual Calling List-levels. The
Calling List-level option takes precedence over the
Application-level.

Note:

When in use, Full Chain Update ensures that all records in the chain are updated with the same status
as the chain itself, regardless of the chain's currently applied dialing filter, which might separate the
chain by filtering out some records. For example, if the record in the chain has been cancelled with
the flag 'AllChain', then all records, regardless of the dialing filter, will be marked as Cancelled.
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Time Zones

Outbound Contact uses time zones in call records to determine the contact's time zone. Genesys
Administrator populates the tz _dbid field with the international three-letter abbreviation for the time
zone parameter when it imports or exports a calling list. Call time, dial schedule time, and valid dial
time (dial from and dial till) are based on the record's time-zone. For more information about the time
zone abbreviations see Framework Genesys Administrator Help.

If Daylight Savings Time (DST) is configured for
time zones located below the equator using the
Current Year or Fixed Date (Local)
properties, define both the Start Date and End
Date in the DST definition as the current year and
make the Start Date later than the End Date.

Note:

Outbound Contact dynamically updates time changes from winter to summer and summer to winter.
The default set of Time Zones created during Configuration Server installation is located in the Time
Zones folder under the Environment (for a multi-tenant environment) or under the Resources folder
(for a single tenant).

Creating a Custom Time Zone for a Tenant

* To create a custom Time Zone for a Tenant, if necessary.
Start

1. In Genesys Administrator, select Provisioning > Environment > Time Zones.
2. Click New.

3. Define the fields in the Configuration tab. For more information, see Framework Genesys
Administrator Help.

4. Click Save and Close.

End

Time Zones Object--Configuration Tab Fields
Name

Required; default is [Time Zone]. The name of a Time Zone object. This value must be unique within
the tenant.

Tenant

Automatically populated by the system.

Outbound Contact Deployment Guide 200



Manually Define Outbound Configuration Objects/Table Access Object Time Zones

Description
Optional; the default value is [Blank]. A brief description of the Time Zone object.
Time Zone

Required; the default value is [GMT]. Greenwich Mean Time (GMT) plus the amount of time (in hours
and minutes) to add to that standard.

DST Select

Optional; A drop-down list to select Daylight Savings Time definition (GMT) to indicate that the time
zone observes Daylight Savings Time (DST) or Current Year or Fixed Date (local) to indicate that DST
is not observed.

Netscape (in Specific Time Zone section)

Required; Enter the time zone as it appears in Netscape Navigator.
Microsoft Internet Explorer (in Specific Time Zone section)

Required; Enter the time zone as it appears in Microsoft Internet Explorer.
State Enabled

Required; default is checked. A check box indicating whether or not a customer interaction can be
directed to this target. A more complete description can be found in Framework Configuration
Manager Help.

Time Zones and Time-Related Calculations

OCS uses the operating system time zone information for time-related calculations. For example,
when a record is rescheduled by the agent or by using a treatment. On UNIX platforms, OCS
recognizes time zone information in POSIX format only. OCS does not support any other format.
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Treatment Object

Treatment objects are assigned to Calling List objects. Treatment objects define what OCS should do
with a call that does not reach the intended party. A treatment, for example, could be that Outbound
Contact redials a number that returns a Busy call result. If no treatments are assigned to a call result,
OCS changes the record status to Updated.

You can add or remove treatments from a Calling List object while a dialing session for a campaign is

running. However, when a treatment is in progress, it cannot be interrupted. Changes made to that
treatment will be applied to the next record that receives the call result that prompts the treatment.

Creating and Applying Treatments

Start

1. In Genesys Administrator, select Provisioning > Outbound Contact > Treatments.
2. Click New.

3. Define the fields in the Configuration tab.

4

. Click Save and Close.

End

Treatment Object--Configuration Tab Fields
Name

Required; the default value is [Treatment]. Type the name of the treatment. It must be unique within
the tenant.

Tenant

Automatically populated by the system.

Description

Optional; the default is [Blank]. A brief description of the selected treatment.
Call Result

Required; the default value is [Unknown Call Result]. Select a value (the result of a dialing
attempt) for this object. The following table provides information about call result values.

Call Result Values

Call Result Value Description
[Unknown Call Result] Default value. You must change this default value
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Treatment Object

Abandoned

Agent CallBack Error

All Trunks Busy

Answer

Answering Machine Detected

Bridged
Busy
Call Drop Error

Cancel Record

Cleared
Conferenced
Consult
Converse-On
Covered
Deafened

Dial Error

Do Not Call

Dropped

Dropped on No Answer
Fax Detected

Forwarded

General Error

Held

and replace it with another value from this table.
OCS does not apply treatments to the Unknown call
result.

Call dropped and will not be redialed.

OCS generates this call result when a call record is
rescheduled according to a personal callback
request from the desktop application, but OCS
cannot find the designated agent to receive the
callback when the scheduled time arrives.See the
"Communication Protocols" chapter in the
Outbound Contact Reference Manual for details on
the personal callback request.

No free trunks on the switch for dialing a call.

Customer was reached at the dialed phone
number.

Answering machine was detected at the dialed
phone number.

Reserved for future use.
Dialed phone number was busy.
Reserved for future use.

Record has been marked with Cancel by the agent
desktop application or a third-party application.

Reserved for future use.
Reserved for future use.
Reserved for future use.
Reserved for future use.
Reserved for future use.
Reserved for future use.

Hardware error from a Dialogic board or a call
progress detection (CPD) board on the switch.

Record has been marked with DoNotCall by the
agent desktop application or a third-party
application.

Call dropped by dialer after call dialed. Call
dropped if/when the
call wait in queue_timeout option expires.

Reserved for future use.

Fax machine was detected at the dialed phone
number.

Reserved for future use.

General error occurs when a call is not completed,
possibly caused by an invalid telephone number in
the record or a wrong number according to the
switch.

Reserved for future use.
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Treatment Object

No Answer
No Dial Tone

No Established Detected
No Port Available

No Progress

No RingBack Tone

NU Tone
OK

Overflowed
Pager Detected
Pickedup
Queue Full
Redirected
RemoteRelease

Silence

SIT Detected

SIT IC (Intercept)

SIT Invalid Number

SIT NC (No Circuit)

SIT RO (Reorder)

SIT Unknown Call State

SIT VC (Vacant Code)

Stale

Switch Error
System Error

Transfer Error

Ring without answer at destination.

Absence of dial tone based on an error returned by
the Dialogic board or the call progress detection
(CPD) board on the switch.

Reserved for future use.
No port is available to place call.
Reserved for future use.
Reserved for future use.

A special Public Switched Telephone Network
(PSTN) code valid only in Europe.

OCS treats the call result OK as undefined,
therefore, it disregards any treatments created for
this call result.

Reserved for future use.
Pager was reached at the dialed phone number.
Reserved for future use.
Reserved for future use.
Reserved for future use.
Reserved for future use.

Call was dialed, but there was no call progress
detection (CPD).

Any type of network tone.

Only applies if the network supports this specific
standard information tone (SIT). Check with the
switch vendor for confirmation.

Only applies if the network supports this specific
SIT. Check with the switch vendor for confirmation.

Only applies if the network supports this specific
SIT. Check with the switch vendor for confirmation.

Only applies if the network supports this specific
SIT. Check with the switch vendor for confirmation.

Only applies if the network supports this specific
SIT. Check with the switch vendor for confirmation.

Only applies if the network supports this specific
SIT. Check with the switch vendor for confirmation.

Call result is marked as stale if the following timer
has expired: stale clean timeoutOCS will also
mark the call result as stale for call records that
have not received a RecordProcessed request
from the desktop application when a dialing
session/campaign group is being unloaded.

No dial tone received.

Dialing software error from the Dialogic driver or
CPD from the switch.

Dialer has a problem transferring calls based on
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Transferred

Wrong Number

Wrong Party

Apply to Record

call action.
Reserved for future use.

Call is answered but the desired person(s) could
not be reached at this number; this call result is
sent by the agent desktop application and not
detected by the dialer.

Call is answered but by a wrong party; this call
result is sent by the desktop application and not
detected by the dialer.

Required; default [Unknown Action]. Select a value from the drop-down list. The action to apply to a
Calling List record based on the call result. Applies to all call results in the Call Results Values table
except for call result Answer. The following table provides information on Apply to Record values.

Apply to Record Values (Unanswered Call Results)

Apply to Record Value

Assign to Group

Execute SQL Statement

Mark as Agent Error

Next in chain

Next in chain after

Next in chain at specified date

Description

Used for the Agent CallBack Error call result.
The call record is treated as a scheduled call of
type Campaign. The record type is set as
CampaignCallBack. The call record is sent to one
of the desktops in the Campaign Group. The
desktop must be programmed with a
communication protocol to use this feature. See
the "Communication Protocols" chapter in the
Outbound Contact Reference Manual.

Used to execute pre-configured SQL statements
when certain call results are received. There is no
limitation on the type or complexity of the SQL
statement that can be configured. Macro
expressions can also be used to form the SQL
statement. To execute this statement, OCS
connects to the Calling List table from which the
associated dialing record originated.

Used for the Agent CallBack Error call result.
The record status is set to Missed Callback. See
also the predictive callback option in this guide.
Note: Although you can set this value to other
negative call results in Configuration Manager, you
should only use it for Agent CallBack Error call
result.

Used to set the total number of times that the next-
in-chain treatment cycle occurs, and set the time
period to wait before beginning the cycle again.

Used to set the interval until the next record in
chain is dialed, and until the next pass through the
chain, after the last record in the chain has been
dialed.

Used to set the date/time to dial the next record in
chain.
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No Treatment No treatment will be applied.

Redial number within a specified number of
Redial minutes (Interval) for a specified number of times
(Cycle Attempt).

Record will be redialed at specified times within the
Retry at specified date time interval specified in the Range property of the
treatment.

Retry once after the specified number of minutes
(Interval).

Sends an HTTP request with the JSON body to a
remote Web/Application Server.

Retry in

Send HTTP Request

No more dial attempts are made for the chain and

Wjpekie cll raEeies i Cozln all records in the chain are marked as Updated.

Default value. You must change this default value

[Unknown Action] and replace it with another value from this table.

Apply to Call

Optional; applicable only when call result is Answer, Answering Machine Detected, or Fax Detected;
the default value is [Unknown Action Code]. Allows an alternate path when a dialing attempt is
answered or reaches an answering machine or fax machine. Select a value from the drop-down
menu. The following table provides information about Apply to Call values.

Apply to Call Values (Answering Machine/Fax Results)

Apply to Call Value
Connect

Drop

Mute Transfer
Play a Message
Route

Send a fax
Send a page
Send an e-mail

Transfer

[Unknown Action Code]

Destination DN

Description

Call connected to the DN defined as the
Destination DN.

Drop = Unknown. Call is dropped or disconnected.
Reserved for future use.
Reserved for future use.
Reserved for future use.
Reserved for future use.
Reserved for future use.
Reserved for future use.

Call transferred to the DN defined as the
Destination DN.

[Unknown Action Code] = Dropped. Default value.
You must change this default value and replace it
with another value from this table.

Required for the Apply to Call actions, Connect and Transfer; default is [None]. The DN to which
the call will be connected or transferred. Browse for an existing DN. If a Destination DN is not
supplied, OCS will ignore the treatment.
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Number in sequence

Required; the default value is [0]. Assign the value 1 for a stand-alone treatment or for the first
treatment of a treatment sequence. In a treatment sequence, each treatment contains a unique
number that determines the order in which each treatment is applied to the same call result.

Cycle Attempt

Required to be other than © when Apply to Record is set to Next in chain, Next in chain after,
Next in chain at specified date, Redial; the default value is [0]. The maximum number of
consecutive attempts to execute the treatment on the record.

Interval (minutes)

Required when Apply to Record is set to Next in chain, Next in chain after, Redial, or Retry
in; defaultis [0]. A time interval, in minutes, that OCS waits between the first dialing attempt and
the first treatment attempt.

Increment (minutes)

Required when Apply to Record is set to Next in chain, Next in chain after, Retry 1in,
Redial; the default value is [0]. Specifies the number of minutes added to the previous redial time
interval.

Date

Required if the Apply to Record action is set to Next in chain at specified date or Retry at
specified date; the default value is [current date]. The date when another treatment attempt
will be performed. Select a calendar date from the drop-down list.

Time
Required if the Apply to Record action is set to Next in chain at specified date or Retry at

specified date; the default value is [current time]. The time of day that another treatment
attempt will be performed. Select a time from the drop-down list.

Range

This is reserved for future use.

Treatment Sequences

Note the following:

* You can define treatment sequences (sometimes called linked treatments) for the same call result by
using the Number in sequence field on the Configuration tab of the Treatment object. The first
treatment in the sequence must have a value of 1 in the Number in sequence field. The values for this
field must be numbered sequentially (1,2, 3, etc.). The sequence will not work if a treatment sequence
is broken, for example, numbered 1, 2, and 4.

* You can create two Busy treatments and specify the order (sequence) in which to apply them. For
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example, create one Busy treatment that has an action of Redial and the Number in sequence field
set to 1; create a second Busy treatment that has an action of Retry in and the Number in sequence
field set to 2; then assign both Busy treatments to the same Calling List.

* You can also use the sequence of treatments in combination with cycling through the chain. To do this,
you need to place one of the treatments of the type Next-In-Chain, Next-In-Chain After, or Next-
In-Chain at Specified Date, at the end of the sequence of treatments.

Properly configuring one of these treatments to be the last in the sequence will result in the following:
When the chain is completed, OCS will jump from the last record to the first record in the chain to
begin the cycle again.
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Campaign Object

A Campaign object contains information about the Calling List(s) and, if needed, defines campaign-
level options.

Creating a New Campaign Object

Start

In Genesys Administrator, select Provisioning > Outbound Contact > Campaigns.
Click New.
Define the fields in the Configuration tab.

In the Calling Lists section, click Add to add calling lists to the campaign.

A

Click Save and Close.

End

Campaign Object--Configuration Tab
Name

Required; the default value is [Campaign]. Type or choose the name of the campaign. This name must
be unique within the tenant.

Tenant
Automatically populated by the system.
Script

Optional; the default value is [None]. Defines the Script object that contains all of the attributes
that are required by Agent Scripting. For more information, see the "Attaching Script Information to
OCS User Events and Telephony Events" section in the Outbound Contact Reference Manual for more
information.

State Enabled

Required; default is checked. A check box that indicates that customer interaction can be directed to
this target. A more complete description can be found in Framework Genesys Administrator Help.

Calling List

Required; the default value is [None]. The names of Calling Lists that will be dialed during this
Campaign. A Campaign can have zero or more Calling Lists. Select from defined Calling Lists.
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List Weight (in Configuration Manager); Share (in Genesys Administrator)

Required; default is [10]. This property is applicable for a campaign with more than one active
Calling List. It is the percentage of call records to be retrieved from a Calling List for a Campaign.
Specify what percentage of that volume will be drawn from each calling list. See the "Understanding
Weights" topic in the Framework Genesys Administrator Help.

The List Weight field is the Share field in the

Note: Calling List tab.

Active

Required; default is checked. A check box that indicates if the selected Calling List is involved in this
campaign. The check box is used to activate or deactivate the Calling List dynamically in a running
dialing session for a campaign.

Campaign Object--Options Tab

Use this tab to define outbound campaign-related options. An option defined in this tab fine-tunes the
system on the individual campaign level.
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Campaign Group Object

A Campaign Group is the main configuration object in Outbound Contact. It can be found in the
Campaign Groups tab within the Campaign object in Genesys Administrator > Provisioning tab
> Qutbound Contact. The Campaign Group is defined as a Campaign (a set of calling lists) that is
assigned to work resources such as an Agent Group or a Place Group.

The following sections describe how to configure a Campaign Group object:

Creating a New Campaign Group Object

Start

In Genesys Administrator, select Provisioning > Outbound Contact > Campaigns.
In the Details pane, double-click a Campaign.
Select the Campaign Groups tab.

Click New.

v ok W N

Define the fields in the Configuration tab.

The following sections (General Section,
Note: Advanced Section, and Connection Section)
describe how to configure this tab.

6. Configure the Options tab.
7. Configure the Permissions tab.

8. Click Save and Close.

End

General Section

Name

Required; The format is [Campaign@CampaignGroup]. Automatically populated by the system.
Tenant

Required; Automatically populated by the system.

Campaign

Required; The name of the Campaign that will form the Name field above. Automatically populated by
the system.
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Group Type

Required; The type of group (agent or place). Automatically populated by the system.
Group

Required; The name of the group that will form the Name field above.

Description

Optional; the default value is [Blank]. A brief description of the campaign.

State Enabled

Required; default is checked. A check box that indicates that customer interaction can be directed to
this target. A more complete description can be found in Framework Genesys Administrator Help.

Advanced Section

Dial Mode

Required; the default value is [Predictive]. Any of the modes that are described in Dialing Modes.
Voice Transfer Destination

Required; the default value is [None]. Identifies where calls are to be delivered for handling. In
addition to the Voice Transfer Destination DN, any ACD Queue, Virtual Queue, Routing Point,
or Service Number DN that might be part of a call flow that involves this group of agents or places
must be specified as an Origination DN in the Advanced section of the Agent Group or Place
Group objects in Genesys Administrator. OCS needs to monitor these DNs to identify "foreign"
inbound or outbound calls that are delivered to agents but were not issued by OCS on behalf of the
Campaign Group, or if the ACD Queue DN is configured as an "overflow" DN.

* You must avoid situations in which the same DN
is configured as an Origination DN for more
than one Agent Group or Place Group that is
part of a predictive or progressive campaign
dialing mode because the pacing algorithm
may give incorrect statistics that may result in
poor dialing ratios.

Notes: ¢ In addition to the actual Voice Transfer

Destination DN, other DN types such as ACD
Queue, Virtual Queue, Routing Point, or Service
Number must be configured as Origination DNs
in the Agent Group object or the Place Group
object. These types of DNs need to be specified
so that OCS can monitor them in order to
recognize foreign inbound or outbound traffic
(such as calls that seize agents but were not
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issued by OCS on behalf of the Campaign
Group) or to recognize that the ACD Queue DN
is configured as an overflow DN.

Operation Mode
Required; the default value is [Manual]. Not used at this time.
Optimization Method and Optimization Method Value

Required in Predictive mode; the default value is [Agent Busy Factor] for Optimization Method,
and the default value is [80] for the Optimization Method Value. These parameters work together
to determine how busy the campaign will be. They are not applicable to Push Preview and Power
GVP dialing modes.

Maximum Queue Size

Optional; the default value is [0]. Determines the number of records to keep in the dialer's queue. It
is an internal counter that is used when OCS performs with Power GVP or Push Preview modes. OCS
tries to always keep dialer's buffer full with the specified Maximum Queue Size.

IVR Profile

Optional; the default value is [Blank]. Specifies the IVR Profile that is specified in the GVP EMPS IVR
Profile. The ivr-profile-name option uses the value specified in this field.

* In an VoIP environment, OCS provides this IVR
Profile to GVP in the TMakePredictiveCall
request before the GVP VoiceXML application is

started for dialing the customer call.
Notes:

* In an VolP environment (Power GVP or
Progressive GVP modes), User Data associated
with the customer call is delivered through SIP
messages.

Interaction Queue

Optional; the default value is [None]. Specifies a configuration object that is created in the Scripts
section in Genesys Administrator > Provisioning > Routing/eServices by Interaction Routing
Designer when developing a Business Process to process outbound Preview mode interactions. For
more information, see the Universal Routing Business Process User's Guide. An Interaction Queue
is used in Push Preview mode only.

Script

Optional; the default value is [None]. Defines the Script object that contains all of the attributes
that are required by Agent Scripting. For more information, see the "Attaching Script Information to
OCS User Events and Telephony Events" section in the Outbound Contact Reference Manual for more
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information.
Trunk Group DN DBID

Required only if you are using Outbound Contact in an Outbound VoIP environment. If specified, OCS
uses this DN as the DN from on behalf of which outbound and engaging calls originate. The name of
the Trunk Group DN is the same as the partition-id value specified in SIP Server, which determines
the resource allocation for calls made from this Trunk Group DN.

For additional information about configuring an
Note: Outbound-IP environment, see Outbound-VolP in
ASM Dialing Modes.

Minimum Record Buffer Size/Optimal Record Buffer Size

Required; the default value is [4] for Minimum and the default value is [6] for Optimal. Acts as a
multiplier for the number of agents that are available for a campaign. Together, the Minimum and
Optimal values determine how many records OCS keeps in memory when performing traditional
campaigns. Because there might be no agents for the Push Preview and Power GVP dialing modes,
these parameters are used differently by OCS as a percentage of the desired Maximum Queue Size
value. For example, you can set them to Min: 100%, Opt: 150-200%.

Number of Channels

Identifies the maximum number of channels (or ports), that a Campaign Group can use to place calls.
This max number is used in: Progressive, Predictive, Progressive with seizing, Predictive with seizing,
and Progressive GVP dialing modes.

Connection Section

The Connections section enables you to specify all server connections (besides T-Server) that are
required to run a dialing session for an outbound campaign in a certain dialing mode for a particular
Campaign Group.

This type of connection provides basic host/port
connectivity only. It does not provide features such
as Advanced Disconnect Detection Protocol (ADDP).

Note: Also, you can add your application to the
Connections tab of the 0CS Application object in
order to configure any additional connection
parameters.
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Outbound Schedule Object

Each Schedule is represented in the Genesys Configuration Layer as a Script object, of the Outbound
Schedule type. OCS only considers schedules which are Enabled in configuration.

The following section briefly describes how to create an Qutbound Schedule object. For complete
information on configuring and using Schedules, see the Framework Genesys Administrator Help.

Creating a New Outbound Schedule Object

Start

. In Genesys Administrator, go to Provisioning > OQutbound Contact > Schedules.

. Click New. The Outbound Schedule Properties window opens, and then click Add under the Schedule
Items to add an existing Campaign Group or create a new Campaign Group.

. On the Configuration tab, enter the following information (indicates a mandatory field)

Name--The name of the Schedule. You must specify a value for this property, and that value must be
unique within the Configuration Database (in an enterprise environment) or within the Tenant (in a
multi-tenant environment).

Tenant--In a multi-tenant environment, the Tenant to which this Schedule belongs. This value is set
automatically, and you cannot change it.

Script Type--Select Outbound Schedule.

State--Indicates if this Schedule is enabled (default) or disabled.

. On the Options tab, enter information as required.
. On the Permissions tab, enter information as required.
. To save the new Schedule object and register it in the Configuration Database, do one of the following:

e Click Save and Close to return to the Scripts view. To configure the new object, double-click on the
name of the object to open the Schedule Properties dialog box. Refer to Genesys Administrator Help
for information about configuring the properties of the Schedule.

When defining sequential execution points for a
Schedule, the At time condition specified for a
Stop action must not be earlier than the At time
condition specified for the corresponding Start
action. OCS does not assume that the earlier
Note: Stop time is on the next calendar day; instead, it
' starts the action at the specified time and then
immediately stops it.
Warning: This is not an issue when defining Stop actions with

the After condition; OCS supports execution on the following
day in this case.

* Click Save to continue configuring the Schedule.

e Click Save and New to save the new Schedule and start creating another one.

End
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Outbound Contact Configuration Options

These topics describe each of the options that you can configure to ensure that Outbound Contact
performs as needed in your environment:

e Overview
¢ Qutbound Contact Server Options
e CPD Server Options
In Genesys Administrator, all Outbound Contact
options that were located on the Annex tab of the
Note: respective Outbound Contact objects (with the

exception of SCXML options configured at the OCS
application level), are located on the Options tab.
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Overview

In Outbound Contact, you define options at the Outbound Contact Server (OCS) application level. You
can also define options at the object level for Switch, DN, Agent, Place Group, Calling List,
Campaign Group, and Campaign objects. Defining the settings at the object level enables flexibility
and fine-tuning for a campaign setup.

OCS first reads the configuration options in the objects. If an option is not defined at the object level,
OCS checks the configuration at the application level. If the option is not specified at the application
level, OCS uses the default value for that option.

When you make changes to an option, the changes
Note: take effect immediately, unless otherwise noted in
the option description.

Depending on the needs of the contact center configuration, the Outbound Contact Administrator can
choose to:

* Use default OCS options, if the contact center has no specific requirements.
e Set options at the OCS application level, if the contact center requires overriding of OCS settings.

¢ Set options at the level of a specific object, if the contact center has specific needs for individual Switch,
Agent, Place Group, or Campaign objects.

OCS stores configuration options in section folders on the Options tab. The Options tab contains the
section folders and options for application objects in OCS and CPD Server.

This topic lists the section folders and options according to their general function, and the name of
the object.

* Logged data can be truncated to hide sensitive
data in the log by configuring either the
default-filter-type option or any of the
log-filter-data section options to the value
hide. The truncation is represented in the log
by asterisks. For more information about these
options, see the "Common Configuration
Options" chapter in the Framework
Configuration Options Reference Manual.

Notes: e Starting in OCS 8.1.2, the tag option value is

supported and built into the Log Library and, in
user data printouts, covers all events received
from external servers, such as T-Server, SIP
Server, and Interaction Server. OCS will
continue to print SQL statements and HTTP
BODY JASON pairs in full when the default-
filter-type logging option is set to copy and
hides all sensitive data by replacing it with
asterisks (****) when this option is set to any
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other value, including tag.
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Outbound Contact Server Options

The Outbound Contact Server options are defined in various configuration objects. These options are
summarized by logical group, that is, the operation for which they are required. The detailed
descriptions of the options are then listed in alphabetical order.

e Section Names

* OCS Options by Logical Group

¢ OCS Option Descriptions
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Section Names

The Options tab of the configuration object needs to contain a section that is named in one of the
following ways:
* 0CS application object name, which specifies the name of the current OCS Application object.
e default
e 0CServer
Genesys recommends that you define all OCS
options in the 0CServer section folder, with the

exception of default record priorities options, which
are defined in the Qutbound section.

Note:

The Outbound section is used for defining the default record priorities in Outbound Contact Campaign
Group objects at the OCS application level. This section contains parameters specific to record
priorities. See Flexible Prioritization of Record Types for more information about these options.

There is also an additional section, called log call stats, which is created only at the OCS
application level. This section contains parameters specific to Audit Logging. See Section log call
stats for descriptions of the options that this section contains.

When OCS looks for the defined value of an OCS option, it searches the sections in a prescribed order
until it finds the option in one of the sections.

The prescribed search order is the following:

1. OCS searches the designated sections on the Options tab of the configuration object, as follows:
a. <0CS application object name> section
b. default section

c. 0CServer section

2. If OCS does not find the option, it follows the same procedure to search in the Options tab of its own
Application object.

3. If OCS does not find the option, it uses the option's default value.

Example of an OCS Option Search

In this example, two different OCS applications (OCS1 and OCS2) work with the same switch. The
options for each OCS application are defined on the Options tab of the switch configuration object or
on the Options tab of the OCS Application object.

OCS1 is searching for the outbound release action option.

1. Options tab of the Switch object:

a. OCS1 searches for the outbound release action option in the OCS1 section.
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b. If the option is not in the OCS1 section or if there is no section named OCS1, OCS1 searches for the
option in the section named default.

c. If the option is not in the default section, or if there is no section named default, OCS1 searches
for the option in the section named 0CServer.

2. Options tab of OCS:
If OCS1 does not find the outbound release action option in any of the three sections on the
Options tab of the Switch object, it searches the Options tab of its own Application object, repeating
the search process that it performed on the Options tab of the Switch object.

3. Other:

If OCS1 does not find the outbound release _action option on either Option tab, it uses the option's
default value (false).

Most Outbound Contact Server options are
dynamic. This means that the application does
Note: not have to be restarted in order for option
changes to take effect, unless otherwise noted in
the option description.

How OCS Prioritizes If Different Configuration Objects Contain the Same Section

 If there are different configuration objects that contain options in the same named sections with the
same key and different values, OCS chooses only one of them, according to the following priorities:

e Calling List (highest priority)
e Campaign Group

e Campaign

e Agent Group or Place Group
* Switch

e OCS application (lowest priority)

 If there are several configuration objects that are used in a particular campaign with options that

contain different keys, OCS attaches all of these options as a list of key-value pairs in the UserData
attribute.

e If you want to indicate that a particular outbound campaign has a higher priority than other campaigns,
you can attach a campaign priority = high key-value pair to every call or preview record that OCS
generates while running the dialing session for this campaign. As an example, you can perform the
following steps if you want to configure a Campaign Group to run a dialing session/campaign called
Collections90days that uses an OCS application called 0CS Western Region:

1. Choose a section name to store the data that you want to attach, such as collection options.

2. Create a section with this name on the Options tab of a Campaign Group configuration object. In this
section, add an option specifying the key as campaign priority and the value as high.

If more than one dialing session/Campaign Group
. is going to run this campaign, configuration
Note: : : .
objects representing all these Campaign Groups
should have this configuration.

3. Configure the user _data section name option and set the value to collection options in the
0CServer section of the Options tab of the 0OCS Western Region application object.
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Section log_call_stats

This section contains the configuration options used to configure Audit Logging, and takes effect only
if the configuration option log call stats is set to yes or true.

In addition to the option all (see log_call stats), this section can also contain the common options
expire and segment. Refer to the Framework Configuration Options Reference Manual for full
descriptions of these options.
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OCS Options by Logical Group

The following table lists the OCS options related to a given functionality. Some options might belong
to more than one logical group.

For a full description of each option, use the link provided to find the option in the section OCS Option
Descriptions.

OCS Options by Logical Group
Logical Group Options

agent_logout_preview_call_result
agent_preview_mode_start
campaign-callback-distr
cancel-on-desktop
desktop-chains-limit
direct-personal-callback
engaged_answer_action
engaged_release_action
hard_request_to_login_dn
outbound_answer_action
outbound_release_action
preview_release_nocontact_action
record_processed
stale_clean_timeout

Agent Desktop

asm_channel_num
asm_drop_am_announcement_data
asm_drop_announcement_data
assured-connect
assured-connect-field
T beep-on-merge

ASM Dialing engaged_answer_action
engaged_release_action
merge-method
on-asm-overdial
on-bridging-unable
vtd-override

divert_to_unknown_dn
ivr_group
ivr_update_on_release
on-asm-overdial
overflow_dn
predictive_callback
remote_release_action
transfer_to_unknown_dn

Call Processing

campaigngroup-preload-uri
campaigngroup-states-interval
campaigngroup-states-uri
customer_id
digital-dialer-uri

CX Contact disposition-code-field
history-uri
history-wait-condition-threshold
http-connection-pool-size
http-custom-headers

Outbound Contact Deployment Guide 223



Outbound Contact Configuration Options

Outbound Contact Server Options

Logical Group

Dial Log

Dialing

Dialing Regulations

http-proxy
http-response-timeout
http-retry-applies-to
http-retry-max-attempts
pre-desktop-validation-uri
pre-dial-validation
protocol.add-record.uri
schedule-states-uri
send-campaigngroup-states
send-history
send-schedule-states
validation-uri

dial_log_buffer
dial_log_delimiter
dial_log_destination
dialer-num-attempts
log_call_stats

am-detection-map
am-drop-field
assured-connect
assured-connect-field
call_answer_type_recognition
call_timeguard_timeout
call_transfer_type
call_wait_agent_connected_timeout
call_wait_connected_timeout
call_wait_in_queue_timeout
call_wait_original_establish_timeout
caller-id-sets
caller-id-rotation
campaign-callback-distr
channel_num
check_dnc_callback
check_dnc_list
cpd-on-connect
cpd-recording

CPNDigits

CPNDisplayName

CPNPlan

CPNPresentation
CPNScreening

CPNType

customer_id

dialer-ttl

dialing_rate_limit

lifo-mode
lifo-record-expiration
lifo-unload-pace
public_network_access_code
user_data_section_name

all
asm_drop_am_announcement_data
asm_drop_announcement_data
call_timeguard_timeout
check_dnc_callback

check_dnc_list

CPNDigits

digits-detection
digits-detection-pattern
digits-detection-timeout

Options
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Logical Group Options

digits-reaction
dnc-default-duration
dnc-purge

dnc-reread

dnc-use-duration
log_call_stats
pa-abandon-rate-limit
pa-amd-false-positive-rate
pa-amd-test-percentage
pa-odr-period-start-time
pa-safe-dialing
predictive_max_overdial_rate
predictive_min_overdial_rate

agent-assignment
agent-assignment-max-num
agent-assignment-min-num
agent-assignment-priority
agent-reassignment-if-waiting-ports
agent-reassignment-if-waiting-ports-timeout
agent-reassignment-if-waiting-records
agent-reassignment-if-waiting-records-timeout
inbound-agent-assignment-min-num
inbound-agent-assignment-priority
ocs-urs-broadcast

ocs-urs-interact

Dynamic Agent Assignments

am-beep-detection
dialer-num-attempts
dialer-ttl

GVP gvp-modes-use-switch-rate-limit
ivr-profile-name
ivr_record_processed
predictive_patience_time

conversion
icon_attribute
right_person
snapshot_interval

Historical Reporting

campaigngroup-states-interval
campaigngroup-states-uri
contact-processed-notification
contact-processed-notification-uri
encoding
history-uri
history-wait-condition-threshold
history-wait-recovery-timeout
http-connection-pool-size
http-body

HTTP-based Notifications http-custom-headers
http-headers
http-method
http-proxy
http-response-timeout
http-retry-applies-to
http-retry-max-attempts
treatment-action-uri
send-campaigngroup-states
send-history
validation-race-condition-call-result
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Logical Group

Interactions Processing in Push
Preview Dialing Modes

Licensing

Outbound Contact VolP Dialing
Modes

Outbound Schedule

Pre-dial Validation

Predictive Algorithm

direct-personal-callback
direct-push-preview
interaction-media-type
recall-on-unload

license-file
num-of-licenses

am-beep-detection
beep-on-merge
cpd-on-connect
cpd-recording
merge-method
on-asm-overdial
on-bridging-unable
predictive_patience_time

campaigngroup-preload-uri
on-schedule-disable
schedule-states-uri
send-schedule-states

http-connection-pool-size
http-response-timeout
http-retry-applies-to
http-retry-max-attempts

Options

pre-desktop-validation-expiration-timeout

pre-desktop-validation-type
pre-desktop-validation-uri
pre-dial-validation
validation-keys

validation-propagate-user-data

validation-timeout-call-result

validation-uri validation-wait-history

dynamic-port-allocation
history_length
inbound_agent_outlier_limit
outbound_agent_outlier_limit
pa-abandon-rate-limit
pa-amd-false-positive-rate
pa-amd-test-percentage
pa-dial-expire
pa-exclude-long-dialing
pa-handle-expire
pa-handle-time-consider
pa-hitratio-min
pa-inbound-ignore
pa-odr-interval
pa-odr-period-start-time
pa-progressive-multiplier
pa-queue-expire
pa-safe-dialing
pa-selfcheck-adt-threshold
pa-selfcheck-awt-threshold
pa-selfcheck-bf-threshold
pa-selfcheck-interval
pa-selfcheck-odr-threshold
predictive_algorithm
predictive_hit_ratio
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Logical Group

Predictive Algorithm Self-Test

Predictive Hot Start

Prioritization of Record Types

Real-Time Reporting

Record Processing

SIP Cluster

Options

predictive_hot_start
predictive_inbound_call_duration
predictive_inbound_rate
predictive-longcalls-truncation
predictive_max_overdial_rate
predictive_min_overdial_rate
predictive_outbound_call_duration
predictive_patience_time
progressive_blending_reserved_agents
progressive_blending_reserved_status
small_group_size

stat-hit-ratio-count
time-to-ready-tolerance

pa-selfcheck-adt-threshold
pa-selfcheck-awt-threshold
pa-selfcheck-bf-threshold
pa-selfcheck-interval
pa-selfcheck-odr-threshold

predictive_hit_ratio
predictive_hot_start
predictive_inbound_call_duration
predictive_inbound_rate
predictive_outbound_call_duration

default_campaigncallback_priority
default_campaignrescheduled_priority
default_general_priority

db-stat-recalc-interval
outbound_contact_server
record-count-use-timeframe
report-procedure-body
report-procedure-location
stat-server-ha

callback-observe-campaign
callback-observe-group
campaign_name_field
campaigngroup-auto-complete
disposition-code-field
force-unload-wait-db
ignore-empty-group
protocol.add-record.uri
record_save_intermediate_results
send_attribute
stale_clean_timeout
treatment_sched_threshold
update_all_records

send-history

history-uri
history-wait-condition-threshold
history-wait-recovery-timeout
validation-race-condition-call-result

sip-cluster-asm-dial-node
sip-cluster-lb-mode
sip-cluster-prime-node
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Logical Group Options

action-queue-quota

local_file_maxage

maxAge

maxStale

scxmli.persistence.max_active
SCXML-based Treatments scxmli.transcoder.default

treatment-holidays-table

treatment-preferred-contact-field

treatment-uri

treatment-weekdays-table
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OCS Option Descriptions

action-queue-quota

Default Value: 10000

* Valid Values: A positive integer, greater than 10
¢ Changes take effect: After restart

e Configuration Level: OCS Application

e Logical Group: SCXML-based Treatments

Specifies the number of action items to process from an SCXML action queue before returning control
to OCS.

agent-assignment

Default Value: no/false
e Valid Values: yes/true, no/false

e Configuration Level: Campaign Group

Logical Group: Dynamic Agent Assignments
Controls the ability of the Campaign Group to be used in agent reassignment. The value no/false is

used for Campaign Groups that have calls distributed by the switch and not distributed by Universal
Routing Server.

agent-assignment-max-num

Default Value: 0

Valid Values: 0 to n

¢ Configuration Level: Campaign Group

Logical Group: Dynamic Agent Assignments

Defines the maximum number of agents in the Campaign Group when determining agent
reassignment. When the value is set to 0, there are no restrictions for the maximum amount of
agents in the Campaign Group. The agent-assignment-max-num option and dynamic agent
reassignment, in accordance with the availability of ports, is applied irrespective of the value that is
specified for the agent-assignment-min-num option (before OCS 8.1.3, these were not applied if the
value of the agent-assignment-min-num was set to zero).
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agent-assignment-min-num

Default Value: 0
Valid Values: -1, 0 ... n

e Configuration Level: Campaign Group

e Logical Group: Dynamic Agent Assignments

Defines the minimum number of agents in the Campaign Group when determining agent
reassignment.

¢ When the value is set to 0, the Campaign Group is always considered to be understaffed. Agents are
assigned to this Campaign Group even when the lowest priority Campaign Groups are understaffed.

* When the value is greater than 0, the Campaign group is considered understaffed until the number of
assigned agents is at least equal to the specified value. For instance, if you provision a campaign group
with the value 100, the campaign group is considered understaffed until it has 100 agents. Agents are

reassigned to the campaign group accordingly.

¢ When the value is set to "-1", the Campaign Group is considered always staffed, even if there are no
assigned agents. This setting prevents assignment to the Campaign Group and OCS assigns agents to
this Campaign Group only if the following items are true:

* These agents can not be assigned to any running activities (inbound activity and running associated
Campaign Groups) with higher priority due to the restrictions imposed by the options regarding the

agent assignment.

* Any running activity with lower priority is staffed; that is, the number of assigned agents is not less
than the non-zero minimum values specified in the agent-assignment-min-num or inbound-
agent-assignment-min-num option.

* The inbound-agent-assignment-min-num option is not set to zero.

* The agent-assignment-min-num options for all active associated Campaign Groups are not set to
zero.

agent-assignment-priority

e Default Value: 1
Valid Values: 1... n

¢ Configuration Level: Campaign Group

e Logical Group: Dynamic Agent Assignments

Defines the priority of the Campaign Group when determining agent reassignment. As the value
increases, the priority for the specified Campaign Group also increases.

agent _logout _preview call result

¢ Default Value: -1
e Valid Values: -1, 0, 1,...n
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¢ Configuration Level: Campaign Group, Application

e Logical Group: Agent Desktop
Enables OCS to change the call result for Preview, Personal CallBack, or Campaign CallBack
records that are on an agent's desktop after receiving an EventAgentLogout message from Stat
Server.

¢ When the value is -1, OCS updates the record with the previous call result.

¢ When the value is greater than or equal to 0, OCS updates the record in the database table with the
integer value of this option. For Genesys Administrator to display the call result as a string, the integer
value of this option must match a call result enumeration value listed in the Defined Constants topic of
the Outbound Contact Reference Manual.

agent_preview_mode_start

e Default Value: no/false
* Valid Values: yes/true, no/false
* Configuration Level: Campaign Group, Application

e Logical Group: Agent Desktop

Controls whether agents must send the PreviewDialingModeStart event before they can receive
preview records or callbacks. If set to true, before sending a personal or group callback, OCS checks
the agent's status to see whether his or her desktop sent PreviewDialingModeStart.

agent-reassignment-if-waiting-ports

¢ Default Value: no/false

Valid Values: yes/true, no/false

* Configuration Level: Campaign Group, Application

¢ Changes Take Effect: Immediately

¢ Logical Group: Dynamic Agent Assignments
When set to true, OCS calculates the "effective pool" of agents, which is a number of agents that can
effectively work with the given number of available ports. If this effective pool is smaller than the
currently-assigned number of agents and less than the agent-assignment-max-num, then the
remainder of the agents is reassigned to other activities. To prevent too frequent reassignments, OCS
initiates a new reassignment only when the time since a previous reassignment is longer than the

timeout configured in the agent-reassignment-if-waiting-ports-timeout option. This option is
applicable to dialing sessions with agent-assignment enabled.

agent-reassignment-if-waiting-ports-timeout

e Default Value: 30

¢ Valid Values: A positive integer
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¢ Configuration Level: Campaign Group, Application

¢ Changes Take Effect: Immediately

e Logical Group: Dynamic Agent Assignments
Specifies the timeout, in seconds, after which an agent can once again be reassigned from a dialing
session with no available dialing ports to a different activity. This option is applicable to dialing

sessions with agent-assignment enabled and with the agent-reassignment-if-waiting-ports
option set to true.

agent-reassignment-if-waiting-records

Default Value: no/false

¢ Valid Values: yes/true, no/false

* Configuration Level: Campaign Group, Application

¢ Changes Take Effect: Immediately

¢ Logical Group: Dynamic Agent Assignments
When set to true, OCS reassigns all agents from this Campaign Group to other activities when there
are no available dialing records for the Campaign Group, and the duration of the "waiting records"

condition has surpassed the time set in the agent-reassignment-if-waiting-records-timeout
option. This option is applicable to dialing sessions with agent-assignment enabled.

agent-reassignment-if-waiting-records-timeout

Default Value: 30

e Valid Values: A positive integer
e Configuration Level: Campaign Group, Application
e Changes Take Effect: Immediately

¢ Logical Group: Dynamic Agent Assignments

Specifies the timeout, in seconds, during which OCS waits to reassign agents from a Campaign Group
that has no available dialing records to some other activity. This timeout is not applicable if all agents
have been reassigned away from the Campaign Group and new records are retrieved into the dialing
buffers. This option is applicable to dialing sessions with agent-assignment enabled and with the
agent-reassignment-if-waiting-records option set to true.

all

Default Value: CallStats

Valid Values: A valid path and file name for the audit log

* Configuration Level: Application

Changes Take Effect: Immediately
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e Logical Group: Dialing Regulations
Specifies a full path to the Audit Log flat file, including the filename without the extension.

This option is configured in the log-call-stats

—_— section.

am-beep-detection

¢ Default Value: no/false

Valid Values: yes/true, no/false
* Configuration Level: Campaign Group, Application

¢ Changes Take Effect: Immediately

Logical Groups: GVP, Outbound Contact VolP Dialing Modes

Specifies whether GVP is forced to detect an answering machine beep tone before playing music or
starting the VoiceXML application in certain Outbound VolIP dialing modes, specifically Power GVP,
Progressive GVP, Progressive with Seizing (ASM) and Predictive with Seizing (ASM).

* When set to true, GVP delays playing music or starting the VoiceXML application until the beep tone is
detected.

* When set to false, GVP starts playing music or executing the VoiceXML application immediately after
the answering machine is detected. This may result in the message being played before the beep tone,
which is the indication for the answering machine to start recording. Depending on the length of the
message, the answering machine may not record all or any of the message.

am-detection-map

Default Value: An empty string ("")

Valid Values: A name of a Business Attribute value configuration object, or default

¢ Configuration Level: Calling List, Application

Logical Group: Dialing

Specifies the name of the Business Attribute value configuration object that contains the AM-
detection map to be used for a particular Calling List or to be used application-wide. See Per-Record
Basis for more information.

Dependency: If the CX Contact option custom-format is configured, OCS does not support the am-

detection-map option for all custom CX Contact fields (0ther21+) and fields
c _otherl,..,c other20.

am-drop-field

e Default Value: An empty string

¢ Valid Values: * (asterisk) OR <field name>:<valuel>[,<value2[,value3]...], where:

Outbound Contact Deployment Guide 233



Outbound Contact Configuration Options Outbound Contact Server Options

* (asterisk) is any value
* <field name> is the name of the field in the Calling List
e <valuel>[,<value2[,value3]...] is an optional comma-separated list of values for this field
For example:
* am-drop-field = *
* am-drop-field = cd device index:2,3,6
e Configuration Level: Calling List (higher priority), Campaign Group, Application

¢ Changes Take Effect: When the next record is retrieved from the Calling List table

Logical Groups: Dialing
e Introduced: 8.1.517.04

Specifies how OCS handles an outbound call on a particular device when the call is placed in any
auto-dialing mode and Answering Machine (AM) is detected. Any existing field from the Calling List
(including user-defined) can be used. If the field with the configured field name exists in the Calling
List, OCS checks the value of the field for each record. A record is marked to be handled in
accordance with the configured value. The specified field is not required to have send _attribute
configured. If the option is set to * (asterisk), all calls to the detected AM will be dropped.

Dependency: If the CX Contact option custom-format is configured, OCS does not support the am-
drop-field option for all custom CX Contact fields (0ther21+) and fields ¢ otherl,..,c other20.

asm_channel_num

¢ Default Value: 0

¢ Valid Values: 0 or a positive integer less than the Number of CPD Ports property of the Campaign
Group

e Configuration Level: Campaign Group
¢ Changes Take Effect: Immediately
e Logical Group: ASM Dialing

Specifies the maximum number of engaging ports that can be used by the given Campaign Group.
This option always works in pair with the Number of CPD Ports property which is defined on the
Advanced tab of Campaign Group configuration object. OCS considers the Number of CPD Ports to
be the total number of ports available to the Campaign Group, for example, the sum of engaging
ports and ports for outbound dialing. The following table summarizes OCS behavior for different
variations of the CPD Ports setting:

OCS Behavior and CPD Port Configuration
CPD port configurations Number of CPD ports = 0 Number of CPD ports > 0

No restriction on the number of
engaging ports (although they
must not be greater than
'Number of CPD Ports' property).

asm_channel num = 0 No restrictions.
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Both the engaging ports and the
ports for outbound dialing are
restricted.

Only the number of engaging

CEI EEIEL [ = @ ports is restricted.

This option can be used with hardware configurations that use a separate pool of engaging lines
(ports for agent engagement). See the CPD Server use-engaging-lines option which controls
engaging mode of CPD Server. This option can also be useful for blended environments to limit the
number of agents being engaged and thus allocate some portion of the agents to always be available
to handle inbound calls.

Assigning the asm_channel_num option with a
value of less than the number of agents available
Note: for the Campaign Group might cause an excessive
overdial rate if the classical Predictive Algorithm is
being used. See the predictive_algorithm option.

asm_drop_am_announcement_data

CPD Server SIP Server

Default Value An empty string ("") none

Path to the file in the VOX format A prompt ID for an

Valid Values announcement, as configured in

() GVP Media Control Platform
Configuration Level Campaign Group, Application Campaign Group, Application
Changes Take Effect Immediately Immediately
Logical Groups Dialing Regulations, ASM Dialing Dialing Regulations, ASM Dialing

¢ (For ASM modes only) Specifies the message to be played if an answering machine is detected before
releasing the established customer call in the ASM modes.

The values differ depending on whether you use CPD Server or SIP Server, as follows:
e (For CPD Server) The full name (including the path) to the file (in the VOX format). CPD Server plays this
announcement and then releases the established customer call because either of the following occurs:
e The customer leg could not be bridged with the engage call leg

* No destination DN is specified for bridging answering machine detected calls.

e (For SIP Server) The Prompt ID for the message, as configured in GVP Media Control Platform. For more
information on the Prompt ID, see the GVP documentation.

This option can be used with the asm_drop_announcement_data option. While the
asm_drop_announcement_data option instructs OCS to play the same announcement for all call
results, using both options allows CPD Server to play a different announcement for Answering
Machine call results than for Answer call results.

Note: This option, added in OCS 7.6.101.04, can only be
' used in the Active Switching Matrix (ASM) mode.
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asm_drop_announcement _data

CPD Server SIP Server
Default Value An empty string ("") none
Path to the voice file (including A prompt ID for an
Valid Values the name) in the VOX format announcement, as configured in
(string) GVP Media Control Platform
Configuration Level Campaign Group, Application Campaign Group, Application
Logical Groups Dialing Regulations, ASM Dialing Dialing Regulations, ASM Dialing

Specifies the message to be played before releasing the established customer call in the ASM modes.

If the established customer leg of the call has to be released by CPD Server or SIP Server (in an
Outbound-IP environment) because it could not be bridged with the agent engaging call leg, a
predefined announcement to the customer can be used before the call is released.

The values are as follows: For CPD Server--The full name (including the path) to the file (in the VOX
format) with the announcement that OCS provides to CPD Server for all call results.

CPD Server must be able to access this network

i path so that this file can be used.

If no value is specified, OCS does not add the 0CS DROP_ANNOUNCE DATA attribute to the extensions
parameter of the Outbound Contact Server RequestMakePredictiveCall event.

If a value is specified, the full path to the voice file will be used by CPD Server in the following
extensions parameter of the Outbound Contact Server RequestMakePredictiveCall event:

0CS _DROP_ANNOUNCE DATA
Data Type: String
Contains the full name of the voice file in .vox format.

CPD Server will play the specified file before releasing the established customer call. If CPD Server
successfully opens the file specified in the 0CS_DROP_ANNOUNCE DATA attribute, it prints a dx_playvox
success message to the log file. If there was an error, a dx_playvox failed message is printed in
the log file.

For SIP Server--The Prompt ID for the announcement, as configured in GVP Media Control Platform.
For more information on the Prompt ID, see the GVP documentation.

This option can be used with the asm _drop_am_announcement data option. The
asm_drop_am_announcement_data option instructs OCS to play the same announcement for
Answering Machine call results, while the asm_drop_announcement_data option instructs the
component to the same announcement for all other call results.

When using Trunk Group DNs in an Outbound-IP
environment, OCS uses the standard

Note: TApplyTreatment event with a MUSIC DN
parameter, according to SIP Server requirements.
In this scenario, OCS releases the call only after the
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announcement is played, which occurs when it has
received EventTreatmentEnd from SIP Server.

assured-connect

¢ Default Value: false

e Valid Values: false, true

e Configuration Level: Individual record and chain of records (via SCXML), Campaign Group, Application

¢ Changes Take Effect: Immediately

e Logical Groups: Dialing, ASM Dialing
At the Campaign Group or Application level, this option enables/disables assured (guaranteed)
connection for a specific Campaign Group or the entire OCS application:

¢ When set to false, OCS does not apply assured connection to any record.

¢ When set to true, OCS applies assured connection to an individual record or a chain based on the
assured-connect-field option and/or the assured-connect option that is set using the
set flex attr custom action of the SCXML treatment. See Setting Options for Individual Records or
Chain of Records for more information about custom actions.

assured-connect-field

e Default Value: Empty string

¢ Valid Values: field name:[:1list of values], where:

field name Name of a field in the Calling List.

An optional comma-separated list of values for this

list of values field.

e For example: is_assured:yes,true or is assured:1,2,4
e Configuration Level: Calling List, Campaign, Application

¢ Changes Take Effect: When record is retrieved from the Calling List table

Logical Groups: Dialing, ASM Dialing

If the field with the configured field name exists in the Calling List, OCS checks the value of the field
for each record. A record is marked for assured connection if either of the following conditions are
met:

e The value in the field matches exactly one of the values given in the list of values.
e The value in the field is not NULL or zero (0) and the list of values is empty.
Dependency: If the CX Contact option custom-format is configured, OCS does not support the

assured-connect-field option for all custom CX Contact fields (0ther21+) and fields
c_otherl,..,c other20.
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beep-on-merge

¢ Default value: false

e Valid Values: yes/true, no/false

e Configuration Level: Campaign Group, Application

e Changes Take Effect: Immediately

e Logical Groups: Outbound Contact VolIP Dialing Modes, ASM Dialing

Enables the playing of a beep tone to the agent on the engaging call immediately before the agent is
bridged to the customer call when running in Outbound VolP dialing modes.

call_answer_type_recognition

Default Value: no_am detection

Valid Values: no_progress detection, no_am detection, positive am detection,

full positive am detection, accurate am detection, telephony preset

e Configuration Level: Individual record and chain of records (via SCXML), Campaign Group, Application

Logical Group: Dialing

Specifies answer, answering machine, and fax detection settings when dialing using CPD Server, SIP

Server, or OBN Manager.

Note:

This option does not apply when OCS uses T-Server
for dialing and PBX equipment for call progress

detection.

The values are as listed in the following table:

Option Value

no_progress _detection

Note: The
call_answer_type_recognition option
cannot be set to no progress detection
on DM3 hardware because of line-side
PDK protocol restrictions.

no_am detection

Option Value Description

Non-IP Outbound Environment
Description

Disables call progress detection,
and the call is transferred as
soon as it is established.

Disables answering machine
detection but detection of all
other devices is still enabled.

Outbound-IP Environment Description

No SIT, answering machine, or
fax tone is detected; the call is
connected, as if it were answered
by an actual person.

Note: If a SIP error message contains the
call result with SIT tone information (for
example, if a carrier sends the SIT
Invalid number call result in the SIP
error message “404 Not Found”), the
information can be used as a detected
tone despite the

no_progress detection option setting.

SIT and fax tones are detected
but answering machines tones
are not; if no SIT or fax tone is
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positive am detection

Note: This value works only with
tape-based answering machines.
It does not work with modern
digital answering machines.

full positive am detection

accurate am detection

telephony preset

call_timeguard_timeout

¢ Default Value: 0 (milliseconds)

Enables standard answering
machine detection (Positive
Answering Machine [PAM] mode).

Enables full positive answering
machine detection (Full Positive
Answering Machine [FPAM]
mode).

Enables or disables detection,
based on an analysis of the
duration of the greeting.

Causes the same behavior as the
no_am _detection value. If the
user selects telephony preset,
this value is automatically
converted to the
no_am_detection value.

Valid Values: 0. . .<n> (milliseconds)

* Configuration Level: Campaign Group, Application

Logical Groups: Dialing Regulations, Dialing

detected, the call is connected as
if it were answered by an actual
person.

SIT, answering machine, and fax
tones are detected; answering
machine detection should be
performed with default
parameters for Media Gateway or
Media Server.

SIT, answering machine, and fax
tones are detected; answering
machine detection is performed
with the highest probability of
live voice detection, if supported
by Media Gateway or Media
Server. If it is not supported, this
value functions in the same way
as the positive am detection
value.

SIT, answering machine, and fax
tones are detected; answering
machine detection is performed
with the highest probability of
answering machine detection, if
supported by Media Gateway or
Media Server. If it is not
supported, this value functions in
the same way as the
positive am detection value.

Tones are detected in accordance
with the default configuration for
SIP Server and Media Gateway.

Enables a user to set a timeout for post-connect call progress detection. The call is transferred to a
queue when the timeout expires, regardless of the call result or the completion of call progress
detection. The timeout is calculated from the moment that CPD Server receives an
EventEstablished message. If this option is set to 0 (zero) or if it is not present, CPD Server does not
break call progress detection.

This option applies when OCS uses SIP Server, CPD

i Server or OBN Manager for dialing. It does not
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apply when OCS uses T-Server for dialing and PBX
equipment for call progress detection.

You must specify a value greater 0 for this option when
configuring Trunk Group DNs in an Outbound-IP environment.
For more information about Outbound-IP environment
requirements, see Outbound VoIP Deployment.

call _transfer_type

e Default Value: one _step
e Valid Values: one_step, two step
» Configuration Level: Campaign Group, Application

e Logical Group: Dialing

Specifies the transfer type that the dialer (CPD Server or OCS) use for outbound calls. This option
applies when OCS uses CPD Server or for two-step transfers in Outbound IP environment (see
Outbound VoIP Deployment). It does not apply when OCS uses PBX equipment for call progress
detection.

For an environment using CPD Server as the dialer, CPD Server translates the one step value as
either mute or single_step depending on the switch that is being used; check your switch
documentation.

The two_step value is commonly used to overcome some switch transfer issues such as ring splash
on a Meridian switch. Ring splash occurs when a dialer transfers a connected call to an agent, and
the caller hears a ringback before he or she hears the agent answer. For some switches, this ringback
cannot be turned off, either by a command in the CTI link or by a switch setting.

As a workaround to this situation, Genesys uses a two-step transfer. In a two-step transfer, the switch
puts the original leg of the call on hold and starts to initiate a transfer. For a moment, the caller hears
silence or music depending on whether the music on hold feature is enabled on the trunk or queue.
For the second leg of the call, the Origination DN (usually a queue), as defined in the Campaign
Group, is dialed. The transfer process is complete when an agent answers the call. The

call_wait in_queue_timeout option is a timer and the value determines how long the call should wait
(in the queue) before an agent answers. If the timer expires, the dialer drops the call, and the record
is marked with the Dropped call result.

Genesys recommends turning off the music on
Note: hold feature on the trunk or queue when using a
two-step transfer.

call_wait_agent_connected_timeout

Default Value: 6 (seconds)
¢ Valid Values: A positive integer

e Configuration Level: Campaign Group, Application

Logical Group: Dialing
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Specifies the timeout, in seconds, from the time the engaging call is dialed to the time the call is
answered by an agent. This timeout applies only to engaging calls in ASM mode; that is, calls that
engage an agent before the customer answers. If the agent answers the call, the agent is seized for

that call. The value of this option indicates how long to wait for an agent to be seized after dialing
that agent.

This option applies when OCS uses CPD Server for
Note: dialing. It does not apply when OCS uses T-Server
’ for dialing and PBX equipment for call progress
detection.

call_wait_connected_timeout

¢ Default Value: 120 (seconds)

Valid Values: 0-7200 (seconds)

* Configuration Level: Campaign Group, Application

Logical Group: Dialing

Specifies the timeout upon of expiration of which dialer should consider that call is not answered by
call party. When OCS is dialing calls through CPD Server or OBN Manager:

¢ For ISDN: Specifies the timeout, in seconds, between dialing and the determination that the called party
is not answering.

e For analogue and line-side DNs: Specifies the timeout between the first ring and the determination that
the called party is not answering.

When OCS is dialing calls through T-Server or SIP Server:

¢ The value of this option is passed to the T-Server as an AttributeTimeout in the MakePredictiveCall
message. The timeout value received in the request has a higher priority than T-Server's own options,
and it is used to set up the duration of the No Answer interval on the switch.

e Set the value between 6 and 99 when using the Aspect switch classification board. The default value of

120 causes the RequestMakePredictiveCall requests sent by OCS to fail because the switch accepts
only two digit values.

¢ For a VoIP environment in which SIP Server is used for dialing, the maximum value of this option is 32
seconds for all dialing modes. It can be set to a higher value if the predictive-timerb-enabled option
is disabled on SIP Server, but additional settings might need to be applied to SIP Server and Genesys
Media Server (MCP) to accommodate the higher value. For more information, see the "Increasing
Ringing Period for Predictive Calls" chapter in the SIP Server Deployment Guide. To ensure accurate
reporting of T-Library attributes, set the call_wait_connected_timeout option to the value of less
than 32 seconds in the VoIP environment.

call_wait_in_queue_timeout

¢ Default Value: 10 (seconds)
¢ Valid Values: A positive integer

e Configuration Level: Campaign Group, Application
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e Logical Group: Dialing

Specifies the maximum amount of time, in seconds, that an outbound call is allowed to stay in a
queue. This option applies when OCS uses CPD Server or for two-step transfers in an Outbound IP
environment (see Outbound VolP Deployment).

For CPD Server usage, after this timeout expires,
CPD Server can release the call only when the two-

Note: step transfer is used (see the call transfer type
option, and CPD Server controls the consult leg of
the transferred call.

call_wait_original_establish_timeout

¢ Default Value: 4 (seconds)

Valid Values: A positive integer or 0

e Configuration Level: Campaign Group, Application

Logical Group: Dialing

Specifies the timeout, in seconds, between the end of a positive call progress detection response
from Dialogic—such as Answer, Answering Machine (AM), or Cadence Break—and an
EventEstablished from T-Server.

This option applies only when OCS uses CPD Server. It does not apply when OCS uses PBX equipment
for call progress detection.

callback-observe-campaign

¢ Default Value: true

Valid Values: true/yes, false/no
e Configuration Level: Campaign, Application
¢ Changes Take Effect: When Campaign Group is loaded
¢ Logical Group: Record Processing
When set to true, OCS will use the Campaign DBID when retrieving callbacks and rescheduled

records. That is, only records scheduled by the given Campaign will be retrieved. When set to false,
OCS will retrieve records previously scheduled by any campaign.

callback-observe-group

Default Value: no/false
¢ Valid Values: yes/true or no/false
* Configuration Level: Campaign, Application

¢ Changes Take Effect: Upon loading of the Campaign Group
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e Logical Group: Record Processing

Specifies whether OCS should select Personal Callbacks and Personal Rescheduled records from the
Calling Lists based on both the Campaign DBID and the Group DBID or just the Campaign DBID. If
these records are selected based on both DBIDs, then it is guaranteed that they will be processed by
the same group to which the agent belonged when these records where initially scheduled.

¢ When set to true, OCS selects them based on the Campaign DBID and the Group DBID.
¢ When set to false, OCS selects them based on the Campaign DBID only.

In a scenario in which one or more Campaign
Groups share the same Campaign, and thus the
same Calling Lists, OCS updates the group id field
in the list with the current Group DBID, in addition
to the campaign_id, when records are marked as
Retrieved. The ability to identify the Campaign
Group name associated with personal records is
only available for Calling Lists that have the
group_id field included in the format. To maintain
backward compatibility with Calling Lists using
format 6, OCS checks the format for the group _id
field and the callback-observe-group option. If
format 6 is being used, the group-id field is not
updated and OCS ignores this option value.

Note:

caller-id-sets

¢ Default Value: An empty string

Valid Values: A comma-separated list of Script object names (Caller ID sets)
e Configuration Level: Campaign Group

¢ Changes Take Effect: Upon Campaign Group activation, for example, when the Campaign Group is
loaded

* Logical Groups: Dialing

Specifies a comma-separated list of Script object names (Caller ID sets). It may contain zero, one, or
more names of Script objects. Processing is similar to how OCS processes treatment options at the
Campaign Group level.

caller-id-rotation

e Default Values: asc

Valid Value: asc, desc, random
¢ Configuration Level: Campaign Group

¢ Changes Take Effect: Upon Campaign Group activation, for example, when the Campaign Group is
loaded

¢ Logical Groups: Dialing
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Specifies the method of Caller ID rotation. The Campaign Group rotates through the available pool of
Caller IDs for each phone number. Each time an attempt is made per number, the next available
Caller ID from the pool is selected and used as CPNDigits for the call attempt.

¢ When set to asc—sequential, in ascending order—OCS selects the next Caller ID per ASC order defined
by option names (integer values).

¢ When set to desc—sequential, in descending order—OCS selects the next Caller ID per DESC order
defined by option names (integer values).

* When set to random, OCS selects a random Caller ID from the pool.

campaign-callback-distr

» Default Value: random

e Valid Values: random, equal-from-zero, or equal-from-avg
¢ Configuration Level: Campaign Group, Application

¢ Changes Take Effect: Immediately

* Logical Groups: Agent Desktop, Dialing

Specifies how campaign callbacks are distributed to agents when the predictive callback option is set

to false and campaign callback notifications are distributed as UserEvents. The option values that
define this distribution are as follows:

e For the random value, OCS randomly distributes callbacks between eligible agents, as it did previously.

e For the equal-from-zero or equal-from-avg values, OCS monitors the actual number of campaign
callbacks distributed to each agent in the campaign group from the moment the dialing session/
campaign group is loaded until it is unloaded. When OCS needs to distribute new campaign callback, it
selects an agent who has processed the fewest number of campaign callbacks since the dialing
session/campaign group was loaded. If two or more agents have processed the same minimum
number, an agent is selected randomly from among them.

If an agent logs out of the group, OCS clears the agent's history, including the number of callbacks
processed. When an agent logs into the group, OCS assigns the number of callbacks processed by

this agent, as follows:
e If you set the value to equal-from-zero, OCS assigns 0 as the number of callbacks processed.

If you set the value to equal-from-avg, OCS assigns the average number of callbacks processed by
agents in the group. You might use this value in a scenario in which an agent logs in for the first time at
mid-day and want to ensure that all agents receive callback requests. Otherwise, this new agent would
receive all requests until he or she reached the group average.

campaigngroup-auto-complete

e Default Value: An empty string
e Valid Values: no-records

e Configuration Level: Campaign Group, Application
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¢ Changes Take Effect: Immediately
e Logical Group: Record Processing
e Introduced: 8.1.528.25

If set to no-records, OCS automatically completes (stops and unloads) a Campaign Group when all
dialing records are depleted for it.

campaigngroup-preload-uri

¢ Default Value: An empty string

e Valid Values: A valid URI

e Configuration Level: Application

¢ Changes Take Effect: At the next activation of the schedule item

e Logical Groups: CX Contact, Outbound Schedule

Specifies the URI of the external system (Campaign Manager) to which OCS sends Campaign Group
pre-load requests.

campaigngroup-states-interval

Default Value: 10

¢ Valid Values: 0 (zero), a positive integer

* Configuration Level: Campaign Group, Application

¢ Logical Group: CX Contact, HTTP-based Notifications

e Changes Take Effect: Next attempt to send notification to Web or Application server
Defines the time interval (in seconds) for sending periodic Campaign Group state notifications. If this
option is set to zero (0), no periodic notifications are sent. (Notifications for Campaign Group state

changes continue to be sent). For more information about this feature, refer to Campaign Group
Status Reporting.

campaigngroup-states-uri

Default Value: No default value
¢ Valid Values: A valid URI

e Configuration Level: Campaign Group, Campaign, Application

Logical Group: CX Contact, HTTP-based Notifications

¢ Changes Take Effect: Next attempt to send notification to Web or Application server

Specifies the URI of the Web or Application server to which the Campaign Group status information is
being sent. For more information about this feature, refer to Campaign Group Status Reporting.
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campaign_name_field

Default Value: An empty string ("")

Valid Values: A valid field name from the Calling List table with an appropriate data type to store the
campaign name.

* Configuration Level: Calling List, Application

Logical Group: Record Processing

All calling list records in Genesys Administrator and the Calling List table include the campaign name
and the campaign ID. OCS stores the campaign name in a user-defined field in the Calling List table.
This option specifies the name of that field in the Calling List table. If the value of the
campaign_name_field option is any string (not an empty string), when OCS updates the
campaign id field with the DBID of the campaign, it also updates the field specified by this value with
the name of the campaign.

Note: Misuse of this option can cause statements from
’ OCS to fail on a SQL Server.

cancel-on-desktop

¢ Default Value: true

Valid Values: true, false

¢ Configuration Level: Campaign Group, Application
¢ Changes Take Effect: Immediately

e Logical Group: Agent Desktop

Specifies how OCS behaves when it receives a RequestRecordCancel request but finds records on an
agent's desktop that have the specified phone or the customer ID.

* When set to true, OCS finalizes these records as cancelled when it receives a RequestRecordCancel
request.

* When set to false, OCS does not finalize records on an agent's desktops as cancelled when it receives
RequestRecordCancel request. As a result, agents can complete calls and their associated record that
are still in progress, rather than being locked out the record.

OCS also notifies the RequestRecordCancel requester (agent desktop or third party application) in
the RecordCancelAcknowledge response about the inability to handle cancellation request
completely. The GSW_MESSAGE attribute displays the following message: "Incomplete processing:
record(s) on desktop."

This functionality does not affect
RequestRecordCancel requests made by the

Note: record handle or any DoNotCall requests.

GSW_MESSAGE is not a new attribute to the desktop protocol, but
it is for third-party protocol.
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channel_num

Default Value: 0 (Switch Level); 40 (Application Level)

Valid Values: 0 or a positive integer
e Configuration Level: Switch, Application

e Logical Group: Dialing

Specifies the total number of available channels (CPD ports) to be used by a Campaign Group or on
the switch when using the Predictive or Progressive dialing mode.

¢ If OCS dials a call through T-Server, the value of this option is taken from the Options tab of the Switch
object.

e If OCS dials through CPD Server, the option is not used. OCS derives the proper number of CPD ports
directly from CPD Server through the protocol events.

This option works as follows:

1. Before requesting the next call from T-Server, OCS calculates the number of busy channels on the
switch.

2. OCS dials an outbound call when the number of busy channels is less than the value specified for the
channel_num option.

If the default value 0 (zero) is assigned to channel_num, there are no restrictions on the switch, and
OCS dials continuously.

For the dynamic allocation of ports among
Campaign Groups running in a VoIP environment,
OCS uses the total number of ports, which is

Note: reported by SIP Server in the total-ports
parameter of EventResourcelnfo messages, instead
of the channel_num option that is defined for a
Switch object.

check _dnc_callback

Default Value: no/false

e Valid Values: yes/true, no/false

» Configuration Level: Application

¢ Changes Take Effect: Immediately

e Logical Groups: Dialing Regulations, Dialing
Enables or disables a special predial check of callback records against the Do Not Call (DNC) List. This
option applies to the Personal CallBack, Campaign CallBack, and Personal Rescheduled record types.
The value set for this option determines whether a scheduled call is processed or not processed,
depending at which time the DNC restriction was applied.

If the option is set to yes or true, OCS identifies the record type and, after comparing the
timestamps, determines whether the DNC restriction was applied after or before a customer agreed
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to a scheduled call from an agent:

e If after, OCS processes the call.

 |If before, OCS does not process the call.
See also DNC Rule for Scheduled Calls.

The check_dnc_callback option works only if the check_dnc_list option is set to true. If you set
check_dnc_callback to true, it may override check_dnc_list = true for the Personal CallBack,
Campaign CallBack, or Personal Rescheduled records, based on the timestamp comparison.

DNC Rule for Scheduled Calls

The purpose of the Do Not Call (DNC) rule for scheduled calls is to determine whether a Personal
CallBack, Campaign CallBack, or Personal Rescheduled record can be dialed even though the phone
number or customer ID on the record is on the DNC List. The callback might be permissible, for
example, if both of the following conditions are met:

* The check_dnc_callback option is set to true, which enables OCS to perform a predial check of
callback type records.

¢ The customer had requested a callback before submitting a DNC request.
The algorithm for the predial check is as follows:

1. OCS checks the DNC List to determine whether the record to be dialed is on it.
2. If yes, OCS reads the value of the check dnc_callback option:
* If check_dnc_callback = false, OCS dials the record.

* If check_dnc_callback = true, OCS continues the predial check.

3. OCS checks the record type:
e If the record type is not a callback, OCS marks the record DNC. End of predial check.

» If the record type is Personal CallBack, Campaign CallBack, or Personal Rescheduled, OCS continues
the predial check.

4. OCS checks the time stamp:

e If the timestamp of the original call (when the callback was scheduled) precedes the timestamp of
the DNC request, OCS will dial the callback record. End of predial check.

* It the timestamp of the original call does not precede the timestamp of the DNC request, OCS will
not dial the callback record. End of predial check. The following figure shows the algorithm for the
DNC rule for scheduled calls.
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DNC Rule for Scheduled Calls

check_dnc_list

Default Value: yes/true

Valid Values: yes/true, no/false
e Configuration Level: Campaign, Application

e Changes Take Effect: Immediately

Logical Groups: Dialing Regulations, Dialing
Enables or disables a predial check against the Do Not Call list for all types of records.

e |If you set this option to yes or true or if the option is not defined in the configuration, OCS performs a
predial check against the Do Not Call (DNC) List.

 If this option is set to no or false, OCS dials without performing a predial check.
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When set to false, OCS also does not check any
records that are already delivered to an agent's
desktop against the phone number (or

Note: customer_id) in the newly submitted request (by
phone or customer_ id respectively). Therefore,
OCS does not issue a RecordCancel notification to
the desktop.

contact-processed-notification

» Default Value: false

* Valid Values: true/false, yes/no

e Configuration Level: Application, Campaign Group
e Changes Take Effect: Immediately

e Logical Group: HTTP-based Notifications

e Introduced: 8.1.528.21

Controls whether OCS generates contact-processed notifications for the chains in a given Campaign
Group.

contact-processed-notification-uri

e Default Value: An empty string

¢ Valid Values: The URI of the remote Web or Application Server with HTTP or HTTPS scheme
* Configuration Level: Application, Campaign Group

¢ Changes Take Effect: Immediately

¢ Logical Group: HTTP-based Notifications

e Introduced: 8.1.528.21

Specifies the URI of the remote Web or Application Server with an HTTP or HTTPS scheme. If set to an
empty string, OCS does not attempt to send any notification, similar to pre-dial validation.

conversion

e Default Value: ""

¢ Valid Values: Any value that can be stored in the field for which this option is configured
¢ Configuration Level: Field

¢ Changes Take Effect: Immediately

e Logical Group: Historical Reporting

Marks the field that indicates that the answered call was a successful transaction. If it is updated with
a value equal to what is configured in this option's value, it will be recognized by Genesys Info Mart
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as a conversion indicator.

This option should be specified for only one field

Note: within a calling list.

cpd-on-connect

¢ Default Value: false

Valid Values: yes/true, no/false

¢ Configuration Level: Campaign Group, Application

e Changes Take Effect: Immediately

e Logical Groups: Outbound Contact VolP Dialing Modes, Dialing
Specifies when call progress analysis is started in Outbound VolIP dialing modes. If value is set to no/
false, OCS instructs Media Server to start call progress analysis as soon as the media stream is

available. If set to yes/true, OCS instructs Media Server to delay call progress analysis until the call
is answered.

cpd-recording

* Default Value: false

e Valid Values: yes/true, no/false

¢ Configuration Level: Campaign Group, Application

¢ Changes Take Effect: Immediately

* Logical Groups: Outbound Contact VolP Dialing Modes, Dialing

(For VolIP dialing modes) Enables or disables the recording of the call progress detection phase of the
call. If value is set to no or false, the recording is disabled; otherwise it is enabled.

CPNDigits

¢ Default Value: Empty string

e Valid Values: String of characters, according to the formats specified in the appropriate numbering/
dialing plan.

e Configuration Level: Individual record and chain of records (via SCXML), Calling List, Campaign Group,
Application

e Logical Groups: Dialing Regulations, Dialing

Specifies the Calling Party Number (CPN).

The SCXML setting at the chain/record level has a higher

Notes: priority.
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e Starting in release 8.0.001, this option can be

configured for individual records or chain-of-
records to enable fine-tuning of record
processing. Unlike other options, which can be
configured at the individual record level in the
Business Attributes object, this option is defined
using SCXML treatments, which provides
greater flexibility in the calculation of the option
value and enables the definition of complicated
business logic, based on that calculation. For
example, record property, time of day, day of
the week, or any other parameter that can be
calculated inside the SCXML treatment
executable content (JavaScript) can now affect
the value of this option.

e Starting in release 7.6, this option can be

applied to a campaigns running in Proactive
Contact (Power GVP or Progressive GVP) mode.
Its value can be passed to OBN Manager if GVP
7.5 or 7.6 is used or SIP Server if GVP 8.0 or
later is used.

For more information about the Caller ID Support feature and the CPN options, see the following

resources:

¢ Extensions related to TMakePredictiveCall() in the "Extensions" section of the "Unstructured Data"
chapter in the Genesys Developer Program T-Library SDK Developer's Guide

* Framework T-Server for Alcatel A4400/OXE Deployment Guide

e Framework T-Server for Avaya Communication Manager Deployment Guide

¢ Q.931 ISDN user-network interface layer 3 specification for basic call control

CPNDisplayName

¢ Default Value: An empty string ("")

Valid Values: Any string

e Configuration Level: Individual record and chain of records (via SCXML), Campaign Group, Application

¢ Changes Take Effect: Immediately
¢ Logical Group: Dialing

Defines the value of the DisplayName attribute used by SIP Server, for which its behavior is identical
to its own display-name option setting. This option takes effect only when OCS is dialing using SIP

Server or using CPD Server in HMP Transfer mode.

CPNPlan

e Default Value: 0
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¢ Valid Values: 0-15
¢ Configuration Level: Campaign Group, Application

e Logical Group: Dialing

Specifies the decimal representation of the Numbering Plan code.

CPNPresentation

e Default Value: 0
e Valid Values: 0-3
e Configuration Level: Campaign Group, Application

e Logical Group: Dialing

Specifies the decimal representation of the Presentation Indicator code.

CPNScreening

e Default Value: 0
Valid Values: 0-3

e Configuration Level: Campaign Group, Application

Logical Group: Dialing

Specifies the decimal representation of the Screening Indicator code.

CPNType

e Default Value: 0
Valid Values: 0-7

e Configuration Level: Campaign Group, Application

Logical Group: Dialing

Specifies the decimal representation of the Type of Number code.

customer _id

e Default Value: An empty string ("")

identifier>
¢ Configuration Level: Campaign, Application

e Logical Group: CX Contact, Dialing

Valid Values: <The name of a user-defined field in the calling list to serve as a customer
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Specifies a user-defined field in the Calling List table that will serve as a customer identifier.

When this option is not present in the Application object, or if the value of this option is the name of
a field that does not exist in the Calling List table, OCS uses the phone number in order to
determine which records cannot be dialed.

e Configuring customer ID at the Campaign level
allows you to define distinct customer ID fields
for different campaigns.

e The Field configuration object that is used as
the value for the customer_id option must
specify the send attribute key-value pair
listed on its Options tab. The section name is
created according to the section naming
convention that is described in the Section
Names topic. The value of the send attribute
key-value pair must be GSW_CUSTOMER ID. For
more information, see Attaching Record
Information to Desktop and OCS User Events in
the Outbound Contact Reference Manual.

Notes:

e This option can be used to identify the customer
for both Do Not Call requests and Record
cancellation requests. For more information
about its use for Do Not Call requests, see User-
Defined Field for Do Not Call. For more
information about its use for Record
Cancellation requests, see Record Cancellation
Requests and Customer ID.

db-stat-recalc-interval

» Default Value: 180
e Valid Values: Integers from 5 to maximum integer
¢ Changes take effect: Immediately
e Configuration Level: Campaign, Application
* Logical Group: Real-Time Reporting
e Introduced: 8.1.300.18
Specifies the frequency, in seconds, of Reporting Stored Procedure execution. In cases where the

Reporting Stored Procedure is still executing when the time comes to execute it again, that execution
is skipped.

Overly frequent executions of the Reporting Stored
Procedure might affect the performance of the
database, which stores calling lists, and so might
affect OCS dialing.

Note:
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default_campaigncallback_priority

Default Value: 1;1

Valid Values: Any two non-negative integers separated by a semicolon.
¢ Changes Take Effect: After Campaign is reloaded and restarted.

e Configuration Level: Application, Campaign, or Campaign Group

Logical Group: Prioritization of Record Types

Specifies the priority of record types and the number of records to fetch for dialing. The two numbers
that make up the value of the option are divided by a semicolon and represent the following two
parameters:

e priority: 1 is the highest priority; 0 (zero) means do not dial. Recommended values are 0 (zero), 1, 2,
or 3.

* n_records: A valid value is any positive number or 0 (zero). 0 (zero) means do not dial.

See Flexible Prioritization of Record Types for more information.

default_campaignrescheduled_priority

Default Value: 1;1

Valid Values: Any two non-negative integers separated by a semicolon.
¢ Changes Take Effect: After Campaign is reloaded and restarted.

e Configuration Level: Application, Campaign, or Campaign Group

Logical Group: Prioritization of Record Types

Specifies the priority of record types and the number of records to fetch for dialing. The two numbers
that make up the value of the option are divided by a semicolon and represent the following two
parameters:

e priority: 1 is the highest priority; O (zero) means do not dial. Recommended values are 0 (zero), 1, 2,
or 3.

* n_records: A valid value is any positive number or 0 (zero). 0 (zero) means do not dial.

See Flexible Prioritization of Record Types for more information.

default_general_priority

e Default Value: 1;2
¢ Valid Values: Any two non-negative integers separated by a semicolon.

¢ Changes Take Effect: After Campaign is reloaded and restarted.
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e Configuration Level: Application, Campaign, or Campaign Group
e Logical Group: Prioritization of Record Types
Specifies the priority of record types and the number of records to fetch for dialing. The two numbers

that make up the value of the option are divided by a semicolon and represent the following two
parameters:

e priority: 1 is the highest priority; O (zero) means do not dial. Recommended values are 0 (zero), 1, 2,
or 3.

* n_records: A valid value is any positive number or 0 (zero). 0 (zero) means do not dial.

See Flexible Prioritization of Record Types for more information.

desktop-chains-limit

e Default Value: 1

¢ Valid Values: Integer, from 1 to MAXINT

e Configuration Level: Agent Group, Application

e Changes Take Effect: Next Campaign Group activation

e Logical Group: Agent Desktop
Controls how many preview interactions can reside simultaneously at an agent's desktop. A preview
interaction is a chain of records delivered to an agent's desktop by a User Event, such as in Preview

mode, Direct Push Preview Mode, Personal Callback (in any mode), Personal Rescheduled (in any
mode), or Campaign Callback (if configured to be delivered as a User Event).

This option affects only delivery of interactions in
Direct Push Preview mode. This option does not

Note: limit interactions delivery in other modes, such as
Preview. This option also does not limit callbacks
and rescheduled records delivery.

dial_log_buffer

¢ Default Value: 16384 (bytes)
Valid Values: 2-32768

¢ Configuration Level: Calling List, Application
¢ Changes Take Effect: When the next dial log file is opened

Logical Group: Dial Log

Specifies the size of the buffer used for the Record History Log file output, and the frequency within
which OCS updates the History Log file.

The smaller the setting of the size limit for the OCS buffer, the more frequently OCS must empty the
buffer by unloading the data into the file.
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dial_log_delimiter

Default Value: An empty string ("")

e Valid Values: Any character combination

e Configuration Level: Calling List, Application

¢ Changes Take Effect: When the next dial log file is opened

e Logical Group: Dial Log
Specifies the delimiters that are used between the fields of the log for the calling list (the Record
History Log text file). Because the flat files are produced for this option, delimiters must be added to

the log. The default value is an empty string. If the value of the option is an empty string (string
length of 0), the ASCII TAB character (code 9) is used.

You can place this option in the OCS Application object or in a specific list. OCS first looks for the
option in the 0CServer section on the Options tab of a list. If it does not find the option there, it looks
on the Option tab (0CServer section) of the application object. For additional information, see Log
Options Defined.

dial_log_destination

e Default Value: An empty string ("")

¢ Valid Values: <directory path>

e Configuration Level: Calling List, Application

¢ Changes Take Effect: When the next dial log file is opened
e Logical Group: Dial Log

Specifies the path to the directory that stores a log for the calling list (the Record History Log text
file).

You can put this option in the OCS Application object or in a specific list. OCS first looks for the
option in the OCServer section on the Options tab of a list. If it does not find the option there, it looks
on the Option tab (OCServer section) of the Application object. If OCS still does not find the option,
then OCS does not maintain a log for the list. For additional information, see Log Options Defined.

dialer-num-attempts

* Default Value: 3
e Valid Values: 1-25
¢ Configuration Level: Campaign Group, Application

e Logical Groups: GVP, Dial Log

Specifies the number of attempts that OBN Manager will attempt to pass a request to the GVP dialer
(IPCS or VCS) for a dial from it's internal dialing queue.
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This option only applies when OCS uses OBN
Manager for dialing. It does not apply when OCS
uses T-Server for dialing and PBX equipment for
call progress detection.

Note:

dialer-ttl

Default Value: 5
¢ Valid Values: 3-1440

¢ Configuration Level: Campaign Group, Application

Logical Groups: GVP, Dialing

Specifies the Time To Live (in minutes) during which OBN Manager will attempt to pass a request to
the GVP dialer (IPCS or VCS) for a dial from it's internal dialing queue.

This option only applies when OCS uses OBN
Manager for dialing. It does not apply when OCS
uses T-Server for dialing and PBX equipment for
call progress detection.

Note:

dialing_rate_limit

Default Value: 100
e Valid Values: 0-N

e Configuration Level: Campaign Group, Switch, Application

Logical Group: Dialing

If configured at the Campaign Group or Application level, this option specifies the maximum number
of dialing requests per second. If set to 0 (zero), OCS does not dial at all.

If configured at the Switch level, this option specifies the maximum number of calls per second that
are shared between all Campaign Groups running in the auto dialing modes (Progressive, Predictive,
Progressive with seizing, Predictive with seizing, and Predictive GVP) that use the switch. The option
does not apply to engage call legs. If the option is set to 0 (zero), OCS does not dial for any of the
Campaign Groups that use the switch.

The values of this option set at the Switch level do not affect the values set at the
Campaign Group and Application levels.

digital-dialer-uri

e Default Value: An empty string
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Valid Values: Any valid URI (for example: http://ccs-ui.usw.gen.com/dialmanager/v2/)

¢ Configuration Level: Application

e Changes Take Effect: Immediately

e Logical Group: CX Contact
Specifies the URI of the CX Contact Dial Manager, which will be used as a Dialer for SMS and Email
campaigns in Power dialing mode. OCS will expand the URI to a particular endpoint automatically. For
example:
. * http://ccs-ui.usw.gen.com/dialmanager/v2/dial/sms/

e http://ccs-ui.usw.gen.com/dialmanager/v2/dial/email/

digits-detection

e Default Value: none

¢ Valid Values: none, all, answer, am

¢ Configuration Level: Individual record and chain of records (via SCXML), Campaign Group, Application
e Changes Take Effect: Immediately

e Logical Group: Dialing Regulations

Controls whether or not the DTMF detection takes place on the CPD Server side. When set to true,
OCS instructs the CPD Server to perform the DTMF detection.

OCS only instructs the CPD Server if: the dialing
mode is ASM, and either one or both of the
asm_drop_announcement_data and

Note: asm_drop_am_announcement_data OCS options
for the specific Campaign Group are set to a non-
empty value (that is, the message that will be
played is defined before digit detection occurs).

For SIP Server and VolIP Environment, this option instructs OCS to activate the VoiceXML application
for the opt-out feature.

digits-detection-pattern

¢ Default Value: Empty

¢ Valid Values: Any string of keys (digits)

¢ Configuration Level: Campaign Group, Application
¢ Changes Take Effect: Immediately

* Logical Group: Dialing Regulations

Specifies the string of keys (digits) that represents the signal for which OCS awaits before configuring
an Opt-0ut request.
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If the value of this option is an empty string, OCS
behaves as if digits-detection = none.

OCS does not require an exact match of the configured keys to

Note: those received from CPD Server. Instead, OCS treats any string
starting from the digits that are configured in this option as a
match. This means that user inputs like 9, 99, 9#, and similar
inputs match the specified pattern of 9 and cause the
configured reaction.

For SIP Server and VoIP Environment, the value of this option is passed to the VoiceXML application
using the SIP Headers.

digits-detection-timeout

e Default Value: 0

Valid Values: Any non-negative integer
¢ Configuration Level: Campaign Group, Application
¢ Changes Take Effect: Immediately

* Logical Group: Dialing Regulations
Specifies the timeout limitation for digit detection. A value of ® means do not wait.

OCS passes the 0CS_DIGITS DETECTION TIMEOUT
Note: pair to CPD Server only if the
' 0CS _DIGITS DETECTION pair is set to a value of 1 in
the req MakePredictiveCall configuration option.

For SIP Server and VolP Environment, the value of this option is passed to the VoiceXML application
using the SIP Headers.

digits-reaction

» Default Value:DoNotCall|AllChain

Valid Values: Any string in the following format: <digit(s)>|<protocol request>[|<flag>],
consisting of three sections separated by a | symbol, the last of which, is optional. For example,
1|DoNotCall|AllChain, 2|DoNotCall, 3|DoNotCall|RecordOnly

e Configuration Level: Campaign Group, Application
¢ Changes Take Effect: Immediately
e Logical Group: Dialing Regulations
Specifies how OCS reacts to the call when it receives the opt-out signal. OCS uses the value of this

option to build the desktop protocol request after receiving (from the CPD Server) a string of detected
digits that matches the string that is specified in the digits-detection-pattern option.

This request always targets the phone number or record handle of the record that is being processed.
Only DoNotCall and RequestRecordCancel requests are supported. The Chain/Record request is
applicable, only if it can be controlled by the end user by using the Al1Chain or RecordOnly value in
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the digits-reaction option.

To detect a match for the configured digits received from CPD Server, OCS does not need an exact
match. Instead, OCS treats any string as a match, starting from the digit or digits configured in this
option. This means that user inputs like 9, 99, 9#, or similar inputs can match and cause the
configured reaction.

For SIP Server and VoIP Environment, the value of this option is passed to the VoiceXML application
using the SIP Headers.

direct-personal-callback

Default Value: true
e Valid Values: true/yes, false/no

e Configuration Level: Campaign Group, Application

Logical Groups: Interactions Processing in Push Preview Dialing Mode, Agent Desktop
Controls how personal callback records of type are processed in the Push Preview dialing mode.

* When the value is set to true, OCS will submit the personal callback interaction directly to the agent.

* When the value is set to false, OCS will submit the personal callback interaction to an interaction
queue assigned to the Campaign Group. This allows the Universal Routing Server strategy to distribute
this interaction.

. This option is used with Interaction Server in Push
Note: 3 L
Preview dialing mode only.

direct-push-preview

e Default Value: false

* Valid Values: true, false

e Configuration Level: Campaign Group, Application

¢ Changes Take Effect: Next Campaign Group activation

e Logical Groups: Interactions Processing in Push Preview Dialing Mode

Controls the dialing mode that OCS uses for a Campaign Group that is started in Push Preview dialing
mode. A value of false indicates that the Campaign Group will run in Push Preview mode with
Interaction Server. A value of true indicates that the Campaign Group will run in Direct Push Preview
mode, even if Interaction Server is present in the Campaign Group connections.

disposition-code-field

e Default Value: An empty string

¢ Valid Values: A valid name of the field in the calling list
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Configuration Level: Calling List, Application
Changes Take Effect: Immediately
Logical Group: Record Processing, CX Contact

Introduced: 8.1.528.25

When the option is set to a non-empty string, OCS does the following:

Uses the specified field name to store a disposition code value provided in the GSW_DISPOSITION_CODE
key-value pair to OCS from an agent desktop or from a negative pre-dial validation when updating the
record (if record_save_intermediate-results = true) or when finalizing the record. The disposition
code value is stored in the calling list only if it is explicitly provided to OCS in the
GSW_DISPOSITION_CODE key-value pair.

Updates the specified field as set in #1 regardless of the presence of the Field object in the Format
object.

Delivers the field to ICON in record details in GO Chain Events. (Note that the disposition_code field is
configured without send_attribute).

divert to_unknown_dn

Default Value: no/false

Valid Values: yes/true, no/false

Configuration Level: Campaign Group, Application
Changes Take Effect: Immediately

Logical Group: Call Processing

Specifies OCS's reaction to an EventDiverted with either an unknown ThirdPartyDN or without an
agent logged in to it.

If set to no or false, immediately upon receiving this type of EventDiverted, OCS updates the
record with the Stale call result and the Agent Error record status.

If set to yes or true, OCS does not update the record, and continues to monitor the outbound call.

* If a call is diverted to a DN, on which OCS has
not been registered, then the corresponding
record will not be updated in a calling list upon
call release. Instead, it will stay in a Retrieved
status until the timer set by the
stale clean timeout option expires.

Notes: « In release 7.5 and higher, an "unknown DN" is a

DN that is either excluded from any Place
object, or is included in a Place object but the
Place object does not have an associated
agent. An agent is associated to a Place object
when a Campaign Group that is configured with
this agent is activated within OCS.
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dnc-reread

e Default Value: An empty string ("") (Do Not Call rereads are not active)

¢ Valid Values: Time and frequency of the Do Not Call rereads in DAYS@HH24 :MM: SS format.

e Configuration Level: Table Access Point, Application

e Changes Take Effect: Immediately

e Logical Group: Dialing Regulations
You can set this option in the Annex tab of the Do Not Call lists' Table Access configuration object or
the OCS Application configuration object. If the option is set for a specific Table Access object,
only the Do Not Call table accessible through this Table Access object is affected. Setting the option

at the OCS Application level affects all Do Not Call tables, unless you also configure different values
at the Table Access level. In that case, the Table Access setting takes priority for the associated table.

At the configured time, OCS rereads all loaded Do-Not-Call lists into memory. Configure the rereads as
follows:

e DAYS is the frequency of updates in days (each Nth day). The value for DAYS must be greater than 0. The
option value following the @ sign defines at what time the Do Not Call reread occurs.

e HH (hours) defines the hour when the reread should happen. Format is 24 hours. and can be any value
between 0 (midnight) and 23.

* MM (minutes) defines the minutes after the specified hour when the reread should begin. You can enter
any value between 0 and 59.

* SS (seconds) defines the seconds after the specified minute when the reread should begin. You can
enter any value between 0 and 59.

¢ OCS calculates the time for the next reread using as a base time the time when last reread occurred or
the time when Do Not Call list was first read into memory (if no rereads have yet occurred). For
example, if the frequency of rereads is configured at 7 days, OCS rereads the Do Not Call list every 7
days following the initial read.

Related Documentation: Deploying DNC Functionality

dnc-default-duration

¢ Default Value: 0 (indicates that the DNC duration is indefinite)

* Valid Values: 0 to MAX_INT

e Configuration Level: Campaign Group

e Changes Take Effect: For subsequent DNC requests with the GSW_RECORD_HANDLE attribute

e Logical Group: Dialing Regulations
This option specifies the DNC default duration, in seconds. OCS will only refer to this option if no
value is specified in the GSW_DURATION attribute and if GSW_RECORD HANDLE is specified. If a value is

specified for both GSW_DURATION and dnc-default-duration, the GSW_DURATION attribute value
takes priority.
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Related Documentation: Deploying DNC Functionality

dnc-purge

Default Value: 0

e Valid Values: 0 to MAX_INT

e Configuration Level: Table Access Point, Application
¢ Changes Take Effect: Immediately

e Logical Group: Dialing Regulations

This option specifies a delay, in seconds, before an expired DNC entry is purged.

e |If the value is set to 0, OCS does not purge expired DNC entries from DNC tables.

e If the value is set to a positive integer, OCS purges expired DNC entries that have expired before the
time calculated as the current UTC time minus this value.

The purge occurs after OCS reads the DNC table after restart or after OCS re-reads the DNC table in
accordance with the dnc-reread option.

Related Documentation: Deploying DNC Functionality

dnc-use-duration

e Default Value: false

* Valid Values: true, false

* Configuration Level: Application

¢ Changes Take Effect: After OCS restart

e Logical Group: Dialing Regulations

A value of false means that Do Not Call expiration is off. A value of true means that Do Not Call
expiration is on. In this case, OCS looks for the expires at value in the Do Not Call table.

Related Documentation: Deploying DNC Functionality

dynamic-port-allocation

e Default Values: false/no

Valid Values: false/no, true/yes
¢ Configuration Level: Switch, OCS Application, CPD Server Application
e Changes Take Effect: Immediately

e Logical Group: Predictive Algorithm
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Defines whether the dynamic ports allocation is in effect for the Campaign Groups that dial through a
specific Switch (when OCS sends dial requests to T-Server) or through a specific CPD Server or Proxy
(when OCS sends dial requests to CPD Server or Proxy). The level of the configuration is very
important for this option. For Campaign Groups that use a T-Server associated with a specific Switch,
it should be configured at that Switch or the OCS Application level. For Campaign Groups that share
the same CPD Server/Proxy, it should be configured at the CPD Server or Proxy Application level.

When the value of this option is set to true, OCS performs a dynamic allocation of ports for all the
Campaign Groups that use the corresponding Switch or CPD Server/Proxy and have the Number of
CPD ports property set to 0. This property is defined on the Advanced tab of the Campaign Group
configuration object. When the value of this option is set to false, OCS does not perform dynamic
port allocation among any Campaign Groups and all ports are assigned statically.

OCS dynamically allocates the total number of ports only among running Campaign Groups. To retain
static allocation and reserve ports for specific Campaign Groups, the Number of CPD ports property
for these Campaign Groups should be set to a value that is greater than 0. As such, the total number
of dynamically allocated ports for Campaign Groups is the total number of ports available for the
corresponding Switch or CPD Server or Proxy minus the sum of ports reserved for running Campaign
Groups with a static allocation of ports.

If OCS dials through T-Server and the dynamic-port-allocation option is defined at the Switch
level, the total number of available ports is taken from the channel _num option that is specified in
the Annex tab of the Switch object. If OCS dials through CPD Server/Proxy, OCS receives the total
number of available ports directly from CPD Server or Proxy. In the latter case, the number of
available ports is defined by the CPD Server or Proxy configuration.

To protect Campaign Groups with small estimated numbers of required ports relative to other
Campaign Groups, OCS uses these small estimated values as the maximum number of available
ports, without further scaling these numbers. OCS considers the estimated number of ports to be
small if this number is less than 30 percent (%) of the average ports distributed between all
participating Campaign Groups.

When the dynamic-port-allocation option is set to false, OCS uses a static allocation of ports in
accordance with the Number of CPD ports Campaign Group property and the asm_channel_num

option for all Campaign Groups that share the corresponding Switch or CPD Server/Proxy. For more
information, see the asm_channel_num option and Separate Tracking of Engaging CPD Ports topic.

encoding

¢ Default Value: none

Valid Values: (See the ICU Home Converter Explorer page for a list of valid values.)
e Configuration Level: Application
¢ Changes Take Effect: After OCS restart
¢ Logical Group: HTTP-based Notifications
OCS sends this option value to an HTTP proxy, which can then transcode the JSON body of HTTP

requests or responses according to the settings specified. If the option value is not specified, no
conversion takes place.

To change the default, set this option to the name of a converter that can translate UTF-8 data to the
local character set. Converters can be found at ICU Home Converter Explorer.

Outbound Contact Deployment Guide 265



Outbound Contact Configuration Options Outbound Contact Server Options

engaged_answer_action

Default Value: soft_answer

Valid Values: hard not ready, hard ready, soft answer
e Configuration Level: Switch, Application

e Changes Take Effect: Immediately

Logical Groups: Agent Desktop, ASM Dialing
Determines the agent's place state after an engaging call is established.

* When set to hard not_ready, OCS sends a request to T-Server to force the teleset to a Not Ready
state.

* When set to hard_ready, OCS sends a request to T-Server to force the teleset to a Ready state.

* When set to soft_answer, OCS uses the agent state provided by Stat Server.

When using this option, OCS takes the value of the
hard_request to_login_dn option into account. In
other words, if hard_request_to_login_dn is set
to true, OCS sends RequestAgentReady to the
login DN instead of the DN where the call was
answered.

Note:

engaged release_action

e Default Value: soft _previous

Valid Values: soft previous, hard ready, hard not ready
¢ Configuration Level: Switch, Application

e Changes Take Effect: Immediately

¢ Logical Groups: Agent Desktop, ASM Dialing

Determines the agent's place state after an engaging call has been released.

* When set to soft_previous, OCS uses the agent state provided by Stat Server.
* When set to hard ready, OCS sends a request to T-Server to force the teleset to a Ready state.

* When set to hard not ready, OCS sends a request to T-Server to force the teleset to a NotReady state.

When using this option, OCS takes the value of the
hard_request_to_login_dn option into account. In
other words, if hard_request_to_login_dn is set
to true, OCS sends RequestAgentReady to the
login DN instead of the DN where the call was
answered.

Note:
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force-unload-wait-db

» Default Value: false

e Valid Values: true/yes, false/no

e Configuration Level: Campaign, Application
e Logical Group: Record Processing

¢ Changes Take Effect: The next time that the dialing session for this campaign is unloaded forcefully

Controls how OCS handles requests for a records update sent to the database when a dialing session
for the campaign is unloaded forcefully. When set to false/no, OCS does not wait for a database
response for the records update request and terminates the connection to DB Server immediately
after the last update request is sent. This ensures that the dialing session/campaign group is
forcefully unloaded almost immediately. However, this may cause some records to be left in the
Retrieved state, even though OCS has requested that those records be returned to either the Ready
state or marked as Stale.

When set to true/yes, OCS waits for database responses for all update requests that were sent
before terminating the connection to DB Server. This ensures that all records are updated properly in
the database. However, this may slow down the forced unloading process and keep the dialing
session/campaign group in an Unloading state longer, depending on the number of calling list
records in the OCS buffers. OCS holds these records in the buffers to properly mark them when
unloading a dialing session/campaign group.

gvp-modes-use-switch-rate-limit

e Default Value: no/false

e Valid Values: yes/true, no/false
¢ Configuration Level: OCS Application
* Logical Group: Dialing

When set to true/yes, Progressive GVP and Power GVP dialing modes are added to the list of auto
dialing modes, which can use dialing rate limits defined at Switch level.

hard request to login_dn

Default Value: no/false

¢ Valid Values: yes/true, no/false

* Configuration Level: Switch, Application
¢ Changes Take Effect: Immediately

e Logical Group: Agent Desktop

Determines which DN receives the AgentReady or AgentNotReady request when an agent's Place in
the database has more than one DN associated with it.
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You can use this option when Outbound Contact is configured as follows:

e An agent's Place is configured with an ACD Position and an Extension.
e The outbound release_action option is set to hard_ready or hard _not ready.
When both of these conditions are met, OCS sends an AgentReady or AgentNotReady request after

receiving an EventReleased message on either of the agent's DNs, depending on the value of this
option.

¢ When set to yes or true, OCS sends an AgentReady or AgentNotReady request to the DN where the
agent is logged in.

* When set to no or false, OCS sends an AgentReady or AgentNotReady request to the DN that received
the EventReleased message.

history length

Default Value: 30
e Valid Values: Any positive integer from 30 to 300
* Configuration Value: Campaign Group, Application

e Logical Group: Predictive Algorithm

Specifies the point at which OCS switches from the Progressive mode to Predictive mode. As soon as
OCS starts dialing in Progressive mode, it begins to collect call flow statistics or call history to create
predictive statistics.

OCS fills the call history in the order in which calls are established (answered by dialed party),
meaning if the history_length option has value of 40, the first 40 established calls (not 40 randomly-
chosen established calls) must be completed before the Campaign switches to predictive mode.

For large agent groups (approximately 1000 agents), Genesys recommends that you set the value of
history_length to 100 or higher, and that you also control the number of CPD ports.

These settings help maintain the target busy factor and minimize the number of abandoned calls in
large agent groups.

history-uri

e Default Value: none

* Valid Values: URI

e Configuration Level: Calling List, Campaign, Application

* Logical Groups: Record Processing, HTTP-based Notifications, CX Contact

e Changes Take Effect: Next dial attempt, or next attempt to send the Call Report Record to Web or
Application Server, if the previous attempt failed

Specifies the URI of the Web or Application Server.
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Related Documentation: Submitting Call Report Records

history-wait-condition-threshold

» Default Value: 0

¢ Valid Values: Positive Integer

e Minimum Value: 0

* Configuration Level: Campaign Group, Application

e Logical Groups: Record Processing, HTTP-based Notifications, CX Contact
e Changes Take Effect: Next dialing session

Specifies the number of calls for which at least one call report record failed, which triggers a wait
condition for the OCS dialing session (see Notes).

e Arecord is considered failed if it posted to Web
or Application Server but failed to save as a
result of error response or timeout.

¢ A value of ® means that any call for which at
least one call report record failed triggers a wait

condition.
Notes:
* When a wait condition occurs, a campaign

remains in running state but dialing is
suspended.

e A wait condition is cleared when all call report
records marked for re-submission are
successfully processed.

Related Documentation: Submitting Call Report Records

history-wait-recovery-timeout

» Default Value: 30 (seconds)

e Valid Values: Positive integer, starting from 5

e Configuration Level: Campaign Group, Application
e Changes Take Effect: Next dialing session

e Logical Groups: Record Processing, HTTP-based Notifications
Specifies the time to wait before re-submitting the failed call report record.

Related Documentation: Submitting Call Report Records
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http-body

Default Value: An empty string

¢ Configuration Level: Treatment

¢ Changes Take Effect:

Logical Groups: HTTP-based Notifications

Valid Values: JSON string (and support for macro expressions)

Specifies the HTTP body. All macro expressions are expanded in the same manner as for the Execute
SQL Statement treatment, especially record-level macro parameters, such as $GSW_PHONE and
$GSW_CUSTOMER _ID. See Send HTTP Request Action Type for details.

Example:

{

"data": {

"listid": 5711,

"appendOnly": false,

"fields": {

"client id": "$GSW CUSTOMER ID"
)

)

)

{

"data": {

"listid": 5711,
"appendOnly": true,
"fields": {

"device": "$GSW_PHONE"
}

}

}

http-connection-pool-size

Default Value: 64
¢ Valid Values: Positive integer
¢ Configuration Level: Host, Application

* Changes Take Effect: Next dial attempt

¢ Logical Groups: HTTP-based Notifications, Pre-dial Validation, CX Contact

Defines the maximum number of simultaneous connections to the Web or Application Server running

on the specified host at the specified port number.

Note:

OCS parses URI and detects the name of the host
at which Web or Application Server is to be
contacted. OCS then attempts to find the host
configuration object with the name that exactly
matches the host setting from the URI. If found,
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OCS attempts to read this option from the Annex of
the host configuration object. If not found, OCS
reads this option from the OCS Application object.

http-custom-headers

¢ Default Value: An empty string

Valid Values: Custom HTTP headers in the following format:
<headerl name>: <headerl value>[|<header2 name>: <header2 value>...]

* Configuration Level: Application, Host

¢ Changes Take Effect: After OCS Application restart

Logical Groups: HTTP-based Notifications, CX Contact
e Introduced: 8.1.516.04

Specifies the custom HTTP headers. In the valid values format, the header name and its value are
delimited with a colon followed by a space (: ), and headers are delimited with a pipe (]). A semicolon
and colon could be part of the header value. When set at the Host level, it must be configured on the
Host object representing the host of an external Web or Application Server. The Host-level setting
applies only to outgoing HTTP requests and takes precedence over the Application-level setting.

Example: http-custom-headerst = X-Frame-Options: SAMEORIGIN|X-XSS-Protection:1;
mode=block|X-Content-Type-Options: nosniff|Content-Security-Policy: script-src
'self'; object-src 'self'|Strict-Transport-Security: max-age=31536000;
includeSubDomains

http-headers

e Default Value: An empty string

¢ Valid Values: Exactly as specified in http-custom-headers
¢ Configuration Level: Treatment

¢ Changes Take Effect:

e Logical Groups: HTTP-based Notifications

Specifies the HTTP headers. All macro expressions are expanded in the same manner as for the
Execute SQL Statement treatment. Note that the value of this option should be combined with the
Application-level option http-custom-headers, in case if it's present. See Send HTTP Request Action
Type for details.

http-method

¢ Default Value: POST
e Valid Values: POST | PUT | GET | DELETE

¢ Configuration Level: Treatment
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¢ Changes Take Effect:
e Logical Groups: HTTP-based Notifications

Specifies the HTTP method. No support for macro expressions. See Send HTTP Request Action Type
for details.

http-proxy

e Default Value: An empty string

e Valid Values: A string representing the URI of the HTTP tunneling proxy server supporting the HTTP
CONNECT method, in the following format: http://<host>[:<port>][/<path to HTTP proxy server
resource>]

¢ Configuration Level: Host, Application

¢ Changes Take Effect: At the next HTTP connection (existing connections will keep using the previous
settings)

e Logical Group: HTTP-based Notifications, CX Contact
e Introduced: 8.1.528.05

Specifies the URI of the HTTP tunneling proxy server supporting the HTTP CONNECT method.

http-response-timeout

e Default Value: 3

¢ Valid Values: 1-3600 (seconds)

e Configuration Level: Host, Application

* Changes Take Effect: Next dial attempt

¢ Logical Groups: HTTP-based Notifications, Pre-dial Validation, CX Contact

Defines maximum time (in seconds) that OCS will wait for the response from the Web or Application
Server for its request for pre-dial validation or SCXML document. The maximum valid value is 3600
seconds. If a higher value is configured, OCS applies the default value of 3.

OCS parses the URI and detects the name of the
host at which Web or Application Server is to be
contacted. OCS then attempts to find a host
configuration object with the name that exactly
matches the host setting from the URI. If found,
OCS attempts to read this option from the Annex of
the host configuration object. If not found, OCS
reads this option from the OCS Application object.

Note:

http-retry-applies-to

¢ Default Value: An empty string
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Valid Values: validation, contact-processed, pre-load

¢ Configuration Level: Campaign Group, Application

e Changes Take Effect: Next retry attempt

¢ Logical Groups: HTTP-based Notifications, Pre-dial Validation, CX Contact
Introduced: 8.1.528.21

Specifies a comma-separated list of HTTP service types to which the functionality of retrying to send
failed HTTP requests are applied. An empty string means that OCS does not resend failed HTTP
requests if there are any connectivity errors.

http-retry-max-attempts

* Default Value: 0

* Valid Values: 0-30

e Configuration Level: Host, Application

¢ Changes Take Effect: Next retry attempt

* Logical Groups: HTTP-based Notifications, Pre-dial Validation, CX Contact
e Introduced: 8.1.528.21

Specifies the maximum number of attempts for OCS to resend failed HTTP requests. A value of 0
(zero) means that OCS does not resend failed HTTP requests if there are any connectivity errors.

icon_attribute

Default Value: 0
¢ Valid Values: 0,1,2

e Configuration Level: Field

Logical Group: Historical Reporting
Defines how the field's value will be stored by ICON.

e |f set to 0, ICON will not store the value of this field.
e |If set to 1, ICON will use a non-secured table.

e If set to 2, ICON will use a secured table.

For ICON to store a field’s value correctly, you must
configure the icon_attribute. Depending on the
KVP, you might also need to configure the

Note: send_attribute option in order for ICON to receive
the KVP to store. For more information about
configuring the send_attribute option, refer to the
Outbound section of the ICON documentation.
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Genesys Info Mart requires the following two options to be configured in order to calculate metrics:
right_person and conversion.

ignore-empty-group

* Default Value: false

¢ Valid Values: true/yes, false/no

* Configuration Level: Campaign, Application
¢ Changes Take Effect: Immediately

e Logical Group: Record Processing
Specifies how to handle record processing when no agents are logged into group.

¢ When the value is set to false, OCS functions as it did previously and retrieves callback/rescheduled
records when the scheduled time approaches, regardless of agent availability, and does not return any
records back to the database when a group becomes empty.

¢ When the value is set to true, OCS behaves as follows:

* When the last agent logs out of the group, OCS returns all records retrieved for the Campaign Group
back to the calling list with the Ready status.

* When there are no agents logged into the group, no records of any type are retrieved for the
Campaign Group.

If agent assignment is activated for the Campaign Group and
the agent-reassignment-if-waiting-records option is set to true
for this Campaign Group, the Campaign Group will behave as
follows:

e |f all agents are reassigned out of the group, all
records will be flushed from the buffers.

¢ Whenever records need to be retrieved (each 10
seconds for General records, each 100 seconds
for rescheduled records), before doing the
actual retrieval, Campaign Group will determine
the number of agents which are both:

Note:

» Configured for this Agent Group; and

* Logged In.
Warning: If this number is 0, Campaign Group will consider
itself empty and will not retrieve any records. If this number is
greater than 0, Campaign Group will consider itself not empty

and retrieve records. Agents may then be naturally assigned to
this Campaign Group since it is no longer empty.

ignore-not-monitored

¢ Default Values: false
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Valid Values: yes/true, no/false
¢ Configuration Level: Application
e Changes Take Effect: Immediately
e Logical Groups: Agent Desktop

Specifies whether OCS accepts or ignores a TargetRemoved event with the agent status of
NotMonitored that is generated by Stat Server. When set to false, OCS processes a TargetRemoved
event with the agent status of NotMonitored in the same way as a TargetUpdated event. When set to
true, OCS ignores a TargetRemoved event with the agent status of NotMonitored as the previous OCS
versions did.

Note: Genesys recommends keeping this option set to its default value unless explicitly instructed
otherwise by Genesys Customer Care.

inbound-agent-assignment-min-num

e Default Value: 0
e Valid Values: -1, 0 --n
* Configuration Level: Application

e Logical Group: Dynamic Agent Assignments

Defines the minimum amount of agents to perform inbound call activities. It is used when
determining agent reassignment.

When the value is set to 0, there are no restrictions for the minimum amount of agents performing
inbound call activities. Agents are assigned to inbound call activities even when the highest priority
Campaign Groups are understaffed.

To prevent assignment to the inbound activity, the inbound-agent-assignment-min-num' option
should be set to special value "-1". In this case, OCS assigns agents to the inbound activity only if the
agents cannot be assigned to any running associated Campaign Groups due to the restrictions
imposed by the options regarding the agent assignment (maximum number of assigned agents,
waiting records, and so on.)

inbound-agent-assignment-priority

e Default Value: 0
Valid Values: 0 -- n

¢ Configuration Level: Application

¢ Changes Take Effect: Immediately

Logical Group: Dynamic Agent Assignments

Defines the priority of inbound call activities. It is used when determining agent reassignment. As the
value increases, the priority for the specified agent also increases.
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inbound_agent_outlier_limit

Default Value: 600 (seconds)

Valid Values: Any non-negative integer
e Configuration Level: Campaign Group, Application

e Changes Take Effect: Immediately

Logical Group: Predictive Algorithm

Specifies the minimum amount of inbound call time, in seconds, before OCS changes an agent's
status changes to Not Available. If an agent is busy with an inbound call longer than the specified
value (including the After Call Work state), then the predictive algorithm does not consider this
agent available when calculating the number of predictive calls.

interaction-media-type

Default Value: outboundpreview
¢ Valid Values: Any valid value for the media type business attribute
¢ Configuration Level: Calling List, Application

e Changes Take Effect: When the next interaction is created

Logical Group: Interactions Processing in Push Preview Dialing Mode

Defines the media type of the interaction submitted to Interaction Server in the Push Preview dialing
mode.

ivr_group

e Default Value: false

e Valid Values: true/yes, false/no

e Configuration Level: Place Group

¢ Changes Take Effect: After OCS reloads a dialing session for a campaign group

e Logical Group: Call Processing
Specifies whether OCS provides simplified resource availability management for IVR groups.
When this option is set to true or yes, OCS uses the simplified resource availability model when

running a campaign for a Campaign Group linked to this Place Group. Places in that group can
contain DNs of type ACD Position, Extension, or Voice Treatment Port.

ivr-profile-name

e Default Value: An empty string ("")

¢ Valid Values: 1-n
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¢ Configuration Level: Campaign Group, Application
¢ Logical Group: GVP
Populated after a nine-digit value is entered in the IVR Profile field in the Advanced tab of

Campaign Group configuration object. The value itself is the IVR Profile DBID that is specified in the
GVP EMPS IVR Profile.

ivr_record_processed

Default Value: false
e Valid Values: true/false, yes/no
¢ Configuration Level: Campaign Group, Application
¢ Logical Group: GVP
* Changes Take Effect: Immediately
This option controls how OCS processes chain finalization in GVP dialing modes. It works similar to

the record processed option, but enables you to configure different OCS processing options for agent-
related dialing modes and GVP modes.

In Progressive GVP dialing mode, if the
Note: ivr_record_processed option is not set, OCS uses
the value in the record_processed option.

ivr_update_on_release

» Default Value: false

¢ Valid Values: true/false, yes/no

e Configuration Level: Place Group

e Changes Take Effect: After set to true or yes, when the ivr_group option is set to true or yes.

¢ Logical Group: Call Processing
Enables OCS to update the calling list record with values from the outbound call's UserData.

When this option is set to true or yes, OCS updates the fields from the calling list record with values
from the corresponding UserData key-value pairs that are received in the EventReleased message.
This is similar to UpdateCallCompletionStats UserEvent processing.

This option is also used in Power GVP dialing mode with OBN Manager in environments running GVP
7.6. In this dialing mode, when this option is set to true or yes, OCS updates the fields of the calling
list record with values from the corresponding UserData key-value pairs that are received in the
eventOBNRecordProcessed message from OBN Manager for unsuccessful call results. In this dialing
mode, the ivr_group option has no effect on the described functionality.
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license-file

Default Value: None

Valid Values: Any string
e Configuration Level: Application
e Logical Group: Licensing
Specifies the license address. This option is not OCS-specific. It is specified in the license section,

which is optional. This option, along with the num-of-licenses< option, pertains to OCS license
control. The license address format can be entered in either of the following formats:

e The host name and port of the license server, as specified in the SERVER line of the license file, in the
port@host format; for example,
7260@ctiserver

e The full path to, and the exact name of, the license file - for example,
/opt/mlink/license/license.dat

Changes that you make to this option take effect

Note: after an application is restarted.

lifo-mode

¢ Default Value: false

Valid Values: true, false
e Configuration Level: Campaign Group

e Changes Take Effect: At the next Campaign Group activation

Logical Group: Dialing

When set to true, designates a Campaign Group as a Last In First Out (LIFO) Campai